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1 Installing & Getting Started

Welcome!

Thank you for purchasing TheSky™. No other astronomy software offers as
much power, versatility and expandability. Whether you’re a novice or an
experienced observer, TheSky has many features to increase the enjoyment of
your hobby.

● Access the Hipparcos and Tycho catalogs. These data for 1.1 million stars
(Tycho) and 118,000 stars (Hipparcos) are the primary databases for the
Virtual Sky. They fix “messy” entries in the GSC and are invaluable for
CCD astrometry.

● Explore the Hubble Guide Star Catalog (GSC). With 15 million stellar and
4 million non-stellar objects, data on over 70,000 galaxies, 12,000 double
stars, 28,000 variable stars, and thousands of nebulae, clusters, and other
objects, it’s not “billions and billions,” but more than can be explored in
one lifetime.

● Plan a viewing session. Select the objects you intend to view, then print
detailed star charts for those sections of the sky.

● View simulations of astronomical events. Watch a Solar or Lunar eclipse.
View the Solar System as a passing comet sees it. Predict when a minor
planet will occult a star. Preview the positions of Jupiter’s and Saturn’s
largest moons and Saturn’s rings. Display a chart of the Moon’s phases
for any month of any year.

● Control your telescope. Connect an automated telescope to your computer
(desktop or notebook) and let TheSky control it.

● Create custom databases. TheSky’s database compiler can assemble almost
any kind of astronomical data for display. Put together catalogs of favorite
celestial objects, or make your collection of photographs and CCD images
directly viewable from the Virtual Sky.

● Acquire and process images with many popular CCD cameras using
Software Bisque’s CCDSoft™ program (optional, Windows).

● Enhance the accuracy of your computer-controlled telescope with
TPoint™ telescope pointing analysis software (optional, Windows).

● Automate the operation of your telescope and CCD camera with
Orchestrate™ scripting software (optional, Windows).

● Learn astronomy. A Help-based tutorial (Patterns in the Sky) guides you
through the basics, using TheSky to demonstrate astronomical principles.

These features—combined with the ease-of-use of a graphical interface and
the speed of our exclusive plotting technology—provide the most-advanced
astronomy program available. TheSky can keep pace with your astronomical
interests, no matter how far you progress.



This chapter explains how to install TheSky. Chapters 2 through 8 explain its
basic operation. The remaining chapters describe advanced features.

What’s New?

Version 5 introduces new features and major improvements to TheSky.
This section gives a brief description of what’s “new and improved,”
plus a cross-reference to the page where each feature is described.

Macintosh users will be pleased that TheSky is now available in an edition
designed for the OS 8 operating system, running native Power PC code.
It supports the Appearance Control Panel and offers Advanced File Dialogs
that use Apple Navigation Services. The Macintosh edition is essentially
identical to Level III of the Windows edition.

The basic operation of TheSky 5 is essentially the same as previous versions.
If you’re familiar with any of them, you can use Version 5 right away. There
are enough changes and enhancements (some subtle), that you should
eventually read through the manual. (The author—quite naturally—feels
that reading manuals “from alpha to omega” is A Good Thing To Do.)

There were also numerous enhancements to Version 4. These are listed in
“Version 4 Enhancements.” If you skipped the Version 4 upgrade, you
should read this section to be sure you don’t overlook important features.

New & Improved Features of Version 5 (all levels)

● The Hipparcos and Tycho catalogs are the principal stellar catalogs. They
provide greatly enhanced accuracy for 1.2 million stars, plus parallax,
position errors, proper motion, spectral class, and B & V magnitudes.
These improved data correct many “messy” areas of the Hubble GSC.
Milli-arc-second accuracy is maintained. (page 36)

● The complete Hubble Guide Star Catalog is now supplied at all Levels.

● Position errors for all catalogs (including the GSC) are now available—
a necessity for precision astrometry. (page 39)

● Dynamic Proper Motion The proper motions of stars in the Hipparcos and
Tycho catalogs can be applied when plotting them in the Virtual Sky. The
motion for a user-selected interval can be drawn as a line in the direction
of the motion. (page 52)

● 3D Solar System Mode replaces the Solar System Simulator. The Solar
System can be viewed from any angle, at varying distances. The stellar
background for the angle of the viewpoint can be displayed. (page 157)

● Improved Object Information dialog box can be displayed in two ways, as
either a tabbed box with expanded information, multimedia displays,
utility functions and telescope controls, or as a simple box with “terse”
information. (pages 42, 40)

● Object Tips display the name or catalog number of any object when you
hold the mouse cursor over it. (page 59)
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● New Projections and Wider Fields of View At fields of view of 50° and
wider, you can now choose from stereographic, orthographic, Mercator,
gnomonic, azimuthal equal-area, and azimuthal equal-distance
projections. Mercator projection permits fields of view of up to 360°.
Orthographic projection is used at fields of view below 50°. (pages 21, 27)

● Improved Sky Database compiler allows multiple images of any sky object
to be accessed from the Object Information dialog box. (page 132)

● The daytime sky can be simulated, with the sky changing color according
to the time of day. Objects not visible against the sky are hidden. You can
anticipate how viewing near sunrise or sunset will be affected. (page 160)

● A wider range of Update Frequencies takes advantage of faster computers
to update the display more often. (page 56)

● Record QuickTime™ movies of Time Skip animations or any other
dynamic changes to the Virtual Sky or 3D Solar System. (page 154)

● Enhanced Comets and Minor Planets Dialog Box Multiple objects of both
types can be added or removed in a single action. (page 73)

● Enhanced Accuracy of Reported Positions for Extended Minor Planets
Numerical integration provides accuracy to ±1 arc-second. (page 56)

● All extended Minor Planets can now be removed with a single command.
(pages 77)

● Eclipse Finder now displays the path of totality on a globe of the Earth.
(page 161)

● The Earth’s shadow (at the distance of the Moon) is shown automatically
during Lunar-eclipse simulations, manually at other times. (page 162)

● Principal moons of Jupiter and Saturn are shown in the Virtual Sky.
Jupiter’s and Saturn’s brightest moons are displayed at narrow fields of
view. Their motion can be Time Skip animated with the feature. This
enhancement replaces the Jovian Moons utility. (page 163)

● Enhanced Display of Saturn’s Rings The rings’ phase is now drawn
unambiguously; you can see which side is facing Earth. (page 163)

● Enhanced user interfaces for Field of View Indicators and the Sky
Database Manager (pages 67, 109)

● Improved Constellation Boundaries Constellation boundary lines near the
celestial poles are smoother.

● Constellation images make it easier to identify constellations. (page 111)

● Extended-object outlines (isophotes) provide increased detail. (page 111)

● Photo-realistic display of the Moon shows principal surface features and
the terminator (non-Ahnold version).

● Celestial Object Drawing Tool Add deep-sky objects quickly and easily by
drawing ellipses with adjustable major and minor axes. (page 93)

● Improved Full Screen command can now hide all toolbars. (page 49)
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● North/East direction indicator helps you visualize your orientation. (page 62)

● Arrow keys now rotate display in Look Up mode. (page 29)

● Enhanced Color Palette 16-bit color depth is now supported.

● Enhanced Zoom Box Operation The zoom box can now be dismissed by
clicking outside the box. You can now choose any aspect ratio without
pressing CONTROL. (page 26)

● Display artificial satellites (including the Space Shuttle) in real time,
or animate their motion. Any number can be shown. (page 77)

● Enhanced control of stellar brightness and contrast for the Virtual Sky and
printed Sky Charts, which can now have separate settings. (page 50)

● Medium Density Mode gives subtler control over display density. (page 36)

● Multiple Telrad FOVIs let two or more observers use one computer. (page 70)

● Plain-English Dreyer descriptions of all NGC and IC objects

● Expanded Spectral Classes and Spectral Information Star colors are now
shown as a close approximation to their true colors. (page 42)

● Enhanced Telescope Search The Star Search function uses a spiral search
path to let computer-controlled telescopes more quickly locate objects.
(page 176)

● Enhanced Field of View Indicators FOVIs for the SBIG ST-7 and ST-8 now
show the field of view for the ST-4X guiding detector. The field of view
for common film formats is now automatically computed. (page 67)

● Galactic Equator and Celestial Poles can now be displayed. (page 62)

● Enhanced Local Horizon Editor automatically draws horizon line as it
“follows” telescopes with computer interfaces. (page 64)

● Assign sounds to many events in TheSky. (page 135)

● Direct Internet links to the IAU’s observable comets and distant/critical/
unusual minor planets. (Windows) (page 75)

● 13,000+ “thumbnail” images of all NGC and IC objects. Additional pictures
from the spectacular David Malin collection have been added. (page 129)

● Over 100 of the most-popular Hubble Space telescope images. (page 46)

● Extensive Help file includes links to useful Web sites, technical support,
and more.

● Enhanced “What’s This?” Help You can click on any part of TheSky’s
interface to get information about the item. (page 14)

New Features and Enhancements for Level IV

● “List Creator” Database Exporter provides a convenient way to create and
export lists of objects visible in the Virtual Sky, or from databases. Highly
flexible user-selected criteria can be applied. (Levels III & IV) (page 102)
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● Enhanced data exchange with CCDSoft and other Software Bisque
products makes possible automated scripting, astrometry calculations,
telescope pointing analysis, and more.

● United States Naval Observatory (USNO) Support The A1.0 (488 million
stars) and SA1.0 (55 million stars) databases can be displayed in the
Virtual Sky. (Databases not supplied.) (page 38)

● Internet control of remote telescopes including the Software Bisque
Paramount GT-1100 drive at Mount Wilson. Requires optional RASClient.

● Astrometry Data Maker Stellar data can be exchanged with CCDSoft for
highly accurate (sub-arc-second) positions in your CCD images.

● Improved Image Link™ Wizard can search for matches outside the Virtual
Sky’s current field of view. (page 139)

● Support for Orchestrate ™ scripting software to automate operation of
computer-controlled telescopes and CCD cameras.

● Support for TPoint ™ telescope pointing analysis software to improve the
accuracy of computer-controlled telescopes.

Version 4 Enhancements

The following are brief descriptions of the changes and improvements that
appeared in Version 4 for those who did not update to Version 4.

● Enhanced Graphics / Improved Symbols Celestial objects are represented
by a wider variety of better-drawn symbols.

● Focus on Objects, not Catalogs Besides choosing which databases are
displayed, you can also choose which object types are shown. (page 33)

● New Database Engine / Unlimited Databases TheSky can read and display
any text-based astronomical database. You can use TheSky’s database
compiler to create an unlimited number of custom databases. (page 113)

● Full Customizability (page 83)

● Expanded Object Information Dialog Box (page 39)

● User-Created Object Types and Symbols (page 127)

● Support for the Digitized Sky Survey (page 143)

● Display is recalculated before being redrawn. (page 54)

● Image Link™ superimposes images on the Virtual Sky. (page 137)

● Time Skip toolbar directly changes time setting of Virtual Sky. (page 154)

● User-Created Labels (page 89)

● Customizable Local-Horizon Line (page 63)

● More Picture Formats More than 30 graphics-file formats are supported.

● Drag and drop Sky Documents directly into the Virtual Sky. (page 80)

● Print Preview (page 95)

● Right-Click Pop-Up Menus
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● Docking Toolbars (page 79)

● Tool Tips (page 59)

● Automated Creation of Field of View Indicators (page 67)

● Enhanced Label Control (page 71)

● Direct Entry of Comet and Minor Planet Data (page 73)

● Local meridian line can be displayed or hidden. (page 62)

● The Milky Way is a discrete object that can be displayed or hidden (page 60)

Product Level

All Levels and editions of TheSky Version 5 are supplied on CD ROM.
(TheSky is not available on floppy disk.) All levels and editions include the
Hipparcos, Tycho, and Hubble Guide Star catalogs as the primary stellar
databases.

Level II
(Windows)

Level III
(Windows + Macintosh)

Level IV
(Windows)

Advanced Features n/a importing/exporting data

importing/exporting data; Image Link; USNO
catalog support; TPoint integration; CCDSoft
integration; Orchestrate support; client/server
Internet Telescope support; ACL support;
Paramount GT-1100 support; TeleAPI support;
dome support; auto-astrometry support

GCVS (variable stars
catalog)

28,000 28,000 28,000

IC (Index catalog) 5,382 5,382 5,382

NGC (New General
catalog)

7,840 7,840 7,840

NSV (suspected
variables catalog)

14,000 14,000 14,000

PGC (principal
galaxies catalog)

73,000 73,000 73,000

PK (planetary
nebulae catalog)

1,455 1,455 1,455

WDS (Washington
double stars catalog)

16,000 16,000 16,000

Comets 2,000 2,000 2,000

Minor Planets 41,000 41,000 41,000

Images
700 full-size images, 13,000 thumbnail
images of NGC and IC objects, 100+
Hubble Space Telescope images

700 full-size images, 13,000 thumbnail images
of NGC and IC objects, 100+ Hubble Space
Telescope images, 70,000 thumbnail images of
PGC objects
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All Levels include the basic features (planetarium display; star-chart
printing; comets, minor planet and satellite tracking, eclipse finder, and so
on). (The Macintosh edition does not include the Slide Show feature.)

Level III adds the ability to import and display text-based astronomical
databases, and to select and export data using the List Creator.

Level IV includes additional features for the advanced amateur, plus 70,000
thumbnail images of objects from the PGC catalog.

Except for images, all supplemental databases are supplied at all Levels and
include the same objects.

The Macintosh edition is essentially identical to the Level III edition for
Windows.

Minimum System Requirements

TheSky Version 5 is designed to run on IBM™-compatible computers under
Windows 95™, Windows 98™, or Windows NT™ 4 and take advantage of
their features. It does not run under Windows™ 3.1x or other 16-bit systems.

TheSky Version 5 (Level III only) runs on Power Macintosh™ computers
under the Mac OS 7.5.5 (or later).

At least 30 MB of disk space is required for a Compact installation of any
Level. Over 800 MB is required for full installation of Level IV. At least
16 MB of RAM is needed, and a quad-speed (or faster) CD ROM drive is
desirable, especially if you do not copy all the databases to your hard disk.

Performance

TheSky is advanced, high-performance software that places substantial
performance demands on your computer.
● It is computation-intensive. It performs complex floating-point calculations

to compute the positions of sky objects.
● It is display-intensive. It updates hundreds of thousands of pixels when

the display changes.
● It is disk-intensive. It reads large amounts of data from the hard disk

(or CD ROM drive) and performs extensive cross-referencing among
multiple databases.

Version 5 of TheSky requires more computing power than previous versions.
If your computer can satisfactorily run Windows 95/98/NT, it should be
able to run TheSky. Performance with a processor slower than a 66 MHz
486DX2™ is likely to be unsatisfactory, however—especially if you can’t
copy the GSC databases to the hard disk.

The Macintosh edition runs only on a Power Macintosh.
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Disclaimer

Telescopes do not have an unlimited range of movement. The telescope’s
shape, the way it’s mounted, or the addition of accessories can prevent it
from pointing at particular parts of the sky. If the telescope is forced past
these points, the telescope, its mounting, or accessories might be damaged.

TheSky includes a “limit line” feature that lets you specify these inaccessible
positions; TheSky will try not to touch or cross them. (See page 64.) This
feature is provided by Software Bisque as a convenience, not as a panacea.

Since any telescope can run into its mechanical limits through accident,
carelessness, or component failure, Software Bisque cannot be responsible
for any damage to your telescope that occurs when using TheSky to control it.

Installing TheSky

Before starting installation please read readme.txt in the root folder of the
CD ROM. It might have last-minute information we were not able to put in
this manual.

Level IV is now supplied on two CD ROMs, because, with the addition of
the PGC “thumbnails,” a full installation will not fit on a single CD ROM.
If the hard disk has room for the PGC images, you’ll be prompted for the
second CD ROM when it’s needed. If the PGC images are not copied to the
hard disk, put CD ROM #2 in the CD ROM drive when running the program.

If a previous version of TheSky is installed, you should remove it before
installing Version 5. Remember to back up customized files before removing
the program. (See “Removing TheSky” on page 10.)

TheSky is licensed as a single-user product—please do not install TheSky on
a network. If you need a site license, please contact Software Bisque.

Windows Installation

1 Put the CD ROM in the CD ROM drive.

If you're installing Level IV, use CD ROM #1.

A few seconds after loading the CD ROM, the computer should recognize its
presence and run the installation program. If this does not occur…

a Select Start / Settings / Control Panel.

b Double-click Add/Remove Programs.

The Add/Remove Programs Properties dialog box appears.

c Click Install, then click Next.

Windows searches the CD ROM for setup.exe and runs it. If it doesn’t find it, click
Browse and navigate to the CD ROM’s root directory. Double-click setup.exe .

2 Click Finish to begin the installation.

The installation program prompts you for the information it needs, such as the hard
disk and folder in which to install TheSky. Compact / Typical / Custom installation is
described in the following section.
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Macintosh Installation

1 Put the CD ROM in the CD ROM drive.

The computer should recognize its presence and display the “TheSky” icon.

2 Double-click on the “TheSky” icon on the desktop.

The “Install TheSky” icon should appear.

3 Double-click on the “Install TheSky” icon.

4 Click Install to begin the installation.

The installation program prompts you for the information it needs, such as the hard
disk and folder in which to install TheSky. Compact / Typical / Custom installation is
described in the following section.

Compact / Typical / Custom Installation

The choice of Compact, Typical, or Custom installation controls the amount
of data that’s copied from the CD ROM to your hard disk.

● The Compact option installs only the minimum number of files needed to
run. All databases are accessed from the CD ROM, which must be in the
drive before TheSky can run. Select Compact installation if there isn’t
much free space on your hard disk.

● The Typical option copies the most-frequently accessed databases to the
hard disk, while the less-frequently used databases are accessed from
the CD ROM. The CD ROM must be in the drive to access those
databases (but TheSky will run even if the CD ROM isn’t loaded).

● The Custom option lets you choose which files are copied to the hard
disk. If your hard disk large enough to hold all the databases, choose
Custom and mark all the checkboxes. If all the databases and images
are copied to the hard disk, you won’t need the CD ROM to run TheSky.
Operation will be noticeably faster, too.

These choices represent tradeoffs between access speed and space taken up
on the hard disk. Because the computer can read the hard disk more quickly
than the CD ROM, copying CD ROM files to the hard disk gives faster
operation. If hard-disk space is limited, the Typical option is a good
compromise between speed and disk space.

If the installation program reports insufficient space, deselect the smaller
databases (or program options, such as Patterns in the Sky), one at a time.

You can change TheSky’s setup at any time, by copying files from the CD
ROM to the hard disk (or deleting them from the hard disk), then using the
File Locations command to tell TheSky where to find them. Appendix A,
“Database Locations and Errors,” explains how to do this.
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Removing TheSky

Customizing TheSky modifies the files normal.sky and normal.svp .
The uninstaller doesn’t know they’ve been changed and deletes them.
Back up these files if you don’t want to lose your customizations when
you reinstall TheSky. (Files TheSky didn’t install—such as user-created
Sky Databases—are not deleted.)

Windows Removal

1 Select Start / Settings / Control Panel.

2 Double-click Add/Remove Programs.

3 Highlight “Software Bisque TheSky (Remove only)” in the list box.

4 Click Add/Remove.

5 In the Confirm File Deletion dialog box, click Yes to remove TheSky .

Macintosh Removal

1 Find the “TheSky Astronomy Software” folder on the hard disk.

2 Drag it to the Trashcan.

Typographic Conventions

This manual uses the following typographic conventions.

Example of Convention Description

normal.sky

a:install

; This is a comment.

Courier typeface is used for file and folder
(directory) names, for text typed from the
keyboard, and to display the contents of files.

dimmed
Press and hold the left button.
Paramount GT-1100

Italic text is used to highlight new terms.
It’s also used for emphasis...
and to identify product names.

W
ENTER
ALT+Z

Keystrokes are shown in SMALL CAPS. If there
is a plus sign (+) between two keys, press and
hold the first key, then press the second.

UP, DOWN
LEFT, RIGHT

The “arrow” directional keys are represented
by words, rather than arrow symbols.
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Windows and Macintosh Conventions

This manual assumes you have a basic knowledge of the Windows or
Macintosh interface. Here are a few reminders about mouse usage and
Windows/Macintosh terminology.

Term Description

Click “Click” always means “left-click.” If you’re supposed to press
the right mouse button, the text will say “right-click.” (On the
Macintosh, press CONTROL when you click). For Windows
keystrokes using the ALT key, press z on the Macintosh.

Select Point the mouse pointer at a command, an item in a list, or a
tab, then click.

Drag Press and hold the left mouse button. Then move the mouse
to outline the area or objects you want to select.

Dimmed When a command or function is not available, it’s shown in
gray text (instead of black). Unavailable commands and
functions are therefore said to be dimmed.

Marked /
Clear

If a checkbox has a check mark, it’s “marked.”
If there is no check mark, it’s “clear.”

Control button
(Windows)

The Control button is the program icon at the upper-left corner
of a window or dialog box. Clicking it once displays the
Control menu. Double-clicking it exits the program or dialog
box. The X button at the upper- right can also be used to close
a window or exit the program.

The Windows and Macintosh versions of TheSky are virtually identical. All
screen shots and descriptions are of the Windows version. The Macintosh
version is described or shown only when it differs.

Running TheSky

Under Windows, the installation program adds TheSky to the Programs
menu. (You might want to create a folder for TheSky and move these items
into it.) To run TheSky, select Start/Programs, then click TheSky’s icon.

If you want TheSky to run automatically when you start Windows, add
TheSky to the Startup folder.

On the Macintosh a “TheSky” icon is added to the desktop. Click on it to run
the program.
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TheSky’ s Interaction with Other Software

TheSky periodically takes control of the computer to update the display (even
when the program is minimized). If the brief interruptions this causes are
inconvenient, you can stop the updates by clearing the “Use computer’s clock”
checkbox in the Site Information dialog box. (See page 18.)

Tip of the Day

Every time TheSky runs it displays the Tip of the Day, a randomly selected
hint about how to use TheSky, or information about some feature you might
have overlooked. Click the Next Tip button to see more tips.

If you don’t want to see the tips, clear the “Show Tips on Start-up” checkbox.
You can still read the tips by selecting the Tip of the Day command from the
Help menu.

The tips are in tips.txt in TheSky’s user folder. You can edit this file
with any text editor (such as the Windows Notepad or SimpleText on the
Macintosh) to add, delete, or modify tips. The “tip” shown above was
created this way.

Getting Started with TheSky

The rest of this chapter is a brief overview of TheSky. We suggest working
through it to get a feel for the program. You can then read the remainder of
the manual, or experiment on your own.

Basic features and operation are covered in Chapters 2 through 8. If you’re
new to TheSky, you should read through these chapters before moving on to
TheSky’s advanced features.

Setting the Time and Location

TheSky is often used to preview what you expect to see in tonight’s sky. The
program therefore needs to know your terrestrial coordinates. These are set
using the Site Information dialog box (page 17). You can select a predefined
location, or enter any set of coordinates.
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TheSky also needs to know the time for which to display the heavens. You
can choose a specific time, or let the display follow the computer’s clock,
updating in real time. See page 18.

Orienting the Virtual Sky

The first time TheSky runs, it comes up with the Virtual Sky in “Zenith Up”
mode, looking south. By default, it displays the following objects and labels.

● the Sun, Moon, planets, Milky Way, and many deep-space objects
● the ecliptic, meridian, local horizon, and constellation-figure lines
● the “common” names of comets, non-stellar and Messier objects
● the Bayer (Greek-letter) designations of the brighter stars

The Virtual Sky can be oriented in many ways. The material starting on page
22 describes these options.

Scrolling the Virtual Sky

You can scroll the display to see a part of the sky that isn’t currently visible.

The directional arrows on the keyboard are one way to scroll. Try pressing
them, and watch the display move. Or click the arrow buttons in the
Orientation toolbar. See page 28 for more information about scrolling.

Changing the Field of View

The Virtual Sky is initially set to a 100° field of view. This is roughly the field
of view of the human eye. You can change the display to a wider or narrower
field. The easiest way is the “magnifying glass” buttons in the Orientation
toolbar. Try clicking them to see what happens. Refer to page 25 to learn how
to select exactly the field of view you want.

Moving to Specific Sky Coordinates

The arrow keys provide only a coarse positioning of the Virtual Sky. The
Move To command lets you position the center of the display at exactly the
coordinates you want. See page 29 for a description of Move To.

Pictures

TheSky includes databases of astronomical photographs. When one or more
is active, icons that look like 35mm cameras appear in the Virtual Sky.
Clicking one of these icons displays the picture associated with it.

As shipped, the databases with Solar System images and the David Malin
AAO images are loaded and active. Chapter 16, “Image and Multimedia
Databases,” has more information about image databases, including how
you can create your own custom databases.
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Object Information

TheSky can display information about any celestial object in the Virtual Sky.
All you have to do is click on the object. The selected object is marked with a
bull’s eye and information about the object appears in the Object
Information dialog box. Information about the Andromeda galaxy (M31) is
shown below.

Printing the Screen

The current display can be printed at any time. If you have a printer
connected to your computer, try clicking the Print button on the toolbar.

Going Further

This introduction barely scratches the surface of TheSky’s features and
functions. There are several ways to continue your exploration.

● Experiment with the program. Try anything that comes to mind.
You can’t damage the software or the computer.

● Continue reading the manual. If a feature looks interesting, try it out.
● Use the Index or Table of Contents to find information about a specific

feature.

If You Need Help...

Use the Help menu to get additional information.

● Using Help explains how to use the Help system.
● Index lets you search for specific words or topics.
● Tip of the Day is a list of short reminders about features or functions

and how to use them.
● The Astronomy Tutorial is a newcomer’s introduction to astronomy.

Under Windows, to get help with a specific menu command, open the
menu, then press the DOWN arrow to highlight the command. (Don’t click on
the command, or you’ll execute it.) Then press F1.
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Under Windows or on the Macintosh, you can also press SHIFT+F1 to turn the
regular cursor into the Help cursor. (Or click the Help button in the Standard
toolbar.) Click on any button or command to get information about it.

Many dialog boxes have Help buttons that supply specific information about
the use of that dialog box.

Product Support

We have conscientiously tried to make this manual complete, accurate, and
easy to understand. We therefore ask that you spend a few minutes with the
manual (or online help) before contacting us. A little reading and a bit of
experimenting should answer your question.

If you’re still stuck, please call us at (303) 278-4478, and we’ll be happy to
help you. You can also write us at:

Software Bisque
Suite A
912 Twelfth Street
Golden, CO 80401

Please include the following information when you write, or have it ready
when you call.

● The version and serial number. They are displayed when you select
“About TheSky” from the Help menu, or click the “About TheSky”
button in the Standard toolbar.

● Your operating system—Windows 95/98/NT, or the Macintosh OS.
● Your hardware configuration—make and model of computer, processor

type and speed, graphics-card manufacturer and model.
● The exact wording of any messages that appeared on your screen.
● What you were doing when the problem occurred.
● How you tried to solve the problem.

Despite our valiant efforts, there may be omissions or errors. If you find any,
please let us know.

The author of this manual really cares about its accuracy, completeness, and
usability. If you have suggestions about improving the online help or the
printed documentation, please tell us. We do listen!

Using the Internet

You can also contact us through our Internet Web site, www.bisque.com .
Select “Comments” to leave a message.

Besides providing information about Software Bisque products, photos of
many astronomical objects, and links to other useful or interesting sites, our
Web site also has software updates, revised orbital elements for comets and
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minor planets, and specialized deep-sky databases. “Brian’s Corner” has
several pages of FAQs that should help you resolve problems.

The contents and organization of the Web site are likely to change. Be sure to
check from time to time to see “what’s new” and “what’s different.”
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2 Orienting the Virtual Sky

When you run TheSky, the first thing you’ll usually do is adjust the display
(which we call the Virtual Sky) to show the part of the heavens you want to
study. This chapter (and the following) explain how to position the Virtual
Sky exactly how and where you want.

Selecting Terrestrial Coordinates

The first step in orienting the Virtual Sky is setting the point on the surface
of the Earth from which you’d like to view the heavens. To begin, select the
Site Information command from the Data menu. When the Site Information
dialog box appears, click the Location tab.

You can select a predefined location, or enter any coordinates you want.
The coordinates of many US cities have already been entered in the file
United States cities.loc . The city names in this file are displayed in
the Description list box.

To see if your city is listed, click the arrow at the right of the Description
box, then scroll the listings. When you find your city, click on its name to
highlight it. Then click Apply to make it the default setting. (Click Cancel
to quit without changing the location.)

Under Windows, you can jump to an entry by typing its name. Click the
arrow, then enter the first letters of the name. For example, typing SE moves
the list to the first entry starting with ‘SE’—the author’s home city, Seattle.

Click OK to return to the Virtual Sky (or click Apply if you want to see the
changes without exiting). The mouse pointer changes to the symbol at the
left while TheSky recomputes the position of the Sun, Moon, and planets.

For sites outside the USA, there are two other location files—Cities

outside USA.loc and German cities.loc . To load one of these files,
click Open. Highlight the file’s name in the file list, then click OK. As before,
select the nearest city. (There is also a World Observatories.loc file with
the coordinates of many of the world’s leading observatories.)



Getting “Close to Home”

For most users, selecting a nearby city should be satisfactory. However, if
none of the listed cities is near you, or you have a GPS receiver and want to
be very precise, you can enter your own choice of coordinates.

1 To change the coordinates of an existing location, select that location.

If you’re entering coordinates for an unlisted location, the selection doesn’t matter.

2 Enter the Latitude and Longitude.

Use positive values. Click on the North/South and East/West radio buttons to
indicate the hemisphere.

3 Enter the Time Zone.

Time zone numbers start at 0 at Greenwich, and increase to the west. For example,
the Pacific coast of the US is time zone 8. Negative time zones are supported.

4 Enter the Elevation (in meters).

The elevation affects the visibility of objects near the Virtual Sky’s horizon.

5 Enter a name or identifier for these coordinates in the Description box.

This is usually the city and state (or country), but it can be anything you like.
If you use an existing name, the new coordinates will replace the old ones.

6 Click the Add button.

The new coordinates and your description are saved in the currently selected
location (.LOC) file. If you change the coordinates of an existing location, you
are prompted to confirm the change.

7 Click Apply or Close.

The new site coordinates are now the default.

To delete an entry, highlight it and click Remove. You are prompted to
confirm the deletion.

Setting the Time and Date

TheSky also needs to know the time. By default, TheSky uses the current time
from your computer’s internal clock. If you want to see how the sky will
look tonight (or next week, or next month, or on 10/12/1492) you need to
enter the appropriate day and time.
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1 Select the Date and Time tab.

2 Clear the “Use computer’s clock” checkbox.

When this checkbox is clear, the Virtual Sky is no longer automatically
updated to reflect the passage of time.

3 Select the month from the Month list box.

4 Type the date and time in the edit boxes (or click the spin buttons).

Years preceding the Common Era (CE) are entered as negative numbers.

5 Select the appropriate Daylight Saving Adjustment Option.

6 Click Apply or OK.

As before, TheSky recomputes the positions of Solar System objects. Then it
redraws the heavens as they appear at the time and place you selected.

Interactive Changes

Clicking the Apply buttons updates the display without exiting the dialog box.
This makes it easy to view the sky at different times or from different locations,
without having to repeatedly open and close the Site Information dialog box.

Setting Your Computer’s Clock

Personal computers have notoriously inaccurate clocks that can gain or lose
many seconds each day. One way to set the clock is to listen to the shortwave
time signals from WWV or WWVH. These stations are run by the National
Institute of Standards and Technology (NIST), and broadcast at 5, 10, 15, 20,
and 25 MHz. Use the Date/Time applet in the Control Panel to update the
time. Macintosh users with Mac OS 8.5 or later can also use the Date & Time
Control Panel to automatically set their clock from a Network Time Server.

Another way to set the time is to call the NIST time service. TheSky includes
software to make the call (via your modem) and set the computer’s clock.

1 Select the Date and Time tab.

2 Click Time Service.

3 In the Modem COM Port box (Modem COM Port or Serial Port on the
Macintosh), select the port your modem is connected to.

4 In the Baud Rate box, select the speed of the connection.

If your modem can run at 9600 bps or faster, select 9600.

5 The NIST phone number is already entered.

This is a toll call. You must be 18 years old, or have your parents’ permission.

6 Click OK.

TheSky dials the NIST, obtains the current time, and resets your computer’s clock.
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Understanding Projections

Ever since we discovered that the Earth wasn’t flat, but spherical, map
makers have been looking for ways to display a curved surface on a flat
sheet of paper.

A sphere cannot be projected onto a plane without distortion. In the most-
commonly used projection—Mercator—objects get larger the farther they
are from the Equator. This causes Alaska to look nearly as large as the rest
of the United States. The Mercator projection was adopted by navigators,
however, because a straight line drawn between any two points represents
a “great circle”—the shortest navigable distance between the points.

Other projections have their own combinations of strengths and weaknesses.
All projections are compromises—the “best” projection is the one whose
advantages outweigh its disadvantages for a particular application.

By default, TheSky uses stereographic projection for fields of view of 50° or
wider. Stereographic projection is said to be “conformal.” Although (as with
all flat maps) the overall projection is distorted, all lines of declination and
right ascension intersect at right angles, as they do on the celestial sphere.

The advantage of stereographic projection is that, over small areas of the
display, object shapes are only slightly distorted. Constellations remain easy
to identify. Compare this with the polar projection of a planisphere. There is
almost no distortion near the Poles, but constellations near the horizon are
badly stretched out of shape. (A planisphere is one of those rotating star
charts that approximate what’s visible in the sky at a given date and time.)

13h 21h-60d-40d

-20d

+0d

+20d

Stereographic Projection for the Full (235 °) Virtual Sky
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When the Virtual Sky is set to a field of view less than 50°, the projection
automatically switches to orthographic projection, which displays the sky
more as it would appear on the surface of a sphere. ( No other projection is
available below 50°.) Orthographic projection provides the best match of the
image plate to the Virtual Sky when using Image Link (page 137).

When stereographic projection is in use, the bull’s eye that marks a selected
object does not always fall exactly on top of the object. For more-precise
positioning, switch to orthographic projection.

Projections (View menu)

Stereographic projection is the default for fields of view of 50° and greater.
The Projections command from the View menu changes the projection. In
the Projections dialog box, click the radio button of the projection you want.

The selected projection becomes the wide-angle default when you click OK
to exit. It takes effect only when the field of view is 50° or greater—no change
occurs if the current field of view is less than 50°.

● Stereographic The default for fields of view equal to and greater than 50°.
It keeps lines of right ascension and declination at right angles and
minimizes local distortion. Conformal. 235° maximum field of view.

● Orthographic Displays the sky more as it would appear on the surface of
a sphere. It’s the default (indeed, it’s the only available projection) for
angles of view less than 50°. It is used with the Image Link function (page
137) to match the projection of photographic and CCD images, which are
inherently orthographic. Conformal. 180° maximum field of view.

● Mercator Shows the celestial sphere like a conventional map. It allows
wider fields of view, including a 360° view that shows the entire celestial
sphere. Conformal. 360° maximum field of view.

● Gnomonic Displays meteor paths as straight lines, as seen when viewing
a meteor shower. Non-conformal. 150° maximum field of view.

● Azimuthal Equal-Distance The distance between objects having a particular
angular separation on the celestial sphere is the same at any part of the
Virtual Sky. Non-conformal. 300° maximum field of view.

● Azimuthal Equal-Area The areas of any sections of the celestial sphere
subtending a particular solid angle are the same at any part of the Virtual
Sky. Non-conformal. 235° maximum field of view.
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Setting the Orientation

Before navigating the Virtual Sky, you need to choose an orientation. The
orientation sets the basic layout of the Virtual Sky and selects the coordinate
system (horizon or equatorial). There are three orientations.

● Zenith Up
● Pole Up
● Free Rotation

You can select the orientation from the Orientation menu, or click the
corresponding button in the Orientation toolbar. Either way, the button
remains “down” to show which mode is selected.

Zenith Up

Zenith Up projection is referenced to horizon coordinates. It’s used when
you want TheSky to simulate the view from your observing site.

Selecting Zenith Up rotates the Virtual Sky so the selected site’s zenith
(90° altitude) is at the top (whether or not that part of the sky is visible
in the current field of view). The current field of view and coordinates
of the center of the Virtual Sky do not change.

In Zenith Up mode, scrolling the display left or right changes the azimuth.
Scrolling the display up or down changes the altitude.

Pole Up

Pole Up projection references the Virtual Sky to equatorial coordinates. It’s
the most-intuitive mode when you’re studying celestial objects themselves,
rather than how they’re viewed from a specific site.

Selecting Pole Up positions the Virtual Sky so that the North or South
Celestial Pole is at the top (whether or not the Pole is visible in the current
field of view). Which Pole is determined by whether your site location is
north or south of the equator.

The current field of view and coordinates of the center of the Virtual Sky do
not change. Since Pole Up is not referenced to the site location, the Local
Horizon line (page 63) has no meaning and is removed from the display.

In Pole Up orientation, scrolling the display left or right changes the right
ascension. Scrolling the display up or down changes the declination.

Free Rotation

Free Rotation lets you rotate the Virtual Sky to any angle.

1 Select Free Rotation from the Orientation menu.

Or click the Free Rotation button or the Rotate Tool button in the Orientation toolbar,
or press ALT+R (zR on the Macintosh). The Rotate Tool is displayed.
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The Rotate Tool is a line that runs from the center of the display
and points to the North celestial pole, with the letter N in a circle.

2 Drag the N circle to rotate the display.

If you press CONTROL (z on the Macintosh) while dragging, the display
is positioned at multiples of 15° (0°, 15°, 30°, 45°, and so on).

To return the Rotate Tool to 0°, click the N circle.

3 Click the Rotate button a second time to hide the Rotate Tool.

Or press ALT+R (zR on the Macintosh) a second time.

Even though the Tool is now hidden, the display remains in Free Rotation mode.

If you select a different orientation while the Rotate Tool is displayed, the
Tool remains on the screen. If you drag the tool or press ALT++ or ALT+–
(z+ or z– on the Macintosh), the display returns to Free Rotation mode.

The Look Commands

When previewing the night sky, you usually want to orient the display to
the approximate direction you’ll face. There are five preset orientations—
North, South, East, West, or Zenith (Look Up).

These commands appear in the Look command of the Orientation menu,
and as buttons on the Orientation toolbar. Or you can right-click
(CONTROL+click on the Macintosh) anywhere in the Virtual Sky, and select
Look from the pop-up menu.

Each Look command also has an accelerator key. Press N, S, E, W, or Z.

● North, South, East, and West place the horizon at the bottom of the
screen, with the zenith at the top. The field width is set to 100°,
giving a detailed view of about ¼ of the sky.

● Zenith adjusts the field width to 200°, with the zenith at the center of the
screen. This view is similar to that of a planisphere, or the monthly star
charts published in astronomy magazines.

Selecting any Look command switches the Virtual Sky to Zenith Up
orientation. Scrolling movements now move the display with respect to
horizon (Alt-Az) coordinates. (”Up” scrolling is disabled in Zenith view,
however, since you cannot move “above” the zenith.)

Orienting the Virtual Sky 23



Interrupting a Screen Redraw

TheSky completely redraws the Virtual Sky whenever you scroll or zoom.
The more items displayed (stars, deep-space objects, reference lines, labels,
and so on), the longer the redraw takes.

The calculations are performed first, then the screen is redrawn. The redraw
is not instantaneous. You can interrupt it by pressing ESC. (On the Macintosh
you can press ESC or z. (period).) The Virtual Sky shows only those objects
that had been redrawn at the time you pressed ESC. To complete the redraw,
select Redraw Screen from the View menu.

Scrolls or zooms can also be interrupted by pressing any scroll or zoom key.
TheSky immediately begins redrawing the display at the new coordinates or
magnification. You can “tap” the scroll or zoom keys to make a big change
in the display, without having to wait for multiple redraws.

Interrupting a redraw can also speed things up when you make more than
one change at a time. For example, if you want to hide the constellation
boundaries, then display the horizon lines, you can press ESC as soon as you
turn off the boundaries, instead of waiting for the redraw.

Undoing Changes to the Virtual Sky

Changes to the Virtual Sky’s orientation can be reversed by selecting Undo
from the Edit menu. Or press CONTROL+Z (zZ on the Macintosh) or
ALT+BACKSPACE (Windows).

TheSky remembers up to 15 orientation and move changes made since the
beginning of each session, including the automatic display updates that
occur every 15 minutes in Zenith Up mode. You can keep undoing changes
until you exhaust the “undo” list. At that point, the Undo command is
dimmed.

The list of changes is discarded when you exit TheSky. If there’s a group of
settings you want to keep, use the Save As command to create a Sky
Document (.SKY file).

You can also undo changes that have not yet been saved in the current Sky
Document. Select the New command from the File menu (or press
CONTROL+N, or click the New button in the Standard toolbar). You are
prompted to save changes to the current Sky Document. Click No to discard
the changes. The last saved version will then be reloaded.

Changes that don’t affect orientation, position, or field width—such as
turning on the Equatorial Grid or switching to the High Density display—
are not recorded. They are undone by deselecting them.
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3 Navigating the Virtual Sky

This chapter explains how to scroll the Virtual Sky, change its field of view,
or display a specific area of the heavens.

Zooming the Display

When TheSky first runs, the field of view has the default value of 100°. This is
approximately the same field of view as the human eye.

You can “zoom in” or “zoom out” to see less or more of the sky. As the field
is narrowed, more dim, high-magnitude objects are displayed.

The Zoom To Command

There are several ways to change the field width. One is to use the Zoom To
command from the Orientation menu (or from the pop-up that appears
when you right-click (CONTROL+click on the Macintosh) in the Virtual Sky).

Choose from the list of seven preset angles. You can also select one directly
with the keystrokes listed below.

Designation Field of View Keyboard Shortcut

Maximum 150°–360° (varies with projection) HOME z7

Wide Field 150°–180° (varies with projection) CONTROL+W z6

Naked Eye 100° CONTROL+E z5

Binoculars 50° CONTROL+B z4

Finder 10° CONTROL+F z3

Telescope 1° CONTROL+T z2

Minimum 1' END z1

HOME and END are easy to remember, because they represent the beginning
(lowest) and ending (highest) limits of magnification. The others correspond
(approximately) to the fields of view suggested by their names. For a simple
mnemonic, think “WEBFooT.”

Zoom Buttons

Another way to change the field width is to click one of the “magnifying
glass” buttons on the Orientation toolbar. Like Alice’s mushroom, one side
(“minus”) shows you more of the sky, the other side (“plus”) shows you less.

When zooming in, the incremental change is 20% of the current field width.
For example, if the width is 180°, clicking the plus button decreases it to 144°.
When zooming out, the change is 25% of the current field width. (A 25%
increase and a 20% reduction are equivalent changes.)



Pressing CONTROL (OPTION on the Macintosh) when you click reduces the
increment to about ¼ its default value—5% in each direction.

Pressing CONTROL+SHIFT (OPTION+SHIFT on the Macintosh) when you click
reduces the increment to about 1⁄20 its default value—1% in each direction.

The PAGE UP and PAGE DOWN keys work the same as the “minus” and “plus”
zoom buttons (respectively). If you hold down either one, the Virtual Sky
zooms as rapidly as it can, without pausing for a full redraw. As with the
zoom buttons, pressing CONTROL or CONTROL+SHIFT (OPTION or OPTION+SHIFT

on the Macintosh) at the same time reduces the zoom increment to ¼ or 1⁄20

its default value.

The Zoom Box

The most flexible way to “zoom in” is to outline the desired area with a zoom
box. This gives exactly the magnification you want, and automatically centers
the selected area. To select a specific area:

1 Point the mouse cursor at the upper-left corner of the area.

If you normally hold the mouse in your left hand, you can point at the upper-right
corner instead.

2 Drag the mouse cursor to outline the desired area.

The selected area is outlined with a rectangle. Its angular dimensions—in
degrees and minutes—are shown in the lower-left corner of the Status Bar.
If the zoom box is too large or has the wrong shape, you can drag “backwards” to
change it. Dragging past the starting point “flips” the zoom box right-to-left.

3 Release the mouse button.

If the zoom box doesn’t have the shape or position you want, click outside the zoom
box to remove it. Or right-click (CONTROL+click on the Macintosh) in the Virtual Sky
and select Remove Zoom Box from the pop-up menu. Then repeat Steps 1–3.

4 Click anywhere inside the zoom box to zoom in.

The zoom box can be drawn with any aspect ratio, regardless of the aspect
ratio of the display. (If you want the zoom box to have the same aspect ratio
as the display driver, press CONTROL as you drag.) The Virtual Sky zooms to
the highest magnification that shows at least the area you outlined.

You cannot zoom closer than an angle of view of 1'. If you try to zoom closer,
the center of the Virtual Sky is repositioned at the center of the zoom box.

26 TheSky Astronomy Software



Large Zoom Boxes

If the zoom box’s height or width is larger than about half the screen, the
new view might show more than the previous screen. This is a side effect of
stereographic projection. If it occurs, just select a smaller zoom area.

Entering a Field Width Directly

If you want a specific field width, you can enter it in the Find dialog box.

1 Press F, or click the Find button in the Objects toolbar.

The Find dialog box appears.

2 Type Z in the Find edit box, followed by the angle you want (in degrees).

You can enter fractional angles. For example, Z11.27 produces a field of view of
11° 16' 12". To enter an angle in arc-minutes, add the letter m after the angle.

3 Click OK.

The Virtual Sky zooms to the angle you entered.

Minimum and Maximum Angles of View

Regardless of how you change the viewing angle, TheSky “beeps” if you try
to zoom wider than the maximum field of view allowed for that projection,
or narrower than 1'. To remind you that you can’t zoom any farther, the
minus button is dimmed at the maximum field of view, and the plus button
is dimmed at the minimum field of view (1').

The maximum field is 360° for Mercator, 300° for azimuthal equal-distance,
235° for azimuthal equal-area & stereographic, 180° for orthographic, and
150° for gnomonic.

Zooming and Planet Size

At wide angles of view, the planet symbols are all about the same size—
almost as large as the Sun. This makes them easy to find and recognize.

As the field width narrows, the size of a planet remains constant until the
point at which the planet would actually be visible as a disk. The planet
symbol is then replaced by a disk whose diameter matches what you would
see through a telescope. (Pluto is the only exception. Even at the Virtual
Sky’s minimum field width, it cannot be resolved as a disk.)

Keep this in mind if you set the Virtual Sky’s field of view to match your
telescope’s field of view. Until you reach the transition point, the planet
looks smaller through the telescope than it does in the Virtual Sky.

Changes in Projection

As explained on page 21, the Virtual Sky’s projection automatically switches
to orthographic when the field of view is 50° or less. As a result, changing
the field width sometimes produces “unexpected” changes in object position
or field orientation. This is normal behavior.
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Scrolling the Display

TheSky’s display can be scrolled, just as a document in a word processor can
be scrolled. There are several ways to scroll.

Scrolling with the Arrow Keys (Orientation toolbar)

The arrow keys scroll the display directly. You can use any of the three sets
of arrow keys.

● the “inverted T” group on the keyboard
● the arrow keys in the keyboard’s numeric keypad
● the arrow-key buttons in the Orientation toolbar

The default movement is about 10% of the current field of view. Scrolling
can be modified in the following ways.

● If you hold down any of the keyboard arrow keys, the display scrolls
as rapidly as it can, without pausing for a full redraw.

● Pressing CONTROL (OPTION on the Macintosh) while scrolling reduces the
scroll increment to ¼ its default value.

● Pressing CONTROL+SHIFT (OPTION+SHIFT on the Macintosh) while
scrolling reduces the scroll increment to a single pixel.

Scrolling Direction

First-time users sometimes find the screen movement confusing. “When I
press the DOWN arrow, the display moves up. Is that right?” Yes, it is.

The arrow movements represent motion in the sky. The arrows point in the
direction you’d move your head to look at a different part of the sky.

How Left/Right Scrolling Looks on the Screen

Left-right scrolling is not left-right movement of the Virtual Sky, but a change
in azimuth or right-ascension coordinates. How it looks depends on which
part of the sky is displayed.

Imagine a spinning sphere. If you view it from above a pole, it appears to be
rotating. If you view it from the equator, it appears to be moving sideways.

Left-right scrolling works the same way. If Pole Up is selected, and either
pole is visible, pressing the LEFT or RIGHT buttons rotates the display. If a pole
is not visible, the display scrolls sideways.

The same movements occur when Zenith Up is selected, whether or not the
zenith is visible in the Virtual Sky.

Either way, it’s the same motion. Only the point of view differs.
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Upward Scrolling Disabled in Zenith Orientation

In Zenith (Look Up) orientation, the local zenith is at the center of the screen.
Upward scrolling is disabled, because you cannot scroll “above” the zenith.
(You can still scroll “down.”) Pressing LEFT or RIGHT rotates the display.

The Move To Command (Orientation menu)

The Move To dialog box positions the center of the Virtual Sky at any
combination of right ascension–declination, or altitude–azimuth. You can
enter coordinate values, or select them graphically by dragging a cursor.

Entering Coordinates

1 Select the Move To command from the Orientation menu.

Or right-click (CONTROL+click on the Macintosh) anywhere in the Virtual Sky and
select Move To from the pop-up menu. The Move To dialog box appears.

2 Click the Entry Mode radio button of the coordinate system you want—
Equatorial or Horizon.

You can use either, regardless of whether you’re in Pole Up or Zenith Up mode.

3 Enter the new coordinates in the edit boxes.

Enter Altitudes and Declinations as positive numbers. Then click the North
or South radio button to indicate the hemisphere.
Right ascension is assumed to be in hours—not degrees. If you enter a value
larger than 23, TheSky treats it “modulo 24”—it divides the value by 24 and
uses the remainder. For example, an entry of 53 would be treated as 5.

4 Select the Epoch—Current, 2000.0, or 1950.0.

Current is for the year shown on the Date and Time sheet. If you select a different
Epoch, TheSky converts your coordinates to the Current Epoch.

5 Click OK.

The screen is redrawn with the new coordinates at the center of the display.

Telescope Slewing

If TheSky is actively linked to your telescope, the Slew To button is displayed
at the lower right. Click it to slew to the coordinates you entered.
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Selecting Graphically

1 Select the Move To command from the Orientation menu.

Or right-click (CONTROL+click on the Macintosh) anywhere in the Virtual Sky
and select Move To from the pop-up menu. The Move To dialog box appears.

2 Click the Entry Mode radio button of the coordinate system you want
to use—Equatorial or Horizon.

You can choose either, regardless of whether you’re in Pole Up or Zenith Up mode.

3 Position the mouse cursor anywhere within the coordinates window
at the top of the dialog box.

In Horizon mode, the axes are azimuth (horizontal) and altitude (vertical). In
Equatorial mode, the axes are right ascension (horizontal) and declination (vertical).
The cross-shaped cursor shows the coordinates of the current screen center.

4 Drag the cursor to the new coordinates.

The mouse cursor changes to a rectangle with marker lines when you drag.
To cancel the move, drag the cursor out of the coordinates window.

5 Release the mouse button.

The screen is redrawn with the new coordinates at the center of the display.

Dragging the cursor is not as precise as entering coordinates. However, it
lets you see both the old and new positions. It’s an easy way to move the
display close to known coordinates without having to type them in.

Understanding Coordinate Systems

Remember that Equatorial (right ascension-declination) and Horizon
(altitude-azimuth) are two entirely different coordinate systems.
● Equatorial coordinates point to absolute positions on the celestial

sphere. Use them when you want to center a specific object (such
as a galaxy or variable star).

● Horizon coordinates are relative to the sky above your current horizon
line. Use them when you want to position the display toward a
particular compass direction.

Centering the Display

Sometimes you want to move a point in the Virtual Sky to the center of the
screen. For example, Sirius might be at the upper-left corner, and you want
to move it to the center. There are two ways to do this.

● Left-click on the point (or object) you want to be at the screen center. In
the Object Information dialog box, select Cursor Position (or the object)
from the Object List. Then click the Center button.

● Right-click (CONTROL+click on the Macintosh) on the point you want to be
the new screen center. Then click Center in the pop-up menu.
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Where am I?

As you zoom and scroll the Virtual Sky, you might lose track of where you’re
looking. TheSky normally displays more stars than can be seen with the naked
eye, so constellations are sometimes hard to identify.

If this is a problem, try displaying the Equatorial Grid, Horizon Grid, or
Constellation Lines. Any of these provides a useful reference.

To see exactly where the display is centered, select the Status Bar command
from the View menu. Mark either the “Equatorial” or “Horizon” checkbox in
the Screen Position section and click OK. This adds a set of coordinates to the
Status Bar that show the RA-Dec or Alt-Az of the center of the Virtual Sky.

Making It All Make Sense

We’re often asked about the differences between Pole Up and Zenith Up
modes. Some users lose their bearings when switching between the modes.
The screen is redrawn in a way that doesn’t seem to make sense.

The following explanation should clarify the differences.

Pole Up and Zenith Up are separate modes that display the sky in different
ways. Confusion occurs because users expect these modes to “relate” to each
other in some way. They don’t. They have nothing to do with each other.

You would normally select the mode that’s appropriate for the way you’re
using TheSky and stay with that mode until you have a reason to change.
The following examples should make this clear.

● When planning a night’s viewing, you’d probably select Zenith Up
(or one of the Look modes—North, South, East, West, Look Up). These
modes show the sky the way you’d see it from the viewing site—which
objects are visible, where they rise and set, and so on. Scrolling moves
the display with respect to the local coordinates.

● When studying celestial objects, you’d probably select Pole Up mode.
If you’re learning the constellations, memorizing the locations of Messier
objects, or viewing TheSky’s image database, you’re interested in the
celestial sphere itself—not how it looks at a particular place or time.
You want to move and position the display with respect to celestial
coordinates—not those of your viewing site.
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Interrupting a Screen Redraw

TheSky completely redraws the Virtual Sky whenever you scroll or zoom.
The more items displayed (stars, deep-space objects, reference lines, labels,
and so on), the longer the redraw takes.

The calculations are performed first, then the screen is redrawn. The redraw
is not instantaneous. You can interrupt it by pressing ESC. (On the Macintosh
you can press ESC or z. (period).) The Virtual Sky shows only those objects
that had been redrawn at the time you pressed ESC. To complete the redraw,
select Redraw Screen from the View menu.

Scrolls or zooms can also be interrupted by pressing any scroll or zoom key.
TheSky immediately begins redrawing the display at the new coordinates or
magnification. You can “tap” the scroll or zoom keys to make a big change
in the display, without having to wait for multiple redraws.

Interrupting a redraw can also speed things up when you make more than
one change at a time. For example, if you want to hide the constellation
boundaries, then display the horizon coordinates, you can press ESC as soon
as you turn off the boundaries, instead of waiting for the redraw.

Undoing Changes to the Virtual Sky

Changes to the Virtual Sky’s field width and position can be reversed by
selecting Undo from the Edit menu. Or press CONTROL+Z (zZ on the
Macintosh) or ALT+BACKSPACE (Windows).

TheSky remembers up to 15 orientation and move changes made since the
beginning of each session, including the automatic display updates that
occur every 15 minutes in Zenith Up mode. You can keep undoing changes
until you exhaust the “undo” list. At that point, the Undo command is
dimmed.

The list of changes is discarded when you exit TheSky. If there’s a group of
settings you want to keep, use the Save As command to create a Sky
Document (.SKY file).

You can also undo changes that have not yet been saved in the current Sky
Document. Select the New command from the File menu (or press
CONTROL+N (zN on the Macintosh), or click the New button in the Standard
toolbar). You are prompted to save changes to the current Sky Document.
Click No to discard the changes. The last saved version will then be reloaded.

Changes that don’t affect orientation, position, or field width—such as
turning on the Equatorial Grid or switching to the High Density display—
are not kept track of. They must be undone manually.
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4 Displaying Celestial Objects

TheSky’s databases are whole catalogs (such as the GSC). From these catalogs
you select the types of objects displayed and their limiting magnitudes.

The Hipparcos, Tycho, and Hubble Guide Star catalogs are supplied with all
Levels, plus catalogs with specialized contents. Please refer to the table on
page 6 for a description of their contents.

Type Selection

The Filters dialog box controls which objects and object types are displayed
in the Virtual Sky. You can hide those you aren’t interested in, both to reduce
screen clutter and shorten the time it takes to redraw the Virtual Sky.

There is a large number of distinct object types, to provide fine control over
what is and isn’t visible. Object types in the Celestial Object box are grouped
into the following classes, instead of being listed in alphabetical order.

● stars
● galaxies
● clusters
● nebulae
● NGC objects
● quasars and X-ray/radio sources
● the Sun, Moon, and individual planets
● comets and minor planets
● spacecraft
● multimedia files
● the Milky Way
● all other objects, images and lines that can be displayed



To select an object, click on its name, or type the first letter of its name. If
more than one object starts with the same letter (for example, Star and Sun),
the selection switches among those objects each time you press that letter.

To select a range of objects, select the first, then press SHIFT as you click on
the last. To select (or deselect) individual objects, press CONTROL (z on the
Macintosh) as you click.

Each object has its own checkbox. Mark or clear the checkbox to display or
hide objects of that type. If more than one object is selected, marking or
clearing any checkbox marks or clears the checkboxes of all those objects.

Marking a checkbox will not display the associated object type if there isn’t
anything to display! For example, if Comets is marked, but no comets are
selected in the Comets and Minor Planets dialog box, no comets will appear.

The Select Types buttons make it easy to display or hide everything in a
class. Clicking any of the following buttons

● Stars
● Galaxies
● Clusters
● Nebulae
● Planets

selects all objects from the same class, highlighting them in the Celestial
Object box. Marking or clearing any of them displays or hides all of them.

By default, the following objects and symbols are not shown. You must mark
their checkboxes to display them.

● Variable Star; Suspected Variable; Double Star
● Constellation Boundary
● Horizon Grid; Equatorial Grid; Galactic Equator
● Field of View Indicator Reference Point

This isn’t the Field of View Indicator itself, but the “marker” at the center of
the FOVI. The Field of View Indicator is displayed or hidden from the Field
of View Indicator dialog box.

● Telescope Limit

Constellation Boundaries, Galactic Equator, Horizon Grid, Equatorial Grid,
Local Horizon, and Telescope Limits can also be selected or deselected from
the Reference Lines dialog box.

Several object types have pushbuttons on the Objects toolbar—Stars, Double
Stars, Variable Stars, Galaxies, Clusters, and Nebulae. These hide or display
groups of objects with a single mouse click. When a button is “down,” the
objects are shown. When it’s “up,” the objects are hidden.

These buttons interact with the checkboxes in the Celestial Objects list box.
For example, when you hide the galaxies by clicking the Galaxies button (so
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that it’s “up”), the checkboxes for all galaxy types are cleared. On the other
hand, if the checkbox for at least one object type from a class is marked, the
button for that class is “down.”

All objects of a given type from all catalogs are displayable. How many are
actually shown varies with the limiting magnitude and the field of view.
These factors are described in the following sections.

Once you’ve selected objects and their limiting magnitudes, click OK to
select the new settings. Click Cancel to exit without changing the Virtual Sky.

Changes to the Filter settings last through the current session. To make the
changes permanent, save the current Sky Document.

Limiting the Magnitude of Displayed Objects

The Magnitude Limit settings provide additional filtering, displaying objects
only within a specified brightness range. Larger magnitude values represent
dimmer objects. The brightest objects have negative magnitudes.

Enter the limits in the Brightest and Faintest boxes. Fractional values are
okay. The default range is 30.0 to -6.0. If you enter values outside this range,
you’ll get a warning message and won’t be able to exit the dialog box.

How TheSky Displays the Principal Catalogs

In previous versions of TheSky, the Hubble Guide Star catalog (or its SAO
subset) was the principal catalog. In version 5, the Hipparcos and Tycho
catalogs replace the GSC as the principal data. The 1.2 million stars in the
Hipparcos-Tycho catalogs include every star down to about 12th magnitude.
The corresponding GSC and SAO stars are therefore not displayed (though
they’re cross-referenced in the Object Information dialog box). GSC/SAO
objects are displayed only when there is no corresponding Hipparcos-Tycho
object, or when the display density is increased at narrower fields of view, or
when Medium or High Density mode is selected.

It’s impossible to display all the 1.2 million objects in the Hipparcos and
Tycho catalogs, even at wide viewing angles. Even a 1200x900 display
doesn’t have enough pixels to distinguish 1.2 million distinct objects. (Every
pixel would be illuminated—a computer version of Olbers’ Paradox, in
reverse.) TheSky therefore limits the number of objects plotted, to avoid
cluttering the display. Only the brightest objects of each type from the
Hipparcos and Tycho catalogs are shown at field widths greater than 50°.

This limiting is easy to see in the Virgo Cluster. Center the display at 12h
30m right ascension and 8d 30m declination. Start with the field width at
60°, then reduce it to 50°. You’ll see a big increase in the number of galaxies.

You expect to see more objects at narrower fields of view, so additional
high-magnitude objects are displayed below 50°. Another transition point
occurs at 20°—many objects from the GSC catalog are added.
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High / Medium / Low Density Display Modes

The Virtual Sky defaults to Low Density display mode. Although additional
objects are displayed below 50°, and more are added below 20°, even more
objects can be shown by selecting Medium or High Density. In High Density
mode as many objects as possible are plotted, regardless of the angle of view,
subject only to the restriction of not illegibly cluttering the screen.

To change the density, choose the Stellar Options command from the View
menu. Select the Options tab, then click the appropriate radio button (Low,
Medium, High) in the Density section. You can also select High Density
directly, by clicking the High Density button in the View toolbar.

At 4° and below, every object from every catalog is shown, whether or not
High Density is selected. Although the Density buttons are not dimmed,
you cannot switch to Low or Medium density.

You’ll probably leave High Density turned off until you specifically need it.
It slows down screen updates, and the Virtual Sky automatically switches to
High Density at narrow fields of view (where you need it), anyway.

Faded Stars

If you didn’t copy all the catalogs to the hard disk, TheSky prompts you to
insert the CD ROM when it runs. If you don’t load the CD ROM, TheSky stops
searching those catalogs during the current session.

Catalog Contents

The following are brief descriptions of the catalogs supplied with Version 5.

Hipparcos and Tycho Catalogs

These catalogs were assembled to support the Hipparcos and Tycho
missions. They contain fewer stars (about 1.2 million total) than the GSC,
but these include almost all the stars amateur astronomers are interested in.
The Hipparcos-Tycho coordinates are significantly more accurate than those
in the GSC (though you're unlikely to see any difference in their plotted
positions, expect perhaps at very narrow fields of view). The Hipparcos-
Tycho catalogs contain data that isn't in the GSC, including proper motion,
parallax, position errors and spectral class.

Hubble Guide Star Catalog (GSC)

The Hubble Guide Star Catalog was assembled to support the Hubble Space
Telescope’s need for off-axis guide stars. The GSC contains nearly 19 million
objects brighter than magnitude 15, of which more than 15 million are
classified as stars.

Non-Stellar Guide Star Catalog (NSGSC)

The NSGSC is the non-stellar portion of the GSC.
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Smithsonian Astrophysical Observatory (SAO)

The Smithsonian Astrophysical Observatory catalog is a subset of the GSC.
Because the GSC is now included with every Level of TheSky, the SAO is no
longer supplied. It is still cross-referenced, though, and you’ll see SAO
entries in the Object Information dialog box.

New General Catalog (NGC)

The New General Catalog contains information on 7840 objects, including
galaxies, nebulae, and clusters. Most of the NGC objects classified as galaxies
also appear in the Principal Galaxy Catalog, causing some overlap.

Index Catalog (IC)

The Index Catalog includes the same types of objects that are in the NGC,
and contains 5386 additional objects. Many IC objects overlap galaxies in the
Principal Galaxy Catalog.

Principal Galaxy Catalog (PGC)

The Principal Galaxy Catalog is one of the most-comprehensive catalogs of
galaxies. It contains detailed information on over 73,000 galaxies.

The PGC also contains numerous cross-references to other galactic catalogs.
The Find command can be used to access over 130,000 cross references to
popular catalog designations, including the following:

● Arakelian Catalog of Galaxies (ARAK)
● Catalog of Galaxies and Clusters of Galaxies (CGCG)
● David Dunlop Observatory Catalog of Galaxies (DDO)
● Fairall Catalog of Galaxies (FAIR)
● Karachentseva Catalog of Galaxies (KARA)
● Kazaryan UV Galaxies (KAZ)
● Kiso UV Galaxies (KUG)
● Morphological Catalog of Galaxies (MCG)
● Suspected Variables (NSV)
● Second Byurakay Survey (SBS)
● Tololo Galaxies (TOL)
● University of Michigan Catalog of Galaxies (UM)
● Uppsala General Catalog of Galaxies (UGC)
● Virgo Cluster Catalog of Galaxies (VCC)
● Weinberger Catalog of Galaxies (WEIN)

Planetary Nebulae (PK)

This catalog of 1455 planetary nebulae is derived from the Strasbourg
Catalog of Galactic and Planetary Nebulae.

Displaying Celestial Objects 37



General Catalog of Variable Stars (GCVS)

About 28,000 variable stars are included from the General Catalog of
Variable Stars. Variable stars are represented by a small red V below
and to the left of the star. Suspected variables include a question mark (?).

Suspected Variables (NSV)

This catalog contains about 14,000 stars which are believed to be variable.

Washington Catalog of Double Stars (WDS)

TheSky includes about 12,000 of the brightest doubles from the Washington
catalog of visual-double stars. There are no index numbers for this catalog,
so it cannot be searched from the Find dialog box.

The stars in the WDS are displayed with the yellow star/blue star symbol.
To see these symbols, the Virtual Sky must be set to a field width of 50° or
less, and the Double Star checkbox in the Filters dialog box must be marked
(or the Double Stars button in the Objects toolbar must be “down”).

At field widths below about 0.5°, double stars often have enough separation
to be plotted as separate white dots at their GSC coordinates. In these cases,
TheSky draws a line drawn between the WDS coordinates of the two stars,
rather than drawing the yellow/blue double-star symbol.

The WDS coordinates usually do not match the coordinates from the GSC or
SAO catalogs (mostly because their coordinates are given only to the nearest
arc-minute), so the stars and their connecting line might be in different
positions! A good example of this is the double SAO22384 and SAO22385.

United States Naval Observatory (USNO) (Level IV—support only)

Level IV supports this database (but does not include the database itself).
The A1.0 edition of the USNO contains 488 million stars on 10 CD ROMs,
complete to about 21st magnitude. The SA1.0 edition covers 55 million stars
on a single CD. TheSky can display these data at a field of view of 1° or less.

The USNO data are broken into zones. You can specify a separate location
for each zone, so that the data can be split among multiple hard disks and/or
CD ROM drives. Use the USNO Databases sheet in the File Locations dialog
box to specify the drive and folder where each zone is located.

To display the USNO catalog, zoom to a field width of 1° or less. Open the
File Locations dialog box and select the USNO Databases tab. Mark the
“Plot USNOA-1.0” checkbox.

Disclaimer

Software Bisque has no way to verify the accuracy of catalog data. We are
not allowed to modify most of the catalogs supplied with TheSky. We want
to be informed of errors, but we aren’t permitted to correct inaccurate data.
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5 Finding and Identifying Celestial Objects

Identifying Objects

The Virtual Sky is linked to TheSky’s databases. Clicking on an object
(or locating it with the Find command) displays a wealth of information…
● the object’s common name and/or its catalog designation
● cross references to other catalogs
● the object’s type (variable star, irregular galaxy, and so on)
● the constellation in which the object lies
● the object’s magnitude
● a star’s Bayer (Greek-letter) brightness designation
● the Dreyer description of the object, in plain English
● the object’s distance from Earth, in light years and AU (where known)
● catalog-specific information (such as min/max magnitude of variable

stars, spectral class, parallax, proper motion, position error, distance
from the Solar System)

● the object’s equatorial (RA-Dec) coordinates, for both the date specified
in the Site Information dialog box and Epoch 2000.0

● the object’s horizon (Alt-Az) coordinates at the time displayed in the
Status Bar when the object was clicked on (or found using Find)

● the object’s rise time, transit time and set time for the site location
● the object’s angular dimensions
● the angular separation from the last object identified
● the object’s position angle (the angle between the line connecting the

object and the last-identified object, and the line connecting the last-
identified object and the North or South Celestial Pole)

Clicking on any object displays the Object Information dialog box. The
object is surrounded by a “bull’s eye” of three concentric circles.



The object you clicked on, and up to nine “nearby” objects, are listed in the
Object list box. This eliminates any need to click exactly on the object, and
makes it easy to study groups of objects without having to click on each one.

The Object list box also includes a Cursor Position entry that shows exactly
where you clicked. If you click in an area without any nearby objects, Cursor
Position is the only entry.

To view information about any item in the Object list box, click on it. The
bull’s eye moves to the item’s coordinates.

The Less Information/More Information buttons control the amount of
information displayed. The default is More. Clicking Less Information
removes the tabbed sheets and object type/coordinate summary.

The Object Information dialog box is non-modal. You don’t have to close it
to do other things, such as scrolling the display or selecting commands.

Identifying Galaxies, Nebulae, and Open Clusters

At wide fields of view, galaxies, nebulae, and open clusters are displayed as
their standard symbols. At higher magnifications, the symbols are replaced
with circles or ellipses that represent the shape and dimensions of the object.
Within these extended objects, there is no marked point on which to click.

If the object is displayed as a circle, you can click anywhere within the circle.
For objects displayed as ellipses, click within the circular region defined by
the ellipse’s minor axis, as shown in the drawing below.

The Andromeda galaxy (M31) is a good example of this sort of object.
You need to click on a point towards the center of M31—without too many
nearby stars—to identify it. Stars and other objects within the central regions
can be identified by clicking on or near them.

Limitations on Identifiable Objects

As many as 100,000 objects are displayable in densely populated areas of the
sky. Only the brightest 10,000 on-screen objects can be identified. If you click on a
faint star and there is no information for it in the Object Information dialog
box, reduce the field width and/or turn off High Density. Then click again.

The ellipse defines
the galaxy’s extent.

Click within the circle
to identify the galaxy.
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Using the Information Buttons

The second group of five buttons at the bottom of the dialog box represents
distance, rise/transit/set times, spectral class, angular separation from the
last object located, and orbital information (for Solar System objects) when
the Object Information dialog box is in More Information mode.

If the Object Information dialog box is in Less Information mode, the Orbital
Information and Distance buttons are replaced with Azimuth/Altitude and
Right Ascension/Declination buttons.

Click any button to highlight the corresponding data. If a button is dimmed,
its data are not available for (or applicable to) the selected object.

Copying Information

To copy all the information in the Object Information dialog box to the
Clipboard, click the Copy button at the bottom of the dialog box. To copy
part of the data, drag across the parts you want. Then press CONTROL+C
(zC on the Macintosh). Don’t use the Standard toolbar’s Copy button.

Centering an Object

The Center Object button repositions the Virtual Sky with the identified
object at the center. Unlike the Find dialog box’s Find & Center control,
the field of view is not adjusted.

Adding Objects to the Observer’s Log

TheSky can create an observer’s log of the objects you’ve identified. This file is
called log.txt . It’s written into the user subfolder of TheSky’s folder.

To add an item to the log, select the item from the Object list, then click the
Log button. This opens the Observer Log dialog box, with the object data
displayed in an edit box. Selecting additional objects and clicking adds their
Observer’s Log data to this file. You can edit the data at any time.

Clicking OK saves the log under its default name (log.txt ). If you want to
save it under a different name, click Browse. Enter the name you want, then
click Save. Clicking Cancel discards any entries added to the log since you
last saved it.
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log.txt is never overwritten. New entries are appended to it, regardless of
when you last opened the file. It is also the default log file; you cannot make
another file the default. However, you can save it under a different name.

Using the Multimedia, Utility, and Telescope Sheets

The Object Information dialog box is initially displayed with the General
property sheet open. There are three other property sheets—Multimedia,
Utility, and Telescope.

The Multimedia sheet displays any image of the object in a currently loaded
database. If there’s more than one image for the object, the images are listed
in the right-hand box. Click on the name of the one you want to view.

If the object is a star, and the star has an assigned spectral class, the class is
shown. The approximate visual color of the star is marked on the “spectrum”
with two triangles.

The Utility sheet provides functions that you would otherwise have to call
from menus or dialog boxes.

● The Preferences and Filters buttons bring up the corresponding dialog
boxes. The selected object or its type is highlighted in their Object lists.

● Lock On keeps the selected Solar System object at the center of the Virtual
Sky or 3D Solar System view, even if you change the time or date.
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● Show Orbit switches to 3D Solar System mode (for Solar System objects).

● View From switches to 3D Solar System mode (for Solar System objects)
and shows Solar System motion as seen from the selected object.

● Deactivate disables the Sky Database containing this object, for the
remainder of the current session.

● Copy to Local copies the orbital elements of the selected Extended Minor
Planet to the local minor planet list.

● Time Skip Label adds a time/date “balloon” to the selected step (or the
full sequence) in a recorded Time Skip simulation.

The Telescope sheet provides only alignment controls, since the Slew button
is always available from the toolbar at the bottom of the dialog box. These
controls are not active until you establish a link with your telescope’s drive
system.

● Sync synchronizes the telescope to the selected object.

● Align On sets the selected star to be an alignment star when aligning
encoders.

● Set Park sets the telescope’s park position (ACL, Meade 16" LX-200,
Software Bisque Paramount GT-1100 only).

● Park moves the telescope to the park position (ACL, Meade 16" LX-200,
Software Bisque Paramount GT-1100 only).

Finding Objects

You don’t have to locate an object in the Virtual Sky to get information
about it. The Find command can locate every object in TheSky’s databases.

The Find command is in the Edit menu. You can also access it by pressing
F (zF on the Macintosh), or by clicking the “Sherlock Holmes” button in the
Objects toolbar. (That’s a magnifying glass, not a bubble. Sherlock Holmes
wasn’t “into” bubble pipes.)

Selecting the Find command displays the Find dialog box, which provides
several ways to locate objects.

Finding and Identifying Celestial Objects 43



Finding by Object Type

One way is by object type.

1 In the Common Names section, click one of the types in the left-hand box.

A list of all objects of that type appears in the right-hand box.

2 Scroll the right-hand list to find the object you want.

3 Highlight the object, then click the Find button.

Or double-click the object. The Object Identification dialog box is displayed.

If the object is within the current field of view, it is marked with a bull’s eye.
If the object is not within the field of view, the display is not repositioned.

To guarantee the object will be visible, click Center & Frame. The object is
centered, and the field width is adjusted to tightly frame it. If the object is a
planet, the field width is selected so the planet appears as a disk (rather than
the default symbol). If the object is a dimensionless point (such as a star), the
field width is set to 1°.

Finding by Name

Another way to find an object is to enter its name (Aldebaran, Bear Paw) in
the Find edit box. You can enter the names of comets, minor planets, and
auxiliary objects that appear in any active Sky Database. (See page 109.)

For example, to find the Great Nebula in Orion, type Great Nebula in

Orion and click Find. The Object Information dialog box opens with
information about the Great Nebula. If the Great Nebula is within the
current field of view, it’s marked with a bull’s eye.

You can also search for a star by entering its Bayer (Greek-letter) magnitude
designation, followed by the constellation’s three-letter abbreviation. (A list
of abbreviations is on page 187.) For example, to find the third-brightest
star in Orion, type Gamma Ori . Clicking Find locates that star, Bellatrix.

Find by Type Find by Name Find by Catalog

44 TheSky Astronomy Software



Multiple Finds

Because Find looks for any near match (not just an exact match), it often
locates more than one object. For example, entering “Polaris” finds Polaris,
Polarissima Australis, and Polarissima Borealis. These near-matches also
appear in the Object Information dialog box.

Find also locates matches with Common Name labels. For example,
searching for “Andromeda” not only finds the constellation, but references
to M31 (the Messier number of the Andromeda galaxy). Antares is found
too, since it starts with the same letters.

If You’re Not Sure of the Right Spelling…

Star names are Greek, Arabic, or Latin. You don’t have to know the correct
spelling. The Find command looks for the closest phonetic match.

For example, if you enter “Cassyop,” “Casopea,” or “Casiopeeyah,” Find
correctly locates Cassiopeia. The search requires the correct first letter,
however. Entering “Kassyop” will not locate Cassiopeia.

Finding by Catalog Designation

Yet another way to find an object is to enter its catalog designation. Leading
zeroes are not required; the search routine automatically adds them. Typing
just the catalog abbreviation (with no number) lists the first 10 items in the
catalog.

The Tycho catalog’s designers indexed it with the corresponding GSC
numbers. We have therefore not included it as a searchable catalog. The
WDS catalog does not contain index numbers, so it cannot be searched.

Catalog Number Format

GSC objects Enter GSCbbbb : oooo , where bbbb is the guide star
block number (1–9537) and oooo is the offset of the
object in the block.

SAO objects Enter SAOnnnn , where nnnn is the SAO catalog
number.

Hipparcos Enter HIPnnnnn , where nnnnn is the Hipparcos
catalog number.

Messier objects Enter Mnnn , where nnn is the Messier number of the
object.

NGC objects Enter NGCnnnn , where nnnn is the NGC catalog
number.
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PGC objects Enter PGCnnnn , where nnnn is the PGC catalog
number.

IC objects Enter IC nnnn , where nnnn is the IC catalog number.

PK
planetary nebulae

Enter PK plus the desired number. For example,
PK 118 +2.1 .

GCVS
variable stars

Enter the star designator, followed by the constellation
abbreviation. For example, to find GCVS RR
Andromeda, enter GCVS RR AND.

NSV suspected
variable stars

Enter NSVnnnnn , where nnnnn is the NSV catalog
number.

Hubble Image Enter Hubble Image nnn , where nnn is the index
number. You can also enter the image’s name or the
press-release number.

Searching Other Catalogs

Other catalog designations can be used to find objects. The table below lists
the available catalogs and their prefixes, along with the number of galaxies
in the catalog (Count) and an example of the correct format. Catalog
numbers requiring leading zeroes are noted in the Comments.

In some cases, the name of the catalog is not known. These entries are
marked with a dash (—).

Catalog Prefix Count Example Comments

— 1SZ 26 1SZ 39 Numbering is not
contiguous.

— 2SZ 32 2SZ 4

Zwicky1 1ZW 238 1ZW 1

Zwicky2 2ZW 199 2ZW 1

Zwicky3 3ZW 158 3ZW 1

Zwicky4 4ZW 203 4ZW 1

Zwicky5 5ZW 531 5ZW 1

Zwicky6 6ZW 238 6ZW 1

Zwicky7 7ZW 1145 7ZW 1

Zwicky8 8ZW 645 8ZW 1

Arakelian Catalog of Galaxies ARAK 595 ARAK 38

— ARP 560 ARP 70

Catalog of Galaxies and
Clusters of Galaxies CGCG 29809 CGCG 502- 64

David Dunlop Observatory
Catalog of Galaxies DDO 242 DDO 11
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Catalog Prefix Count Example Comments

— ESO 16239 ESO 152-5

Fairall Catalog of Galaxies FAIR 1185 FAIR 700

Index Catalog IC 3815 IC 434

Infrared Astronomical Survey IRAS 9347 IRAS 01293-2548 5-digit prefix must be
padded with zeros.

Karachentseva Catalog
of Galaxies KARA 183 KARA 4

Kazaryan UV Galaxies KAZ 581 KAZ 9

Kiso UV Galaxies KUG 5455 KUG 0001+311 4-digit prefix must be
padded with zeros.

— LGS 5 LGS 4

Second Byurakay Survey SBS 259 SBS 1209+550

Tololo Galaxies TOL 111 TOL 29

Uppsala General Catalog
of Galaxies UGC 13073 UGC 8100

University of Michigan
Catalog of Galaxies UM 652 UM 533

— VV 1161 VV 222

Virgo Cluster Catalog
of Galaxies VCC 2097 VCC 3

Weinberger Catalog
of Galaxies WEIN 207 WEIN 1

Entering Catalog Numbers with the Mouse

Because it can be difficult to read the keyboard on a dark night, TheSky
includes a method for entering catalog numbers with the mouse.

In the Databases section of the Find dialog box, there’s a list box with the
names of the resident catalogs (their abbreviations, actually).

● GCVS, GSC, HIP,IC , NGC, NSV, PGC, PLN, SAO

The Identifiers of user-created Sky Databases (SDBs) with search indexes
(“searchable” databases) are also listed. Clicking on any of these enters the
SDB Identifier into the Find edit box.

Numbers (and the decimal point) are entered by clicking the “keypad” to the
right. Clicking Space enters a space. Clicking Back deletes the last (rightmost)
character in the edit box, regardless of the current location of the text cursor.
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Occulted Objects

The Sun, Moon, and planets often occult deep-sky objects. To keep the occulted
objects visible, select the Options command from the Data menu and mark the
“Translucent sun and moon” checkbox.

Non-stellar objects (galaxies, nebulae, and so on) can also cover stars “behind”
them. Select the Options command from the Data menu. Set “Non-stellar fill”
to Transparent. The outline of the object remains, but it is no longer filled, and
the stars (or other objects) become visible.

The Milky Way and the Magellanic Clouds

The Milky Way (our galaxy) is displayed as a complex polygon covering a
significant percentage of the Virtual Sky. Keeping track of its boundaries
would consume too many resources. It was therefore decided not to identify
the Milky Way when you click inside it.

At narrow fields of view, the Milky Way’s boundaries are not usually visible
and the polygon forms a solid background color. This is potentially confusing
(”Is that the Milky Way or a nebula?”), so the Milky Way is not displayed at
fields of view below 5°.
The Magellanic Clouds (the two smaller galaxies “attending” our galaxy) are
large, complex objects. It was decided to treat them differently from other
deep-space objects. Neither Magellanic Cloud is indexed by name.

The Small Magellanic Cloud has its own polygon object and is easy to spot in
the Virtual Sky—it’s located at a right ascension of about 1h, not far from the
South celestial pole. To locate it with the Find command, enter one of the
SMC’s catalog numbers (such as NGC 292). The angle of view needs to be
about 7° for all of the SMC to be displayed.
The Large Magellanic Cloud is not shown as a specific object. To display the
region in which it’s located, search for NGC 1965 (the LMC’s catalog number),
or the name or catalog number of one of its components (the Tarantula Nebula,
for example). At field widths of 20° or less, the LMC appears as a group of
about 30 star clusters and nebulae.
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6 Display Modes and Options

Full Screen (View menu)

The Full Screen command maximizes the Virtual Sky, and hides the title bar,
the rest of the window frame, the Status Bar and the toolbars. (You can also
click the Full Screen button on the View toolbar, or press SPACE.) The menus
are hidden under Windows (but not on the Macintosh).

The Full Screen button remains, floating in a toolbar at the upper left.
To remove this toolbar, click the X button (or the close box on the Macintosh).

If you want the toolbars to remain, mark the “Show in Full Screen Mode”
checkbox in the Toolbars dialog box. In Windows, to access the menus in
Full Screen, press ALT, then the accelerator key for the desired menu. Press
RIGHT or LEFT to move to a different menu.

To return to the regular display, click the floating Full Screen button. Or
select the Full screen command from the View menu. (In Windows, press
ALT, V to display the View menu.) Or press SPACE a second time. (Whew!)

Chart Mode (View menu)

Chart mode reformats the display to look more like what you would see in a
book of star charts (such as Wil Tirion’s Sky Atlas 2000.0™), or how a printed
sky chart from TheSky is going to look.

● The sky is white, not black.
● The Sun, Moon, and planets are marked with their astrological signs.
● Stars are black circles.
● Nebulae have irregular black outlines.
● The Milky Way is gray.

Chart Mode uses the same symbol set TheSky uses for printing. You can
change the colors of these symbols—and substitute new symbols, in many
cases—in the Preferences dialog box.



Projections (View menu)

The Projections dialog box selects the projection used by the Virtual Sky.
Six projections are available. They are described starting on page 20.

All projections are available at field widths greater than 50°. At field widths
of 50° or less, orthographic is the only projection available. It is used with
the Image Link function (page 137) to match the projection of photographic
and CCD images, which are inherently orthographic.

Mirror Image / Inverting the Display (View menu)

Mirror Image reverses the Virtual Sky, left-to-right. This shows the sky as
you would see it through a telescope with an erect but laterally reversed
image. The Virtual Sky now scrolls in the opposite direction when you press
the LEFT and RIGHT arrow keys.

There is no specific command to invert the display. However, the Rotate
Tool can be used to turn it upside-down (which also flips it left-for-right).

Stellar Options (View menu)

The Stellar Options dialog box can be selected from the View menu, or by
clicking the Brightness & Contrast button in the View toolbar. It has two
tabbed sheets. The Brightness & Contrast sheet controls the size and size
distribution of the Virtual Sky’s stars. The Options sheet controls other
aspects of the stars’ appearance.

Brightness & Contrast

Star brightness is shown by size—brighter stars are larger. This is the way
stars look on photographic plates—brighter stars produce larger images.

But a computer monitor—unlike a photograph—can display only a finite
number of star sizes. Each size has to represent a range of magnitudes.
For example, the largest star image might represent magnitudes of 1.0 and
brighter, the second-largest image magnitudes of 1.0 to 2.0, and so on.
The Brightness & Contrast settings control the way star magnitudes are
mapped into the size of star images.
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Brightness controls which star size each magnitude is mapped into.

● Increasing the Brightness setting moves each star (except the brightest)
into the next-higher star size. All but the brightest stars get larger.

● Decreasing the Brightness setting moves each star (except the dimmest)
into the next-lower star size. All but the dimmest stars get smaller.

Very high or very low Brightness settings reduce the range of star sizes.
The stars vary less in size, and look more like what you see in the real sky.

Contrast sets the range of magnitudes mapped into each star size.

● A low Contrast setting maps a wide range of magnitudes into each
star size, producing little variation in star size. You might find this
looks more like the “real” sky and less like a photograph.

● A high Contrast setting maps a narrow range of magnitudes into
each star size. This produces a wide variation in star size.

It’s easy to experiment with these settings. As you drag the sliders, the stars
in the sample box are immediately redrawn.

When you find settings you like, click Apply to preview the display without
exiting. Click OK to close the dialog box and keep the new settings. Click
Cancel to discard the changes, even if you previewed them with Apply.

Brightness and contrast changes last through the current session. To make
the changes permanent, save the current Sky Document.

Using the Settings Effectively

There are 41 settings each (-20 through +20) for brightness and contrast.
(The numerical value of a setting is for reference only; it has no mathematical
relation to its brightness or contrast mapping.) The settings for the display
and charts can also be modified separately; click the appropriate radio
button to switch between the Virtual Sky and Sky Charts settings.

The settings are keyed to the field of view— 1°, 2°, 5°, 10°, 20°, 50°, 100° and
200°. You can specify a different set of brightness and contrast settings for each
angle. This allows stars to get larger as the field of view gets narrower, so
that high-magnitude stars can easily be seen.
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The bar graphs in the Brightness and Contrast windows show the settings
for each field of view, starting with 1° on the left. Positive values are bars
above the line; negative values are bars below the line.

Moving the Field of View slider selects the angle for the brightness and
contrast settings to be altered. As you change the Brightness and Contrast
settings, you'll see the bar for that angle move up or down.

As you increase the Brightness setting for (say) 20°, you’ll notice that the
Brightness settings for narrower angles also increase. The reason for this has
to do with the way you expect the stars to be displayed as you “zoom in.”

As the field of view narrows, you expect stars of a given magnitude to stay
the same size, or get larger. It would look rather odd if the stars got smaller!
TheSky therefore automatically increases the Brightness values of the fields of
view narrower than the one you are adjusting. (The Brightness values of
wider fields are also adjusted to prevent abrupt jumps in star size.) If you
want to override these automatic adjustments, start at 1° and work upward,
selecting the Brightness setting you want for each angle—as long as it’s no
larger than the setting for the preceding angle.

Options

The Options sheet controls stellar options other than brightness and contrast.

Catalogs

The Hipparcos-Tycho or Guide Star catalogs can be turned off at fields of
view below 50° by clearing the corresponding checkbox.

Density

The default Density setting is Low. Selecting Medium or High forces TheSky
to show “more” (and “even more”) objects at all angles of view greater than
4°. At angles of 4° and less, the Virtual Sky automatically switches to High
Density; you cannot switch to Low or Medium. (See page 36 for more
information about display density.)

Proper Motion

The Hipparcos-Tycho catalogs contain information about the proper motion
of stars—their absolute motion in the sky, independent of precession. Most
objects with a non-zero proper motion are stars within a few hundred light
years whose movement has a significant component at right angles to the
line connecting them with our Solar System.

When the Compute checkbox is marked, proper motion is computed and
applied to the Virtual Sky. The stars appear at their correct positions
(including precession) for the current date.

Entering a non-zero time interval between -10,000 and 10,000 years in the
Vector Length box computes the proper motion for that interval and
displays it as a red line pointing from the star in the appropriate direction.
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To determine the angular displacement of a star’s proper motion, click on
the star, then click on the end of the displacement vector. The Angular
Separation value in the Object Information dialog box is the magnitude of
the proper motion.

Non-Stellar GSCs

The Guide Star Catalog contains about 4 million “non-stellar” objects. They
were classified as non-stellar because their photographic images were larger
than those of most known stars. In reality, many are stars. Therefore, TheSky
lets you plot non-stellar GSC objects as stars or the non-stellar object symbol.

The default setting is Stars. Selecting Symbols displays these objects with the
Nonstellar GSC symbol. Since these objects have not been fully classified,
the GSC does not contain any information about their size or orientation.

The Stars option has a side effect when you print star charts at small field
widths. Many galaxies in the non-stellar catalogs are also in the GSC. This
means that most galaxies are plotted twice—once as a galaxy and once as a
star. The star appears as a dot at the center of the galaxy. If you don’t want
this, select the “Non-stellar symbols” option.

The figures below show what happens when non-stellar GSC objects are
plotted as stars and as non-stellar symbols.

Spectral

When the “Show spectral colors” checkbox is marked, the stars are redrawn
in hues approximating the true colors of their spectral class. The intensity of
the colors is controlled by the “Color saturation” slider. (Dragging the slider
automatically marks the “Show spectral colors” checkbox, if it isn’t already
marked.)

A table on page 186 lists the approximate color temperature of each class, in
degrees Kelvin.

Red in Night Vision (Windows)

When Night Vision mode is selected, the stars normally remain white (or
keep their spectral colors). Marking this checkbox turns the stars red in
Night Vision mode. All non-stellar objects keep their original colors.

Plot as Non-Stellar SymbolsPlot as Stars
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Night Vision (View menu)

Selecting Night Vision from the View menu (or clicking the Night Vision
button) redraws the display in red, to minimize loss of dark adaptation.

Windows

Only the title bar, toolbars, and Status Bar turn red. To make the stars red,
mark the “Red in night vision mode” checkbox on the Options sheet of the
Stellar Options dialog box. All non-stellar objects keep their original colors.

Switching to and from Night Vision changes Windows’ default system
colors. This can cause "odd” behavior, such as getting a “Preparing Microsoft
Office Toolbar” message. This is normal for Windows, and not a program bug.

Macintosh

A separate dialog box controls Night Vision. The controls are enabled by
marking the “Night vision enabled” checkbox. The Brightness slider sets the
overall brightness of the display. The Redness slider adjusts the degree to
which the display turns red.

Night Vision dims all the monitors connected to your computer, and any
other applications that are running. Settings are retained between sessions.

Halt Update ( ESC)

TheSky fully recomputes the Virtual Sky before redrawing it. Press ESC
(z. (period) on the Macintosh) at any time to halt the calculations. Only
those objects for which TheSky has computed positions are displayed, and
program control is returned to you.

“Why would I want to use this feature?” Well, you might not like a change
you made, and don’t want to wait for the screen to be fully redrawn. You can
also use it to speed up a sequence of display changes. You don’t have to wait
for one change to be completed before selecting the next.

Redraw Screen (View menu)

The Redraw Screen command can be used at any time to force TheSky to
update the screen. It’s useful if you accidentally interrupt an update, or if
(for some reason) TheSky does not completely redraw the display. Under
Windows you can also press F5 (and on the Macintosh, F5 or SHIFT+R).
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Update Solar System (Tools menu)

If the “Use computer’s clock” checkbox on the Date and Time sheet is
marked, TheSky periodically updates the positions of the objects in the
Virtual Sky. The interval between updates is controlled by the Screen
Update Frequency setting in the Options dialog box (page 56). (If the “Use
computer’s clock” checkbox on the Date and Time sheet is clear, the interval
settings are dimmed, because the display never updates.)

The default frequency is every 15 minutes, for both deep-space and Solar
System objects. There are several ways to force TheSky to recompute the
planets’ positions without waiting for an automatic update.

● Select the Update Solar System command from the Tools menu.
● Change the date or time. (Just click Apply on the Date and Time sheet.

You don’t have to actually change the settings.)
● Change the Location.
● Add comets or minor planets.

Options (Tools menu)

The Options dialog box controls the appearance and behavior of several
non-stellar objects.

Extended Minor Planets

When extended minor planets are loaded, their positions in the Virtual Sky
are plotted once. They are not updated. Since you might forget this, and think
their positions remain up-to-date, you can set a time limit, after which the
extended minor planets are removed from the Virtual Sky.

The default is three hours. You can set any interval of 0 to 1000 hours.
Fractional values are okay.

The actual deletion does not occur until Solar System objects are updated
following the interval you selected. If you clear the “Use computer’s clock”
checkbox on the Date and Time sheet before loading extended minor planets,
the Virtual Sky doesn’t update and the minor planets won’t be deleted.

You can also delete all the extended minor planets at any time. See page 77.
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High Accuracy Minor Planet Computations

This checkbox sets the accuracy of minor-planet computations. When clear
(the default), their positions are calculated to ±60 arc-seconds. When marked,
the accuracy is ±1 arc-seconds. The lower-accuracy plot takes substantially
less time, especially when a large number of minor planets is displayed.

This setting applies only to local minor planets. Extended minor planets are
always plotted at ±60 arc-seconds accuracy. But—if you click on an extended
minor planet to identify it, its coordinates are reported to ±1 arc-second in the
Object Information dialog box. This accuracy is obtained by numerically
integrating the orbital elements to update them for the current time.

Translucent Sun and Moon

When this checkbox is marked, objects behind the Sun, Moon, and planets
become visible. You can identify them by clicking on them. (You can also
identify them when hidden, but you have no way of seeing where to click.)

Show Overlapping NGC and PGC Galaxies

The IC and NGC catalogs are subsets of the PGC catalog. If this checkbox is
clear, only one image is plotted for each object, using the PGC coordinates.

If you want to compare the data from both the PGC and the NGC or IC
catalogs, mark the “Show overlapping NGC and PGC galaxies” checkbox.

Screen Update Frequency

When the “Use computer’s clock” checkbox on the Date and Time sheet is
marked, the position of both Solar System and deep-sky objects is updated
automatically every 15 minutes.

The update interval can be changed. The Screen Update Frequency section
has separate settings for the Stellar (deep-space) and Solar System update
intervals. You can select 30 seconds, 1, 5, 15, or 30 minutes, 1 hour, or Never
for either, plus 0.25, 0.5, 1, 5, 10, or 15 seconds for Stellar. Never fixes the
display at its last update, even if “Use computer’s clock” is marked.

When “Use computer’s clock” is clear, the display does not automatically
change. The interval settings are therefore dimmed and have no effect.

Non-Stellar Fill

This setting controls the way galaxies and most nebulae are drawn.

● Color Both the object’s Line and Fill color are drawn.

● Transparent Only the object’s Line color is drawn. The object is not filled.
This setting produces a slightly less-cluttered display. It allows objects
that would otherwise be hidden to be visible.

● Transparent when Image is Present When an Image Link image overlays
the object, and Image Link Display is set to Opaque, the Fill is not drawn,
so it doesn’t hide the image. Removing the image restores the Fill color.
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Precessing Equatorial Coordinates

Because the Earth wobbles on its axis (“precesses”), the celestial coordinates
(RA-Dec coordinates) of all sky objects change slowly with time. The
coordinates in most of TheSky’s databases are for Epoch 2000.0—the position
of objects at 12:00 hours UTC on January 1, 2000.

The exact position of objects is significant when predicting eclipses and
conjunctions, and when using TheSky’s telescope-control software to locate
dim objects. The database coordinates are therefore recomputed for the time
and date shown in the Date and Time dialog box. (These—and the Epoch
2000.0 coordinates—are shown in the Object Information box.)

In earlier versions of TheSky, you could choose whether precession correction
was enabled. With the introduction of Version 4, precession correction was
applied at all times, for maximum plotting and slewing accuracy. The
approximate precession correction (∆) is given by the following equations.
RA is in seconds of time per year. Dec is in arc-seconds per year.

∆RA = 3.074 + 1.366 sin α tan γ

∆Dec = 20.041 cos α

Although a full cycle takes about 25,000 years, even a few decades can
introduce significant shift. Try placing Polaris at the center of the display,
with the Equatorial Grid displayed and a field of view of 10°. Then change
the date by 50 years. You might be surprised at how much Polaris moves.

Computer Time (Tools menu)

The Computer Time command opens a window with a continuously
updated display of your computer clock’s time, plus the date and local
sidereal time. This command is dimmed if the “Use computer’s clock”
checkbox on the Date and Time sheet is clear.

Toolbars

TheSky has seven toolbars. They’re docked against the top of the Virtual Sky,
but you can reposition them. Click anywhere within the toolbar itself (not on
a button) and drag the toolbar to its new position.

Once a toolbar is dragged free of a border, it floats as an independent
window, with its name in the title bar. You can even drag the toolbar
outside the Virtual Sky and onto the Windows or Macintosh desktop.
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You can’t resize a floating toolbar, but you can change its shape by dragging
its sides. The toolbar remembers its new shape when you move it between
docked and floating. (The Time Skip toolbar has a fixed shape, to keep the
control buttons in a straight line.)

A floating toolbar can be docked against any of the main window’s four
borders. Drag the toolbar towards the border as far as you can, until its outline
changes shape. Release the mouse button when the toolbar is where you
want it. Toolbars always dock against the horizontal borders with the
buttons arranged horizontally (and vertically against the vertical), regardless
of the shape they had when they were floating.

Adding and Removing Toolbars

The Toolbars command from the View menu displays the Toolbars dialog
box shown below. Mark the checkboxes of the toolbars you want to display,
clear the checkboxes of those you want to hide, then click OK. Toolbar
changes are automatically saved when you quit TheSky.

Another way to hide or display toolbars is to right-click (CONTROL+click on
the Macintosh) anywhere in the non-button area of a toolbar, or in the gray
space behind the toolbars. This displays the toolbars pop-up menu. The
Toolbars and Status Bar dialog boxes can also be accessed from this menu.

Another way to hide a floating toolbar is to click the X button (Windows)
or the close box (Macintosh).

Show in Full Screen Mode

Switching to Full Screen automatically hides the toolbars. If you want the
toolbars in Full Screen, mark the “Show in Full Screen Mode” checkbox.

Toolbar Idiosyncrasies (Windows)

Power management software, disk utilities, and other background programs
can cause the toolbars to behave incorrectly, because they never let the CPU
idle long enough for the toolbars to redraw and manage themselves.

Common symptoms include the inability to close toolbars, and having two
or more buttons on the same toolbar simultaneously pressed when they
shouldn’t be. Exiting the background program should fix these problems.

Some BIOSs have power-management functions. If these cause problems,
enter Setup as your machine boots and turn off power management.
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Tool Tips

When you hold the mouse pointer over a toolbar button, without clicking,
a pale-yellow caption appears below the button, describing its use.

These tool tips (sometimes called “balloon help”) are displayed by default.
If you don’t want to see them, clear the “Show ToolTips” checkbox in the
Toolbars dialog box.

Changes to tool-tip status are saved when you save the current Sky
Document.

Object Tips

When you hold the mouse pointer without clicking over an object in the
Virtual Sky, a pale-yellow caption appears below the object, with either its
common name or catalog number. If you don’t move the mouse, this object
tip disappears after about 30 seconds.

If the Virtual Sky symbol represents a multimedia object, the object tip
indicates the multimedia type—image, video, sound, or notes.

Object tips are displayed by default. If you don’t want to see them, clear the
“Show Object Tips” checkbox in the Toolbars dialog box.

Status Bar (View menu)

The Status Bar at the bottom of the screen displays useful information. The
Status Bar dialog box (in the View menu) controls what is displayed.

● screen position (equatorial or horizon coordinates)
● cursor position (equatorial or horizon coordinates)
● Earth location (the city and state/country selected from a .LOC file)
● local sidereal time (In Time Skip, shows the time of each “frame.”)
● field width
● telescope position
● date (of the current display)
● time (of the current display)
● angular dimensions of the zoom box (when a zoom box is drawn)

Display Modes and Options 59



Mark or clear the checkboxes to select or deselect items. You can choose
any combination. (The zoom box dimensions are automatically shown at
the left side when you draw a zoom box, so there is no checkbox for them.)
To hide the Status Bar, clear the “Visible” checkbox.

The greater the horizontal resolution of your display driver, the more items
can be shown. Once you reach the limit, the remaining items are dimmed.

Undo

TheSky keeps track of each change you make to the Virtual Sky’s orientation,
field of view, and center coordinates. If you have second thoughts about a
change, use the Undo command (from the Edit menu) to return to the
previous settings. Or press ALT+BACKSPACE or CONTROL+Z (zZ on the
Macintosh).

TheSky remembers the last 15 changes in the current session (including
changes that occur when the Virtual Sky is automatically updated). As long
as the Undo command is not dimmed, there is at least one more Virtual Sky
change that can be reversed.

The list of changes is discarded when you exit TheSky. If there’s a group of
settings you want to keep, use the Save As command to create a Sky
Document (.SKY file).

You can also undo changes that have not yet been saved in the current Sky
Document. Select the New command from the File menu (or press
CONTROL+N (zN on the Macintosh), or click the New button in the Standard
toolbar). You are prompted to save changes to the current Sky Document.
Click No to discard the changes. The last saved version will then be reloaded.

Other changes—such as turning on the Equatorial Grid, or switching to the
High Density display or Night Vision mode—are not tracked, and can’t be
reversed with the Undo command. They must be undone manually.
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7 Reference Lines

Adding Reference Lines to the Display

The Virtual Sky can include reference lines that display coordinates, help
you visualize your orientation, or indicate which part of the sky you’re
looking at. There are four principal sets of reference lines. Click the
corresponding button in the View toolbar to hide or display them.

● Equatorial Grid

The equatorial grid marks the celestial sphere, in coordinates of
right ascension and declination.

● Horizon Grid

The horizon grid shows azimuth and altitude coordinates with
respect to the local horizon.

● Constellation Figures

These lines connect the principal stars of each constellation, giving
a rough idea of its astrological or mythological shape. For example,
the lines in Leo suggest a reclining lion.

● Constellation Boundaries

These lines mark the borders of each constellation, which often extend
well beyond the familiar stars that make up the constellation. The 88
boundaries fully cover the sky; every object falls within a constellation.
The Constellation Boundaries include labels naming the constellations.
To see the labels, the orientation must be set to Pole Up, the field of view
must be less than 60°, and the Constellations checkbox on the Common
Names sheet of the Labels Setup dialog box must be marked.

You can also hide or display these lines from the Reference Lines dialog box.
It provides access to additional reference lines, plus enhanced control of the
Equatorial Grid. Each section of the dialog box is described below.



General Lines

The Constellation Figures and Constellation Boundaries checkboxes have
the same function as the corresponding buttons on the toolbar. Mark or clear
them to display or hide these lines.

There are also checkboxes for the Ecliptic, Milky Way and Galactic Equator.
These have no matching buttons on the toolbar.

● Ecliptic This circle shows the path of the Sun through the sky. Because the
Sun’s apparent motion is caused by the Earth’s rotation around the Sun,
the Ecliptic also marks the plane of the Earth’s orbit.

● Milky Way The Milky Way—our home galaxy—is displayed as a
dark-gray patch. At wide angles you can see its near-circular shape.

● Galactic Equator This circle marks the central plane of the Milky Way.
The North and South Galactic Poles are also marked.

Equatorial Lines

Mark or clear the Grid checkbox in the Equatorial Lines section to turn the
RA-Dec lines on or off.

There are three Equatorial Lines Spacing options. Auto/Wide and
Auto/Fine let TheSky control the lines’ spacing. Fine displays twice as many
lines as Wide. As the field of view changes, TheSky adjusts the number of
lines to provide useful resolution, without cluttering the display.

When User is selected, you can choose the spacing. Enter it as degrees and
fractions of degrees. (Don’t enter hours instead of degrees, and don’t use the
minutes/seconds format—DD.MMSS—by mistake.) There are separate
settings for right ascension and declination.

To avoid cluttering the display, the number of grid lines is limited. If the
User setting is so small that “too many” equatorial lines would be shown
at the current field of view, TheSky overrides the spacing you selected and
switches to the Auto/Wide setting.

N/E Indicator

Marking this box displays two lines that point North and East. Although
they are displayed for all orientations, they are meaningful only for horizon-
based orientations—Zenith Up, North, South, East, West, or Up.

Horizon-based Lines

Mark or clear the Grid checkbox in the Horizon Lines section to turn the
Alt-Az lines on and off.

The Meridian checkbox displays or hides the local meridian line—0°/180°
azimuth. The Meridian is (by default) a dashed line, so it’s easy to
distinguish from other lines.
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Local

Marking the Local checkbox displays a line that represents the local horizon.
The default local horizon is a straight, featureless line at 0°.

You can redefine the line so it represents the horizon at your viewing site.
Adding natural objects and buildings to the Virtual Sky gives a better idea
of what is and isn’t visible, and the times at which objects rise and set.

1 Select the Reference Lines command from the View menu.

The Reference Lines dialog box appears.

2 Click the Edit Local button.

The Horizon Line Editor dialog box appears.

3 Drag the mouse to change the line’s shape.

Hold down the right mouse button (press CONTROL on the Macintosh) as you drag
to draw a straight line, at any angle. You can start or end a straight line anywhere
within the editing area—the straight line and the existing curve are connected when
you release the mouse button.

4 Type a description in the Description edit box.

The description isn’t required, but it’s a convenient reminder.

5 Click Save to store the Horizon file under its default name.

The default Local Horizon file is normal.hrz . The default extension is .HRZ.
Under Windows, if you don’t supply an extension, .HRZ is automatically added.

6 Click Save As to create a new Horizon file.

The file can have any name and be stored in any folder.

The Copy and Paste buttons copy the current horizon line to the Clipboard,
or paste the horizon line on the Clipboard to the Horizon Editor. The horizon
line is represented as a 360-row by 1-column Excel spreadsheet. You can
paste the horizon line into an Excel™ page, modify it, then copy it and paste
it back into the Horizon Editor.

If you observe from more than one site you’ll probably want to create a
Horizon file for each. Use the Open command to load a different Horizon
file. TheSky remembers the last Horizon file you loaded, and automatically
reloads it the next time you run TheSky.
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The Horizon Lines section of the Reference Lines dialog box controls the
display of the Local Horizon. Mark or clear the Local checkbox to show or
hide the Local Horizon.

The Local Horizon Fill radio buttons of the Reference Lines dialog box
determine how the area “below” the Local Horizon is treated.

● If Transparent is selected, the full sky is drawn.

● If Opaque is selected, objects below the horizon line are masked with
the Horizon Line fill color. (This color is set by Horizon Lines Fill in
the Preferences dialog box.)

TheSky can help you draw the Horizon line. See “Limit Line and Horizon
Line Assistance,” below.

The Local Horizon line is a limit line. When limit lines are active (see
“Telescope Limit Lines,” below), you cannot slew a computer-controlled
telescope below the Local Horizon.

Refracted

Near the horizon, the atmosphere refracts (bends) the light so much that
objects below the “physical” horizon are visible. Marking the Refracted
checkbox displays a circle that outlines the “refracted” horizon.

The refracted horizon is the same color as other horizon coordinate lines.
It’s not marked in any special way.

Telescope Limit Lines

Few telescopes have an unrestricted range of movement. Their construction,
or the use of a particular eyepiece or accessory, limits how far they can move
in particular directions. You don’t want to accidentally “bang into” one of
these limits.

To reduce the chance of this happening, TheSky lets you define limit curves.
When a limit curve is active, TheSky will not slew the telescope to any point
or object within the region bounded by the curve. If you’re slewing to an
object outside this region, but the slew requires the telescope to cross the
boundary, TheSky attempts to stop the slew when it reaches the boundary.

Creating a limit line is relatively simple. Set up the telescope as you would
normally use it. Use its setting circles (or electronic readout) to determine
which parts of the sky it can’t be pointed to. (TheSky has a “digital setting
circles” feature that can help. See page 180.) Then transfer the coordinates
to the limit line, as explained below.

You can define limit curves in equatorial or horizon coordinates. It makes
sense to use coordinates that match your telescope’s mounting (equatorial
or alt-az), since these relate directly to the mount’s movements.
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There are two default limit-line files, declimit.hrz and altlimit.hrz .
The following description assumes you’re modifying the default files (but
you can create additional files with different names).

To create a custom limit line:

1 Select the Reference Lines command from the View menu.

The Reference Lines dialog box appears.

2 Click Edit Dec Limit or Edit Alt Limit.

Choose Edit Dec Limit for equatorial telescopes.
Choose Edit Alt Limit for telescopes with alt-az mounting.

The Horizon Editor dialog box—the same dialog box used to create the Local
Horizon line—is displayed (page 55). A default limit line has already been drawn.

3 Drag the mouse to change the line’s shape.

Hold down the right mouse button (press CONTROL on the Macintosh) as you drag
to draw a straight line, at any angle. You can start or end a straight line anywhere
within the editing area—the straight line and any existing curve are connected when
you release the mouse button

4 Type a description in the Description edit box.

You might want to indicate the telescope model, or which accessories this limit
setting is for. The Description is optional.

5 Click Save to store the Limit file under its default name.

The default files are declimit.hrz and altlimit.hrz . By default, Limit files have
the extension .HRZ and are stored in TheSky’s user subfolder. If you don’t supply
an extension, .HRZ is automatically added.

Click Save As to create a new Limit file.

The file can have any name and be stored in any folder. If you use the default
extension and folder, you won’t have any trouble finding it.

If you have accessories that further limit the movement of your telescope,
you’ll want to mount them and create additional limit-line files.

Once you’ve created a limit line, you might want to connect the telescope to
your computer and move it—cautiously!—to see if you supplied the correct
coordinates. If there’s any doubt, be conservative. If the limit line is too
“tight,” TheSky might not be able to stop a slew in time.

To load a limit line file, open the Reference Lines dialog box and click either
Edit Dec Limit or Edit Alt Limit. Then click Open. In the Open dialog box,
select the file and click Open.

To display the Limit Line, mark the Visible checkbox in the Telescope Limits
section of the Reference Lines dialog box.

Limit Line and Horizon Line Assistance

TheSky can help you draw limit lines or local horizon lines. After establishing
a link with your telescope (see Chapter 20, “Linking Your Telescope with
TheSky”), you can position the telescope at its limits (or near the horizon)
and let TheSky add points to the curve for you.
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1 Create a rough approximation of the desired horizon or limit line.

You don’t even need a rough line—TheSky can draw the complete line from scratch,
if you move the telescope through every point on the line.

2 Connect your telescope to the computer and establish a link.

3 Display the Limit Line or Horizon Line.

4 Move the telescope so it’s pointing near the limit or the horizon.

The Virtual Sky’s cross hairs should be near the Limit Line or Local Horizon.

5 Select Line Editor from the Telescope menu.

The Telescope Line Editor dialog box appears.

6 Click the radio button of the line you’re editing (Horizon, Altitude Limit,
or Declination Limit).

7 Mark the “Continuously follow telescope” checkbox if you want TheSky
to automatically add or modify points as the telescope moves.

8 Move the telescope so that it’s at a limit or horizon-line obstruction point.

If you’re setting a limit, watch the telescope as you move it. If you’re outlining the
horizon, look through the telescope.

9 Click Connect.

You’ll see the limit line redrawn to include the point. (This step isn’t needed if you
marked “Continuously follow telescope”—TheSky automatically modifies the line.)

10 Repeat Steps 8 and 9 to add additional points.

Pick points that represent extreme positions. For example, if your horizon includes
a high-rise apartment, pick the left and right edges of the top of the building.

Activating the Limit Line

Displaying a limit line does not automatically activate it. To do so, select the
Setup command from the Telescope menu. Confirm that the “Impose Slew
Limits” checkbox is marked, then click OK. (It is marked by default.)

If you try to move the telescope into a “forbidden” region, you are prompted
twice to confirm that you really want to override the limit, and warned that
damage might occur. Be cautious.

If your telescope has a computer-controlled drive (eg, Meade LX-200,
Software Bisque Paramount GT-1100), open the Telescope Setup dialog box
and mark the “Attempt to stop slews in progress through slew limits”
checkbox. TheSky will then monitor the telescope’s motion. If you use the
drive’s controller to try to slew through the forbidden region, TheSky will try
to stop the slew when the boundary is reached.

The telescope link Simulator provides a convenient way to check operation
of the limit lines before connecting a telescope. See page 180.
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Disclaimer

Any motor-driven telescope can—through accident, carelessness, or component
failure—be run into its mechanical limits. Software Bisque provides the limit-
linefeature as a convenience—not as a guaranteed cure for the problem. You
are responsible for the safe use of your instrument.

Field of View Indicator (View menu)

The Field of View Indicator (FOVI) shows the field of view of an eyepiece,
CCD sensor, camera body, or Telrad™ finder. As you zoom the display, the
FOVI shrinks or expands in proportion to the field width.

TheSky comes with six predefined FOVIs—five for SBIG CCD cameras and
one for the Telrad finder. You can also create your own FOVIs. To display a
FOVI in the Virtual Sky:

1 Select the Field of View Indicators command from the View menu.

Or click the Field of View Indicators button in the View toolbar.
The Field of View Indicator dialog box is displayed.

2 In the Description box, click on the FOVI you want to display.

You can select more than one FOVI. To select a range, click on the first, then press
SHIFT as you click on the last. To select (or deselect) individual FOVIs, press
CONTROL (z on the Macintosh) when you click.

3 Mark the checkbox of any of the FOVIs you selected. Click OK.

The selected FOVIs are displayed at the center of the screen. They remain at
the center, regardless of how you scroll or zoom.

To remove a FOVI from the Virtual Sky, highlight the FOVI in the list. Clear
its checkbox, then click OK. To delete a FOVI, highlight its name, then click
Remove. You’ll be prompted to keep or discard it.

The FOVI Marker

Whenever a FOVI is displayed, the FOVI marker—a 9x7-pixel rectangle—
is also added to the display. This marker shows the center of the FOVI. It is
always visible, even if the field of view is too wide for the FOVI itself to be seen.

The marker is not displayed for the Telrad FOVI. A Telrad indicator is visible
even at field widths of 235°, so the marker isn’t needed.

The color and shape of the marker can be changed. In the Preferences dialog
box, highlight Field of View Indicator in the Object Description box. Click
Symbol, then click Edit (under Virtual Sky Sample) to modify the marker.
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Creating Your Own FOVIs

Since there are thousands of possible combinations of telescope objectives
and eyepieces, TheSky does not come with any telescope FOVIs. But it’s easy
to create your own—TheSky does most of the work.

1 Select the Field of View Indicators command from the View menu.

Or click the Field of View Indicators button in the View toolbar.
The Field of View Indicators dialog box is displayed.

2 Click Add.

The Add Field of View Indicator dialog box appears.

3 Type a description in the Description edit box.

For example, Ceravolo HD216 + Nagler 32mm Panoptic .

4 Select the type of FOVI you want from the Type box.

Elliptical plots an elliptical field with the dimensions in the Width and Height edit
boxes. (If Width and Height are the same, the field is circular.)

Use elliptical FOVIs to approximate the view seen through an eyepiece.

Rectangular plots a rectangular field with the dimensions in the Width and Height
edit boxes. (If Width and Height are the same, the field is square.)
Use rectangular FOVIs to preview the field that will be recorded by a CCD or
photographic film. Or compare your CCD images with TheSky’s star field to
determine the exact angle of view of your film camera or CCD imager.

Telrad plots a series of circles that closely approximate the circles seen through
a Telrad finder. The outer circle is 4°, the middle circle is 2°, and the inner circle is
about ½°. (The size and number of Telrad circles cannot be changed. However,
you can create elliptical FOVIs for use with other finders More than one FOVI can
be displayed at a time, so you can easily duplicate almost any pattern of circles.)

The Telrad option is especially useful when preparing star charts for viewing.
The chart shows the observer what he or she can expect to see through the finder.

SBIG ST-7/8 with ST-4X auto-guider plot a compound field that shows the fields of
both the imaging sensor and the guiding sensor.

5 Enter the field size in the Height and Width boxes.

The field size is specified in arc-minutes. (An arc-minute is 1 ⁄60 of a degree.) If you
don’t know the correct values, refer to “Computing the Field of View”, below.

6 Click OK.

New FOVIs are added to the list in the order they are created.

To modify a FOVI, highlight its name, then click Edit. The Edit Field of View
Indicator dialog box (which looks just like the Add Field of View Indicator
box) is displayed. Change any of the values described above, then click OK.
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To change the font or color used for the FOVI, or to modify the FOVI marker,
click the Preferences button to display the Preferences dialog box. The Field
of View Indicator object is automatically highlighted.

FOVIs for SBIG’s combined imager-guider cameras refer to specific CCD
chips. Their default values should not be modified.

Computing the FOVI’s Field of View

TheSky can calculate the field of view for you, and automatically insert the
values in the Height and Width boxes. After performing Steps 1–4, above:

1 Click Compute.

The Compute Field of View dialog box appears.

2 Select the Eyepiece, CCD, or Film tab.

3 Enter the focal length of the telescope.

Click the mm or inches radio button to specify the units.

4 On the Eyepiece sheet, enter the focal length and apparent field width
of the eyepiece.

Focal length is in millimeters, field width in degrees.

Most eyepieces have a field width of about 50°. Super-wide eyepieces are
about 65°, ultra-wide about 85°. If you aren’t sure, check with the manufacturer
or your dealer.

On the CCD sheet, select the imaging chip your camera uses.

Model numbers are shown for Apogee, Celestron, Meade, and SBIG imagers.

On the Film sheet, select the film size from the Format list box.

5 Click Compute, then OK.

The calculated values are automatically inserted in the Height and Width boxes.

If the CCD for your imager isn’t listed, you can create a custom definition.

1 On the CCD sheet, click Add.

The Add Detector dialog box appears.

2 Type a description in the Description edit box.
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3 Enter the height and width of the chip in the Height and Width boxes.

The dimensions should be those of the active imaging area, not the entire chip.

4 Click OK.

The custom entry now appears in the Detector list box.

To remove a custom CCD, highlight it in the Detector list box and click
Remove. When you are prompted, click Yes to delete it, No to keep it.

Detector types cannot be edited. To change a custom CCD, delete it, then
recreate it with new values.

Multiple Telrad FOVIs

You can display several Telrad FOVIs at the same time. This makes it easier
for two or more observers to use a single computer.

1 CONTROL+click ( z+click on the Macintosh) on the first point
in the Virtual Sky where you a Telrad FOVI.

If something other than the Telrad FOVI is displayed, don’t worry.
It will be changed in Steps 3 and 4.

2 Select the Add User Data command from the Data menu.

Or press ALT+U (zU on the Macintosh).

3 Set the Data Class to Objects/Points.

4 Set the Object Type to Field of View Indicator.

5 Click Close.

You’ll see the first Telrad FOVI.

Continue to CONTROL+click (z+click on the Macintosh) in the Virtual Sky
to add more of them.
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8 Labels

The first time TheSky runs, the common names for the following items are
displayed. (Objects that don’t have common names aren’t labeled.)

● comets
● Messier objects
● Bayer designations of principal stars
● non-stellar objects

To hide these labels, select the Labels command from the View menu and
choose Common Names in the flyout menu. Or click the Common Names
button in the View toolbar.

Extended labeling is normally turned off. To show extended labels, select the
Labels command from the View menu, and choose Extended Labels in the
flyout menu. Or click the Extended Labels button in the View toolbar.

Label Setup

The Labels Setup dialog box controls which items are labeled and how much
data is shown. Choose the Labels command from the View menu, then select
Setup from the flyout menu. (Or press ALT+L (zL on the Macintosh) to open
the Labels Setup dialog box directly.) There are two property sheets,
Common Names and Extended.

The Common Name Labels setup is self-explanatory. Mark the checkboxes
of the labels you want, clear those you don’t want, then click OK.

The Extended setup controls the display additional information from a
number of catalogs and databases. Each catalog can have a different set of
Extended Labeling options.

The following extended data can be displayed (depending on the object type
and catalog).



● alternate names (aliases)
● angular separation (double stars)
● B, V magnitude
● distance
● Dreyer description
● equatorial coordinates (right ascension – declination)
● ID (catalog) number
● magnitude
● minimum/maximum magnitude and period (variable stars)
● minor planet name and number
● position error
● proper motion
● spectral class
● type

Highlight the catalog or database whose data you want to display. Then
mark the data types you want to add to the labeling. Click Clear All to hide
all data for that catalog.

The number of labels displayed is limited to about 150, to avoid cluttering
the Virtual Sky.

If an object is dimmer than the value in the Magnitude Limit edit box, its
extended data are not displayed. You can enter values from 30.0 to -6.0.

The default magnitude is zero (0.00). It does not, however, set a limit of zero,
but tells TheSky to show as many extended labels as possible, without
cluttering the display. Entering a value other than zero sets an actual limit.
Fractional values are okay.

For either Common or Extended labeling, click Apply to preview the effects
of your changes, without exiting. Click OK to accept the changes. Click
Cancel to discard your changes—even if you used Apply to preview them.

Extended labeling is available only when the field of view is 50° or less.
It’s most useful when studying a limited number of objects at field angles
of 1° or less.

Extended labels appear to the left of an object, common names appear to the
right. This allows both labels to be read at the same time.

Labeling and labeling format selections last through the current session.
To make any changes permanent, save the current Sky Document.

User Data in User-Created Databases

If you create your own databases and add user-specified data to each record,
the labels of these items will appear on the Extended Labels sheet for that
database. Mark the checkboxes of the data items you want displayed.
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9 Comets, Minor Planets, and Satellites

As shipped, TheSky is set up to plot 11 comets and five minor planets. It’s
easy to display more by loading elements from database files supplied with
TheSky. (There are elements for several hundred comets and over 41,000
minor planets.) You can also enter orbital elements directly into a dialog box,
or download them from the Internet.

Version 5 adds the ability to plot Earth satellites in real time, using two-line
orbital elements (TLEs). Continually updated elements for all satellites can
easily be downloaded from the Internet.

Entering Orbital Elements

Comet and minor-planet data are entered the same way.

1 Select the Comets and Minor Planets command from the Data menu.

The Comets and Minor Planets dialog box appears.

2 Select the Comets or Minor Planets tab.

3 Click Add.

The Comet Input or Minor Planets Input dialog box appears.



4 Enter a name for the object in the Name edit box.

This name appears next to the object when Common Name labels are displayed.

5 Enter all the required values.

6 Change the Epoch, if necessary.

Epoch 2000.0 is the default. You can also specify a month and date.

7 Click OK to accept the entry and close the dialog box.

If any entry has the wrong format, or is outside its acceptable range, you are
prompted to change it. You can’t close the dialog box until all entries are “correct.”

The Comets and Minor Planets dialog box returns.

8 If you do not want the object displayed, highlight its name in the Name list.
Then clear its checkbox.

Newly added comets and minor planets are automatically active. For any comets
or minor planets to be displayed, the Comet or Minor Planet checkbox in the Filters
dialog box must also be marked.

To change the orbital elements for an object, highlight its name in the Name
list. Then click Edit to display the Input dialog box.

To delete an object, highlight its name in the Name list. Then click Remove.
You are prompted to confirm the removal. Even if you respond Yes, you can
still override the deletion by clicking Cancel.

To remove a comet or minor planet from the display without deleting it,
highlight it in the Name list, then clear its checkbox.

Comets and minor planets can be used with Time Skip animation, like any
other Solar System object. You can follow the path of a comet, or predict
when a minor planet will occult a deep-space object. See Chapter 18, “Time
Skip Animation.”

Comet and Minor Planet Data Storage

“Local” comet and minor planet data are stored in comet.dat and
minorpl.dat . These files are limited to 100 objects each. To display
additional minor planets, see “Extended Minor Planet Data” below.

Adding Orbital Elements from Databases

TheSky comes with text-format databases for comets and minor planets. You
can import individual objects, or load the entire database.

There is a single comet database, called comets.cmt . It’s in the user\data

subfolder. It has about 40 entries.

There are four minor-planet databases in the user\minor planets

subfolder: 500.mpl , 1000.mpl 5000.mpl , and 41528.mpl .

The number indicates the number of data records. 500.mpl and 1000.mpl

have the first 500 and 1000 numbered minor planets (1 = Ceres, 2 = Pallas,
and so on). 5000.mpl includes the first 5000 named minor planets.
41528.mpl includes all minor planets—named or not—that are numbered.
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You can import objects from the Comets and Minor Planets sheets, or from
the Comet Input and Minor Input dialog boxes.

1 Click Import.

The Import Comet Data or Import Minor Planet Data dialog box appears.

The default subfolders are user\minor planets and user\comets .
If the file you want isn’t in these folders, use the browsing controls to find it.

2 Highlight the name of the file you want, then click Open.

Or just double-click the name. The Select list box appears. (Large databases
might take a few seconds to load.)

3 Highlight the object you want to add.

You can select more than one object. To select a range of objects, click on the first,
then press SHIFT when you click on the last. To select (or deselect) single objects,
press CONTROL (z on the Macintosh) when you click.

4 Click OK.

If you’re importing from Comet Input or Minor Input dialog box, the object’s orbital
coordinates are written into the edit boxes.

If you’re importing from the Comets or Minor Planets sheet, the new object now
appears in the Name list. It is automatically made active.

5 Click OK again (if you’re still in the Comet Input or Minor Planets Input box).

The new object now appears in the Name list. It is automatically made active.

The comets and minor planets listed in the Name boxes are called the local
lists. The local lists are limited to 100 objects each. In addition to the Import
feature described above, there is another way to add minor planets to the
local lists. It’s explained in the “Extended Minor Planet Data” section, below.

Comets and minor planets are Solar System objects. They appear in the right-
hand list of the Find dialog box when you select “Planets, Sun, Moon” in the
Common Names box. Their positions are updated whenever the other Solar
System objects are. When a large number are displayed, the updating might
take an unacceptably long time. You can either hide some (by clearing their
checkboxes), or you can lengthen the time between updates. (See page 56.)

Obtaining Orbital Elements from the Internet

Under Windows, you can directly access comet and minor planet orbital
elements over the Internet. If you are a Macintosh user, you can obtain them
at cfa-www.harvard.edu/iau/Ephemerides .
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1 Establish a connection with the Internet.

2 From the Comets sheet, click Observable.
From the Minor Planets sheet, click Distant, Critical, or Unusual.

Within several seconds, a select dialog box (like the one in Step 2 of the previous
section) appears.

3 Highlight the object you want to add.

You can select more than one object. To select a range of objects, click on the first,
then press SHIFT when you click on the last. To select (or deselect) single objects,
press CONTROL (z on the Macintosh) when you click.

4 Click OK.

The object is added to the Name list and automatically made active.

Repeat Steps 2 and 3 to add more objects from different groups to the Name lists.
Don’t forget to log off when you’ve finished.

Extended Minor Planet Data

TheSky can display thousands of minor planets at one time—if you don’t
need to have their positions continually updated. You can see which minor
planets might show up in a photograph, or might be part of an interesting
occultation.

The data for these minor planets are in the 500.mpl , 1000.mpl , 5000.mpl ,
and 41528.mpl files in the user\minor planets subfolder.

1 Select the Extended Minor Planets command from the Data menu.

The Select Minor Planet File dialog box appears.

2 Choose the .MPL file you want. Click Open (or double-click the name).

TheSky loads all the objects in the file and computes their current positions. High-
accuracy plotting of a large file can take up to 10 minutes on a slower computer.

3 Select the Filters command from the View menu.

The Filters dialog box appears.

4 Highlight Extended Minor in the Celestial Object box. Mark its checkbox.

5 Click OK

The minor planets you loaded are displayed.

Extended minor planets are plotted to an accuracy of ±60 arc-seconds. If the
“High accuracy minor planet computations” checkbox in the Options dialog
box is marked, the plotting is accurate to ±1 arc-second.

If you click on an extended minor planet to identify it, its elements are
numerically integrated to update them to the current epoch. The coordinates
reported in the Object Information dialog box are computed to an accuracy of
±1 arc-second, regardless of whether standard- or high-accuracy plotting was
selected.

Extended minor planets keep their originally plotted positions; they are not
updated. Therefore, they cannot be used with Time-Skip animation. To
update their positions, reload their .MPL file.
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To hide extended minor planets, open the Filters dialog box and clear the
Extended Minor Planet checkbox. To remove them from the display without
waiting for automatic deletion (described below), open the Options dialog
box (in the Data menu) and click Remove Now.

Adding Extended Minor Planets to the Minor Planets Local List

Extended minor planets can easily be added to the local minor planets list.

1 Click on the minor planet you want to add.

The Object Information dialog box appears.

2 Highlight the minor planet in the Object List (if necessary).

3 Select the Utility tab.

4 Click Copy to Local.

The minor planet is added to the list in the Comets and Minor Planets dialog box.
You can confirm this by opening the dialog box.

The local minor planets list is limited to 100 objects. You will be prompted if you
try to add more.

The newly added minor planets are automatically saved when you exit
TheSky.

Automatic Deletion of Extended Minor Planets

You might forget you’re looking at extended minor planets (whose positions
are never updated) and think their current positions are correct. TheSky
therefore automatically deletes them from the Virtual Sky after a preset time.

The default is three hours. To change it, select Options from the Data menu
and enter a different value in the Time Limit. (Fractional values are okay.)

The Time Limit is a minimum. The actual deletion does not occur until the
Virtual Sky is redrawn following the next Solar System update. (See page 56.)
If you clear the “Use computer’s clock” checkbox before the Time Limit
expires, the Virtual Sky never updates and the minor planets are not deleted.

Satellites

Version 5 of TheSky can plot satellite orbits using NORAD two-line-element
(TLE) sets. Because these data go out-of-date after about 45 days, no TLE
data are supplied with TheSky. They can easily be obtained from the Web
site at http://www.celestrak.com .

The TLE data at this site are grouped into subsets of related satellites, such
as weather, spy, communications, and “100 brightest.” There is also a master
list of all currently orbiting satellites.

Selecting one of these immediately downloads it to your Web browser as
plain text. To save it as a TLE file, select the Save As command from the Edit
menu of your Browser. Use the controls in the Save As dialog box to move to
the user\satellites subfolder. Enter the name you want, then click Save.
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Under Windows, the text is saved as a .TXT file by default. Don’t forget to
change the extension to .TLE.

Plotting Satellite Orbits

Plotting satellite orbits requires little more than loading a TLE file.

1 Select the Satellites command from the Data menu.

The Satellites dialog box appears.

2 In the Satellites dialog box, set the following parameters.

Update Frequency (Fast, Medium, Slow, Very Slow, Never) sets the relative rate at
which satellite positions in the Virtual Sky are updated. Updating a large number of
satellites at a high rate might cause the computer to noticeably slow down.

Compute Frequency sets the time interval between calculations of the satellite’s path.

Number of Increments sets the number of intervals that will be computed and plotted.

Time Labeling displays the name of the satellite.

3 Click the Import button.

The Select File dialog box appears.

4 Highlight the file you want. Click Open.

Or simply double-click the file. If the file is not in the user\satellites directory,
use the controls to browse for it.

The TLEs are loaded and you are returned to the Satellites dialog box.

The satellites should now be visible in the Virtual Sky, even if you haven’t
exited the Satellites dialog box. If the “date-rejected” message indicates that
one or more satellites’ TLEs are out-of-date, check the Date and Time sheet
for the correct time. If the satellites do not move, it’s probably because the
“Use computer’s clock” checkbox is not marked.

If Number of Increments is greater than zero, you will see a line showing the
calculated future path of the satellite. The length of this line is the distance
traveled by the satellite in the Compute Frequency interval, multiplied by
the Number of Increments.

If you have written your own propagator, Software Bisque can provide a
“hook” to access the propagator when the “Use custom propagator”
checkbox is marked. Contact Software Bisque for more information.
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10 Configuring TheSky with Sky Documents

What is a Sky Document?

A Sky Document (.SKY file) is a record of the configuration of the Virtual Sky.
Loading a Sky Document restores the configuration stored in that document.

Sky Documents keep track of the following items.

● orientation
● field width
● active/inactive databases
● Filter settings
● Preference (.SVP) file currently loaded
● object labeling
● lines and labels
● magnitude limits
● brightness and contrast
● plotting density (Low/Medium/High)
● stars/planets recomputation intervals
● Status Bar contents
● Page Setup options
● user-added data
● OLE-embedded objects (Windows)

When you change any item listed above, you change the Sky Document.
That’s why the Undo command is in the Edit menu, not the View menu.

Default Configuration

The first time TheSky runs, the Virtual Sky has the following default
configuration, stored in the default Sky Document, normal.sky .

● Zenith Up mode with the South viewing direction is selected.
● The viewing angle is set to 100° and plotting density to Low.
● The Milky Way and most deep-space objects are visible.
● The Common Name labels for comets and Messier objects, and the

Bayer designations of the brightest stars, are displayed.
● The Ecliptic, Meridian, Local Horizon, and the Constellation Figures

are the only reference lines shown.
● The Status Bar and all toolbars are visible.



Selecting a Sky Document at Startup

When TheSky first runs, it loads normal.sky from the user\documents

subfolder. Every time after, it loads the previously saved Sky Document.

If you want TheSky to start up with a different Sky Document, double-click
the Document’s name in the Windows Explorer or File Manager, or the
Macintosh Finder. This runs TheSky and loads the selected Sky Document.

Loading a Different Sky Document

Use the Open command from the File menu (or press CONTROL+O—zO on
the Macintosh—or click the Open button in the Standard toolbar) to load a
different Sky Document. Scroll the list box to find the file you want, then
highlight it and click Open. (Or just double-click on the name.)

Sky Documents can have any extension and be in any folder. However, the
Open command assumes these files have the .SKY extension and are in the
user\documents subfolder. Using the standard extension and the default
folder makes it easier to find your Sky Documents.

Under Windows, the most-recently loaded Sky Documents are listed at the
bottom of the File menu. On the Macintosh, the most recently loaded files
can be viewed from the Recent Items button in the Open File dialog box.
Click on the one you want to load, or type the number next to it.

Under Windows, you can also load a Sky Document by dragging it from the
Explorer or File Manager and dropping it anywhere in TheSky’s window. (If
you often use a particular Sky Document, you might want to add it to your
desktop.) On the Macintosh, you can double-click on any Sky Document in
the Finder to load it.

Creating Multiple Sky Documents

Selecting Save from the File menu (or pressing CONTROL+S—zS on the
Macintosh—or clicking the Save button in the Standard toolbar) saves the
current configuration. When you exit TheSky, you’re prompted to save any
unsaved configuration changes.

If you often set up specific configurations, it might be useful to create a
different Sky Document for each one. Select the Save As command from the
File menu and enter a new name.

You might also want to create a Sky Document named (say) bookmark.sky .
You can then save your current configuration to it without overwriting any
other Sky Document.

The New command (from either the File menu or the toolbar) does not create
a new Sky Document. (Use the Save As command to do that.) Instead, it
reloads the current document. You are first prompted to save it. Click Yes to
keep any changes made since it was last saved, No to discard them.
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Sky Documents Supplied with TheSky

Besides normal.sky , TheSky includes several Sky Documents that configure
TheSky for specific uses. These are in the user\documents subfolder.

One of them (classic.sky ) reconfigures the Virtual Sky so that it resembles
version 2.x. The others set up TheSky for simulating celestial events.

These Sky Documents replace the recorded Time Skip simulations in Version
3 and earlier versions of TheSky. After loading one, select Step or Go from the
Time Skip simulator.

Sky Document Purpose

analemma.sky analemma

classic.sky Makes Virtual Sky look more
like Version 2.x.

Conjunction of Moon, Saturn & Venus.Sky

Eclipse, Annular - Solar, 1994.05.10.sky

Eclipse, Annular - Solar, 2019.12.26.sky

Eclipse, Total - Solar, 1991.11.07.sky

Ecliptic.sky-shows the ecliptic on the celestial sphere

merxsun.sky transit of Mercury across the
Sun

moonhrly.sky hourly motion of the Moon

moonoant.sky Lunar occultation of Antares

moonoj_v.sky Lunar occultation of Venus
and Jupiter

moonojup.sky Lunar occultation of Jupiter

moonom45.sky Lunar occultation of M45

moononep.sky Lunar occultation of Neptune

moonosat.sky Lunar occultation of Saturn

Occultation - Jupiter X nu2 Sag, 1996.03.06.sky

Occultation - Moon X Aldebaran, 1997.08.29.sky

Occultation - Moon X Hale-Bopp, 1996.05.08.sky

Occultation - Moon X Jupiter & Venus, 1998.04.23.sky

Occultation - Moon X Saturn, 1997.09.18.sky

Occultation - Uranus X SAO163583, 1996.04.10.sky
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Sky Document Purpose

Occultation - Venus X Jupiter, -0002.06.17.sky

Occultation - Venus X SAO92957, 1996.03.14.sky

Occultation, Grazing - Moon X Aldebaran, 1997.07.29.sky

Retrograde - Jupiter, 2006.sky

retromar.sky retrograde motion of Mars

sato28sg.sky Saturn occults 28 Sagittarii

totalsol.sky total solar eclipse

Transit - Mars X Jupiter, 1170.09.12.sky
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11 Customizing the Display with Preferences

TheSky allows an almost unlimited degree of customization. Virtually every
aspect of the Virtual Sky’s appearance can be modified. Star Charts can be
modified, too, and have a completely different set of customizations.

The Preferences Dialog Box

The Preferences dialog box controls how objects are displayed in the Virtual
Sky or printed in Sky Charts.

1 Select the Preferences command from the View menu.

Or press ALT+P (zE on the Macintosh). The Preferences dialog box appears.

The Preferences dialog box can also be opened by clicking the Preferences button
on the Utility sheet of the Object Information dialog box. The object type of the object
highlighted in the Object list box is automatically selected.

2 Highlight the object in the Object List.

3 Click the button of the characteristic you want to modify—
Font, Line, Fill, or Symbol.

The Sample boxes show the current setting or symbol.

4 Click Edit.

There are separate Edit buttons for the Virtual Sky and Sky Charts.

If the Edit button is dimmed, the characteristic you’ve selected cannot be modified.
For example, you can’t change the symbol for the Milky Way (it’s hard-coded), nor
can you modify the Milky Way’s font (because the Milky Way doesn’t have a label).

5 The appropriate dialog box appears.

The following four sections explain the ways in which each characteristic can be
modified.

Once you’ve changed a Preference setting, you have three options.

● To see how the changes will affect the Virtual Sky, click Preview.
● To discard the changes, click Cancel. Even if you selected Preview,

the Virtual Sky is restored to the previous Preferences.
● To accept and save the changes, click OK.



Font

The Font dialog box lets you select any font currently installed (including
TrueType™ fonts, and PostScript™ Type 1 fonts managed by Adobe Type
Manager™). The font’s size, style, and treatment can be chosen. The font and
its treatment are previewed in the Sample box.

Windows system fonts also appear in the Font list. Unlike TrueType and
PostScript fonts, which scale smoothly to any size, system fonts are bitmaps,
and can produce “blocky” or hard-to-read text. They can’t be rotated, either.
Don’t use a system font unless no other font meets your need.

Line

The Line is (usually) the outline of the object. Most objects have a black
outline, so the line is not visible in the Virtual Sky. These objects have a
white outline when printed in a Sky Chart, for the same reason.

You can choose the line’s color, style, and weight (width). You can’t change
both the style and the weight. You can change only the weight of a solid line.
You can change only the style of a one-pixel-wide line.

In some cases the Line is not the object’s outline, but a related property. For
example, the Line color for Spacecraft objects controls the color of the orbit
line drawn in the Virtual Sky. The Sky Chart Line color controls the color of
zoom boxes and the First Point of Aires line in the 3D Solar System. The
Virtual Sky Line color sets the color of the bull’s eye.
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Fill

The Fill is the color of the object. You can select from predefined colors or
define a new color. The available color range is determined by the color
depth of your graphics adapter. TheSky can support depths up to 16 bits.

Windows Fill

You can choose from 48 Basic colors, or click Define Custom Colors and
create one to your taste. There are three ways to define a custom color.

● Drag the cursor over the color palette to set the hue and saturation. Then
drag the arrow in the narrow adjacent “strip” to set the color’s luminance
(lightness).

● Enter Hue (0-239), Saturation (0-240), and Luminance (0-240) values.
● Enter Red, Green, and Blue component values (0-255).

The three selection methods interact. Changing any one of them causes the
other two to show corresponding changes. For example, increasing Sat
causes the cursor in the color palette to move upward. Moving the cursor
over the palette changes Hue and Sat.

If you want a shade of gray—without any color—type 0 (zero) in the Sat
box. Then drag the arrow in the luminance strip to select the shade of gray.

The mixing system in this dialog box can produce over 16 million colors.
If your graphics system does not support this many colors, some colors
might not be displayable as “solid,” but must be created by “dithering”
(mixing discrete samples of) those colors that can be rendered as solid hues.

The “Color|Solid” box shows the dithered version of the color you mixed,
and the “solid” color closest to it. The dithered color is used by default.
If you want to use the solid color, press ALT+O.
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Macintosh Fill

You can choose predefined colors from the Crayon Picker or HTML Picker.

You can define custom colors, and choose the color system in which you
define them.

● HLS hue/lightness/saturation

● HSV hue/saturation/value

● RGB red/green/blue

● CMYK cyan/magenta/yellow/black

Move the sliders to set the percentage of each. Grays are created by setting
saturation to zero and varying the lightness or value, or by setting red,
green, and blue to the same percentage (or setting cyan, magenta, and
yellow to zero, and black to the desired percentage).

When you have a color you like, click OK to apply it to the object. When you
click Save, the new color is stored in the currently loaded Preferences file.

Color Selection Tips

Everyone adjusts his or her monitor differently. The author, for example, keeps
the brightness low to maximize sharpness. This can cause darker hues to
appear dark gray, or even black. If a particular color does not show up in the
Virtual Sky, try adjusting the monitor’s brightness or selecting a lighter color.
Color printers vary in their capabilities. Some dithered colors may not print the
way you expect them to—or even print at all. You should experiment before
changing to the Sky Chart colors.
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Symbol

The symbols used in the Virtual Sky are 9x9 bitmaps. The Symbol Editor
dialog box shows an enlarged view of the symbol on the left, and an “actual-
size” Preview on the right.

To edit the symbol, click on one of the 16 color boxes at the bottom to select
a color, then click on the pixel you want to change. Drag the mouse to change
a row or column of pixels.

To speed up editing, you can select different colors for the left and right
mouse buttons. (Use CONTROL+click to select or apply the “right” color on
the Macintosh.) These selections are shown in the L and R boxes.

The Copy button copies the current symbol to the Clipboard. You can then
pick a different symbol to edit and click Paste to transfer the first symbol.
This is a convenient way to make symbol A a variation of symbol B.

To start from scratch, click Clear to erase the symbol.

When you’re satisfied with your changes, click OK to save them. To discard
them, click Cancel.

The symbols shown in Sky Charts are Windows metafiles (PICT files on the
Macintosh). If you have one of the popular “draw” programs (CorelDRAW!,
Micrografx Designer, FreeHand, Claris Works), you can create your own images
and export them as metafiles or PICT files. Or you can load images from
these programs’ clip-art collections and convert them.

The default printing size of symbols is 3.0 mm square. Changing the Height
or Width changes the size of the printed symbol. If the Height and Width are
not the same, the symbol will be distorted.

Alternate Symbol Sets

TheSky comes with additional sets of symbols, so you can further customize
the Virtual Sky and Sky Charts. The symbols are in the following subfolders.

user\documents\classic
user\documents\realstic
user\documents\symbolic
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To use any of these sets, copy all the symbols in its folder to the symbols

folder. Copy the associated Preference (.SVP) file to the user\SVPs

subfolder. Then open the Preferences dialog box and load the Preference file
for the symbols you want to use.

Creating New Preference Files

The default Preference file is normal.svp . You can create any number of
additional Preference files to customize the appearance of the Virtual Sky
or the Sky Charts.

To create a new Preference file, use the Save As command to save the current
Preference file under a new name. (The current Preference file is not deleted.)
You can then modify the newly named file as you like.

Under Windows, Preference files have the default .SVP extension. If you
don’t supply an extension, .SVP is added automatically.

A Preference file can have any name, but it must be stored in user\SVPs .
TheSky assumes all Preference files are stored there. The name of the current
Preference file—but not its path—is stored in the current Sky Document.

To load a different Preference file:

1 Open the Preferences dialog box.

2 Click Open.

The list box shows the .SVP files in TheSky’s user\SVPs subfolder.

3 Highlight the desired file and click Open. (Or double-click the file’s name.)

The name of the file appears in the title bar of the Preferences dialog box.

4 Click Preview to see the effect of the new Preference file.

5 Click Close to exit.

You can load a Preference file from any folder. However, if it’s not in
user\SVPs , TheSky will not be able to find it the next time it runs. In such
cases, TheSky defaults to normal.svp .
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12 Adding User Data

Every observer has different needs. For example…
● You want to label often-viewed objects.
● You want to mark the boundaries of particular areas (eg, the Virgo

Cluster)
● You want to add an area of nebulosity not currently shown.

TheSky lets you customize the Virtual Sky by adding four types of user data.
● Labels
● Objects/Points
● Lines/Polygons
● Ellipses representing extended deep-sky objects

These user-created data are saved with the currently loaded Sky Document.
Each Sky Document has its own data set, so it’s easy to create unique data
sets, or put together customized Sky Documents for each observing site.

On the other hand, you might want user-created data to be available at all
times. This can be done by exporting user data to a compiled database. (See
“Exporting User Data to a Database” on page 126.)

Basics of Adding User Data

Data points are added by pressing CONTROL and clicking in the Virtual Sky
(z+click on the Macintosh). Repeated clicks add additional points, objects,
labels, or line segments. The default data point is a small red plus sign (+).

Instead of clicking, you can use the Add User Data dialog box add new
points (by selecting a data type and entering coordinates), or modify data
points that were created by clicking in the Virtual Sky. To open the Add
User Data dialog box, select the Add User Data command from the Data
menu (or press ALT+U—zU on the Macintosh).



Changing the Default Data Type

The Data Class box selects the data object to be added—reference points/
objects, labels, or lines/polygons. The data type of the last item in the Contents
list is the default type when you CONTROL+click in the Virtual Sky. (If the
Contents list is empty, the selections in the Data Class and Object Type boxes
are the defaults.)

If this isn’t the type you want to add when you click, you need to change it.
The “catch” is that you probably don’t want to change the type of the last
entry. The solution is simple: CONTROL+click (z+click on the Macintosh)
where you want the next data point to go, then open the Add User Data
dialog box and change the new entry’s data type to the type you want.
Subsequent data points will be of that type.

Adding Reference Points/Objects

The Reference Point is the default data type. To add an object instead of a
point, select one of the types listed in the Object Type list box. (User-created
data types are listed here, in addition to TheSky’s predefined types. See page
127 for information about user-created types.) If you select Comet (for
example), each mouse click adds a comet symbol to the Virtual Sky.

If the object type is a star (or other object) for which a magnitude is valid,
enter a value in the Magnitude box. TheSky can then display the object with
the correct size. The default magnitude is 30—a very dim object.

A reference point or object can be labeled. Type the label in the Label box.
For example, if you put a reference point at the South Celestial Pole, you
might label it “South Pole.”

Adding Labels

Like Post-It® notes, labels can be stuck anywhere. They don’t have to be
associated with objects or data points. A label can have up to 50 characters,
including spaces and punctuation.

To add labels, select Labels from the Data Class box. (The Object Type
doesn’t matter.) Each time you click in the display, a dialog box prompts
you for the label. Or you can add labels and their coordinates from within
the Add User Data dialog box.

The label is displayed to the right of the point where you click, so that it
doesn’t overlap any object at that point.
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Adding Lines/Polygons

A line (or polygon) isn’t an object, but a set of commands. The first segment
of a line requires two commands.

● Move To moves to the starting point of the line.

● Line To draws a line to the second set of coordinates.

Each following (connected) segment requires just one command.

● Line To draws a line to the next set of coordinates.

The End Line command terminates a line.

Lines

To draw a line from within the Add User Data dialog box, select the Lines/
Polygons Data Class and the Reference Lines Object Type. Then enter the
sequence of commands and coordinates needed to draw the line. Be sure to
apply the End Line command to the last coordinates of the current line
before starting another line.

You can also draw the line directly in the Virtual Sky.

1 Select Lines/Polygons in the Data Class box.

2 Select Reference Line in the Object Type box.

3 Click Close.

4 CONTROL+click ( z+click on the Macintosh) at the point you want to start
the first line segment.

Nothing appears in the display, but the starting point is recorded.

5 CONTROL+click ( z+click on the Macintosh) at the end of the first line segment.

The second point is recorded and the first line segment is drawn.

6 CONTROL+click ( z+click on the Macintosh) to add additional line segments.

7 To terminate one line sequence and start another, press SHIFT+CONTROL

(SHIFT+z on the Macintosh) as you click on the first point in the new line.

TheSky automatically adds the required End Line command to the first line.

When the line is completed, you can open the Add User Data dialog box and
verify that the line-segment coordinates fell exactly where you wanted (or
change them if they didn’t).

Every point in a line segment can have its own label. The label is placed next
to the point. If you’d rather have the labels elsewhere, you can add them as
separate objects.

Polygons

You can’t draw a polygon directly on the screen, or enter polygon points in
the Add User Data dialog box. You must draw a closed shape, and export it
to a Sky Database as a polygon. (See “Exporting User Data to a Database” on
page 126.) You don’t have to close the polygon precisely. When the lines are
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exported as a polygon, the coordinates of the last point are automatically
changed to the same coordinates as the first point.

Controlling What You Click On

A data point can be placed anywhere in the Virtual Sky. However, if you’re
drawing constellation lines or attaching labels, you probably want to click
precisely on a star or deep-space object.

To do this, select either “Nearest star” or “Nearest non-stellar” from the
Snap To box. When you click, the selected point “snaps” to the nearest star
or non-stellar object within a few pixels of the point you clicked. If no object
is close enough, the computer beeps. Try moving the cursor closer.

When snapping is active, TheSky has to search its databases for the nearest
object. It may take several seconds for the point to be marked.

If an object has been selected by snapping, the object’s catalog name appears
in the Snap To Object section of the Add User Data dialog box.

More About the Add User Data Dialog Box

The Add User Data dialog box has the following additional features.

● The Delete Entry button removes the data item currently highlighted in
the Contents list. Deletions cannot be undone.

● The Remove All button erases the entire Contents list. Remove All
cannot be undone.

● The Add Entry button inserts a new data point at the end of the list. It
has the Data Class, Object Type, Label, Command, and/or Magnitude
currently specified. The default coordinates are 00.00.00, 00.00.00. After
clicking Add, enter the correct coordinates. (Don’t forget to click the
North or South radio button, depending on the hemisphere.)

● All coordinates are assumed to be Epoch 2000.0. If your coordinates are
for another epoch (1950, say), enter them as given, then click the Precess
button. Type the epoch’s year in the From box, then click OK. TheSky
recomputes them for Epoch 2000.0.

● The Precess dialog box provides a convenient way to convert coordinates
from one epoch to another. Type the From coordinates in the 2000.0
Coordinates edit boxes. Click Precess, then enter the appropriate From
and To dates. Click OK, then read the converted values in the edit boxes.

● Clicking the Center button immediately recenters the Virtual Sky at the
coordinates of the currently selected data point. You don’t have to exit
the dialog box for this change to take effect.

● Export To Text File is used when creating a compiled database. It’s
explained in Chapter 15, “Custom Databases.”
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Adding Ellipses

Version 5 lets you add elliptical user-data objects that represent non-stellar
deep-sky objects.

1 Zoom to an angle of view of 10° or less.

Ellipses cannot be added at fields wider than 10°. Choose a field of view that’s a
little wider than the ellipse you intend to draw.

2 Center the display at the coordinates you want to be the center of the ellipse.

You don't have to be exact. You can reposition the ellipse later.

3 Press CONTROL+F7 (CONTROL+F7 or SHIFT+z7 on the Macintosh).

An ellipse appears in the Virtual Sky.

4 Drag the ellipse’s control points to alter its size, shape, angle, and position.

The control points along the width adjust the minor axis. The control points along
the length adjust the major axis and the angle of rotation. The central control point
repositions the ellipse.

5 When the ellipse has the shape and position you want, press CONTROL+F7

(CONTROL+F7 or SHIFT+z7 on the Macintosh) again.

The ellipse turns a solid color that hides the objects behind it. (If Transparent
Non-Stellar Fill is currently selected, the objects remain visible.)

To change the ellipse’s Object Type or adjust its position, open the Add User
Data dialog box and highlight the ellipse in the Contents box. You can then
select a different Object Type, or alter the coordinates.

To delete an ellipse, highlight it in the Contents box, then click Delete Entry.
(You cannot delete an ellipse while the control points are visible. You must
press CONTROL+F7 (CONTROL+F7 or SHIFT+z7 on the Macintosh) a second time
to convert the ellipse to a user-data object, then open the Add User Data
dialog box and delete it.)
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13 Star Charts and Tables

TheSky can create star charts and tables for personalized study, or as a
reference during observation. Charts can be sent to a printer, or pasted into
other applications. Tables are written to the hard disk as text files. This
chapter describes the available chart and table formats.

Printed Charts

Under Windows or the Macintosh OS, the Virtual Sky can be printed at any
time with the Print command from the File menu (or the Print button from
the Standard toolbar).

Windows

The Print Setup dialog box controls most printing options. You can select the
printer, paper size, paper source, and orientation. Click Properties to view or
change the printer’s other settings.

The Page Setup dialog box (don’t confuse it with Print Setup) controls the
format of the star chart. Its functions are explained later in this section.

Macintosh

The Page Setup dialog box controls most printing options. You can select the
paper size, orientation, scale and other properties.

The Document Setup dialog box (don’t confuse it with Page Setup) controls
the format of the star chart. Its functions are explained later in this section.

Star Chart Format

The section of the sky currently shown in the Virtual Sky is copied to the
printer, using the same format as Chart Mode. (The exact area might vary
slightly, due to the different aspect ratios of the display and the printer.) The
main difference between the Virtual Sky and Chart Mode is that black and
white are reversed—the sky is white, lines and objects are black.

Objects are printed in color on color printers. If you mark the Spectral
checkbox on the Options sheet of the Stellar Options dialog box, the stars
are printed in those colors.



See page 49 for a description of Chart mode, or select Chart Mode from the
Options menu to see what it looks like.

To see what will actually be printed, select Print Preview from the File
menu. Click Zoom In for a more-detailed view. Click Close (or press ESC)
to return to the Virtual Sky.

Orientation

The default orientation is Portrait. The image is oriented vertically (that is,
with the short side of the Virtual Sky running along the long edge of the
paper). Since Portrait orientation does not match the Virtual Sky’s format,
part of the image has to be cut off. As shown below, Portrait orientation
prints only the central ¾ of the screen.

Landscape orientation prints all of the Virtual Sky that’s currently visible,
with its long side running along the long edge of the paper. To print in
landscape, select Print Setup (Page Setup on the Macintosh) from the File
menu, then click the Landscape button.

Changing the Printing Options

The Page Setup command (Document Setup on the Macintosh) from the File
menu controls the contents and format of a star chart.

Portrait Landscape
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Title

The text in the Title box is printed at the top of the chart. You’ll probably
want to change the default (“TheSky (c) Astronomy Software”) to something
that describes your chart.

Format

The format box selects the chart format. There are four choices.

● Standard

The chart is a direct printout of the Virtual Sky. A optional legend—
describing the symbols—can appear below the chart.

● Feature Object

The same format as Standard, but the legend is replaced with data for
a specific object. The default object is the last object you centered in the
Virtual Sky. (See “Feature Object Information” below.)

● AAVSO

American Association of Variable Star Observers standard format.

● List of Objects

Not a star chart, but a list of all the chart objects, their symbols, visibility,
magnitude limit, line and fill properties, and the filename of the symbol.
(On a color printer, the line and fill properties are printed in their assigned
colors.) The Title is not printed.

The List of Objects works best with Portrait orientation. It might not print
fully in Landscape.

Chart Legend

The Type box in the Legend section controls how much is printed.

● None

Nothing—other than the chart—is printed. Without the legend,
the chart sometimes covers a larger area than shown in the Virtual Sky.

● Small

Prints the time and date, display orientation and magnification,
and a symbol key for all objects shown in the chart.

● Detailed

Prints the same items as Small Legend, plus a symbol key for star
magnitudes. (The Portrait and Landscape examples on page 96
include a Detailed legend.)

The height of the legend box (in inches) can be changed by entering a new
value in the Height edit box. The height is fixed. If the box is too small to
hold the complete legend, the box is not enlarged to show any extra symbols.

The font used in the Legend box is controlled by the Chart Legend setting in
the Preferences dialog box.
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Margins

Most printers can’t print to the edge of the paper. TheSky interrogates the
printer driver to find the width of the printer’s physical margins. It formats
the image so that it falls wholly within the margins. This keeps the chart
from being cut off on one or more sides.

You can set wider margins by entering values in the Margins edit boxes.
Setting the Right margin to (say) 3" leaves a space suitable for notes. Or you
can place a wide margin at the top, so that punching looseleaf holes doesn’t
remove a useful part of the chart.

The margin you select is in addition to the printer’s margins. If your printer
has an unprintable border of 0.2", and you set a margin of 1.3", the total
margin is 1.5". A 0" margin prints right up to the printer’s limits.

Using the Chart Space Efficiently

To leave more room for the chart, the Small and Detailed legends show only
the symbols that actually appear in the chart. You can take advantage of this by
adjusting the height of the legend box so it’s no bigger than it has to be. (Use
Print Preview to confirm its size.) The smaller the legend, the bigger the chart.
The default orientation is portrait. Landscape might work better, depending on
which objects are in the chart and the way they’re oriented in the sky.

Star Chart Prefixes

These prefixes are attached to catalog numbers printed with extended
labeling. The New General Catalog is the lingua franca of astronomical
catalogs, so no prefix is used. Variable stars have a unique symbol, so
General Catalog of Variable Stars objects don’t need a prefix, either.

The prefixes shown are the ones commonly used. You can change or delete
them, if you wish.

Feature Object Information

The data in this box come from the last object you centered. Any centering
method works.

● Clicking Center & Frame in the Find dialog box.
● Clicking Center in the Object Information dialog box.
● Using the Center command from the Virtual Sky’s pop-up menu.

You can, of course, edit the Feature Object Information, or replace it with
anything else. The size of this box is controlled by the Height setting.

Fonts

Printer fonts are controlled by the Sky Chart Font settings in the Preferences
dialog box.
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How Much of the Virtual Sky is Printed?

The printed chart is equivalent to a Full Screen view of the current display.
If a legend is added to the printout, the image is slightly reduced in size,
but still shows everything seen in Full Screen view.

The full display is printed only in Landscape mode. Printing in Portrait mode
cuts off the sides of the display—only the central ¾ is printed. However,
if a group of objects or a constellation (such as Orion) is vertically oriented,
Portrait mode makes better use of the chart space.

Adding an Insert to the Star Chart

Your star chart can include a more-detailed view of one section of the sky.
Draw a zoom box around the desired area before using the Print command.

The zoom box can have any aspect ratio. (If you want the zoom box to have
the same aspect ratio as the display driver, press CONTROL as you drag.)
If the zoom box doesn’t have the size, shape, or position you want, delete
the box by clicking outside it anywhere in the Virtual Sky.

Once you’ve drawn a zoom box, the Selected Area section of the Page Setup
(Document Setup on the Macintosh) dialog box becomes active. There are
three ways to plot the selected area.

● Selected Small The full Virtual Sky is printed, with the inset positioned so
it doesn’t overlap the zoom-box area.

● Selected Large The area in the zoom box fills the entire chart. What would
have been the full chart is reduced to fit the insert.

● Selected Only Only the area inside the zoom box is printed.

Show Inset Origin

When the “Show Inset Origin” checkbox is marked, the star chart includes
a gray rectangle marking the area from which the inset was taken. The
rectangle does not hide the objects within it. (The example above shows this
format.)
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The Chart Legend

TheSky’s logo is printed in the lower-right corner of the legend. There’s no
direct way not to print it (other than not printing the legend at all).

However, you can change it. Go to the Preferences dialog box. Highlight
Chart Legend and click Symbol. Click Edit, then Select. In the Select Metafile
dialog box (Select Picture on the Macintosh), pick the graphic you want to be
the Chart Legend.

The metafiles listed are in the symbols folder. The Select Metafile dialog
box (Select Picture on the Macintosh) has no Browse control—if the symbol
you want isn’t there, you have to copy it to the symbols folder.

Most drawing programs include a selection of clip art. Simply load an image
you like, and export it in Windows Metafile format (PICT format on the
Macintosh). Or, if you can draw, create your own design.

Respecting the Copyright

The design of the Software Bisque star chart is copyrighted. We ask that you
respect the copyright by creating star charts only for personal use, or for limited
distribution (such as within your club, or a single posting on the Internet). The
creation of star charts for publication is not allowed without express written
permission from Software Bisque. Thank you.

Printing Problems?

“I clicked OK in the Page Setup or Document Setup dialog box, but the chart
didn’t print.”

The Setup commands only sets up the page format—you still have to select
the Print command!

“The inset didn’t print.”

The inset’s zoom box must be displayed when you select the Print
command. Did you accidentally remove it before printing?

“The object label fonts printed are not the fonts shown on the display.”

There are separate settings for Virtual Sky fonts and Sky Chart fonts.
Check the Preferences dialog box to see if the fonts you want are selected.

“The chart prints, but it overflows the printable area.”

The margins might be too narrow. Try setting wider margins.

“The chart prints, but it doesn’t have as much detail as the Virtual Sky.”

The margins might be too wide. Try setting narrower margins.
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“The printer reports a Memory Overflow error.”

Some printers have special settings to prevent overflow. (Check your
printer’s manual.) If your printer has variable resolution, lowering the
resolution (for example, going from 600 dpi to 300 dpi) might solve the
problem. The ideal solution, of course, is to increase the printer’s memory.

“The chart takes an awfully long time to print.”

A detailed star chart requires a lot of information to be sent to the printer.
Don’t be surprised if a chart takes several minutes to be printed.

Adding Star Charts to Other Documents

A star chart can be copied to the Clipboard, then pasted into another
application. Under Windows, a chart can also be exported as a disk file.

In Windows, charts are in the placeable metafile format. On the Macintosh,
charts are in the PICT format. You should be able to paste or (under
Windows) import them into any program that recognizes these formats.

Charts are always created in “chart mode”—black lines against a white
background—regardless of the current mode of the Virtual Sky.

Copying a Star Chart to the Clipboard

1 Draw a zoom box if you want the chart to include an inset.

2 Select the Page Setup command (Document Setup on the Macintosh)
from the File menu.

The Page Setup or Document Setup dialog box appears.

3 Select the formatting and features in you want. Click OK.

4 Select the Copy command from the Edit menu, or press CONTROL+C

(zC on the Macintosh).

The star chart is now on the Clipboard.

Creating a Disk File of a Star Chart (Windows)

1 Draw a zoom box if you want the chart to include an inset.

2 Select the Page Setup command from the File menu.

The Page Setup or Document Setup dialog box appears.

3 Select the formatting and features in you want. Click OK.

4 Select the Export Star Chart command from the File menu.

The Export Star Chart dialog box is displayed.

5 Type the name you want for the file. Click Save.

Under Windows, the .WMF extension is added automatically. Unless you select
a different folder, the file is written into the user\exported data subfolder.
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Displaying and Printing Uranometria 2000.0™ Charts

The Find command can display the equivalent sky area of any Uranometria
chart. Type

URAnnn

in the Find edit box, where nnn is the chart number.

If you’re printing a Uranometria-equivalent chart, additional information—
such as coordinates and labels—must also be shown. This requires a plus
sign (+) after the Uranometria chart number.

URAnnn+

The following options are set or enabled for Uranometria charts.

● Sky Orientation is set to Pole Up (Horizon coordinates).
● The Equatorial Grid and Ecliptic lines are turned on.
● Grid Spacing is set to High Density.
● All catalogs are displayed.
● The non-existent class of NGCs is turned off.
● The magnitude limit is set to 10 for stars and to 15 for non-stellar objects.
● Star, NGC, and IC labels are turned on. All others are turned off.
● Extended labels for NGC, IC, PGC, GCVS, and PLN catalogs turned on.
● Page orientation is set to Portrait.
● Detailed legend is selected.
● Vertical field height is set to 13°.

Despite the “Uranometria 2000.0” designation, the current epoch is used—
not Epoch 2000.0.

Use the Print Preview command from the File menu to see what the chart
will look like. To print the chart, select the Print command from the File
menu, or click the Printer button in the Standard toolbar.

The Virtual Sky settings for Uranometria simulation are retained until you
manually change them, load a different Sky Document, or quit TheSky.

List Creator

TheSky’s List Creator function (which is accessed by selecting the Export
command from the Data menu) can generate lists of celestial objects, using a
wide variety of criteria to decide which are included and which omitted.
Because the selecting and sorting criteria are so varied and flexible, there is
almost no limit to the kinds of lists you can create.

● NGC open clusters currently above the horizon
● Galaxies 4 arc-minutes or greater in width and

brighter than magnitude 12
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● Man-made satellites currently above the horizon
● Minor planets currently between 4H and 6H RA

and higher than 30° altitude
● All stars visible from the viewing site at a particular time.

Lists can be exported in plain-text (ANSI) format, or in a format suitable for
Orchestrate™ scripts. Only plain-text files are described here. (The Orchestrate
manual explains the use of the List Creator in creating Orchestrate scripts.)

The List Creator is used principally to create observer lists. Be sure to set the
appropriate location and time (using the Site Information dialog box) before
using the command. The List Creator is also an excellent way to assemble a
text database that can be compiled into a Sky Database.

Only the first four tabbed sheets in the Export dialog box are used when
creating plain-text lists. (The Scripting and Mapping sheets are used with
the optional Orchestrate and TPoint™ mapping software, respectively.)

General Sheet

The General sheet sets the overall characteristics of the list.

● List Format chooses a Simple (plain-text ANSI) list or an Orchestrate script.

● Object Type picks the kind of objects to go into the list. A list can include
only one object type, but you can easily combine lists with a text editor.

✴ Star data are taken from the GSC and Hipparcos-Tycho databases.
Because Hipparcos-Tycho has the most-accurate astrometric
(positional) data, it is used when available.
Double and variable stars are catalogued separately from the stellar
databases, so they are considered deep-sky (non-stellar) objects.

✴ Non-stellar objects include everything (except stars) outside our Solar
System. Only the principal databases (H-T, GSC) are searched when
the Virtual Sky is the source. The angle of view must be 50° or less, or
this button is dimmed.

✴ Extended Minor planets are taken from the Extended Minor Planets
currently loaded.

✴ Satellites are artificial Earth satellites. If no satellites are currently
displayed, the Satellites radio button is dimmed.
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● Coord. Format determines whether coordinates are written in decimal or
DD.MMSS/HH.MMSS format.

You can save the List Creator’s configuration in an export definitions (.EXP)
file, so it can easily be reused. Click Save As to create a new file, or click
Open to update an existing file. By default, export definitions are stored in
the user\export definitions subfolder.

When you’re ready to export the list, click Create List. If the List Details
checkbox is marked, the box beneath it shows information about the creation
of the list file. If the Show Path checkbox is marked, lines are drawn in the
Virtual Sky connecting the objects in the order in which they appear in the
list. This serves as a quick confirmation that the list contains the objects you
wanted it to have, in the order you desired. (See “Sort Sheet,” below.) To
remove the path, clear the Show Path checkbox.

Source/Dest. Sheet

This sheet controls where the data comes from and where it is written to.

The default destination is a text file. Click Browse and use the navigation
controls to specify an existing file (which will be overwritten), or supply the
name of a new file (which will be created). If you press CONTROL (OPTION on
the Macintosh) while clicking Create, the new data set is appended to the
existing text file, rather than overwriting it.

You can also send the data to the Clipboard or a printer. The Clipboard is
handy when you want to paste the data directly into an existing document.
You’d probably send the data to the printer when you want a single copy of
an observer list. (TheSky prints to your system’s current default printer.)

The Source radio buttons control where the data is obtained from. Only one
type of source can be selected, but this isn’t a limitation, as you can combine
lists with a text editor.

● Virtual Sky uses only objects that are currently visible in the Virtual Sky.
Anything that changes the Virtual Sky alters the contents of the list.
✴ location, time, and date
✴ field of view and coordinates of the center of the screen
✴ the direction you’re looking
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✴ whether Local Horizon Fill is Transparent or Opaque
✴ Low/Medium/High Density mode
✴ filter settings (Filters dialog box)

The Filter dialog box settings permit an enormous degree of control and fine-tuning.
You can select or deselect whole classes (or types within classes) and choose
the magnitude of the selected objects.

● Selected catalogs takes objects from those catalogs whose checkboxes are
marked. The settings in the Filters dialog box can be used to refine your
selections. See “Virtual Sky Filters” in the “Filter Sheet” section below.

● User data content lets you select individual objects from the Virtual Sky,
by marking each object with a user-data point. The settings in the Filters
dialog box can be used to refine your selections. See “Virtual Sky Filters”
in the “Filter Sheet” section below.

1 Select the Add User Data command from the Data menu.

The Add User Data dialog box appears.

2 Click Remove All to clear the user data.

3 Select “Nearest star” or “Nearest non-stellar” in the Snap To list box.

4 Select Object Points in the Data Class list box.
Select Reference Point in the Object Type list box.

5 Click Close.

6 CONTROL+click ( z+click on the Macintosh) on the objects you want
to add to the list.

● Mosaic contents exports the coordinates of the center of each frame of the
mosaic currently displayed.

● Sky Databases (SDBs) takes items from all databases that are currently
loaded and active. The settings in the Filters dialog box can be used to
refine your selections. See “Virtual Sky Filters” in the “Filter Sheet”
section below.

Filter Sheet

The Filter sheet provides selection options that supplement those available
from the Filters dialog box.
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● Equatorial & Horizon select an area of the celestial sphere (equatorial) or
the local view (horizon). Only objects within these regions are added to
the list.
The default coordinates cover the whole celestial sphere and the local view.
You can limit either or both. Remember that RA-Dec coordinates refer to
absolute positions on the celestial sphere, whereas Alt-Az coordinates refer
to the sky as seen from your site.
The HA (hour angle) settings are relative to the telescope itself—South is 0,
West is +6, North is +12, East is –12—and can be used along with the regular
Ra-Dec coordinates.

● Magnitude controls the brightness range of selected objects. The default
range of -6 to 30.0 includes every object in the catalogs and databases.

● Size sets a limit or range on the size of extended objects, such as nebulae.
If an object isn’t symmetrical, Size refers to its largest dimension.

● Remove objects closer than n (arc-minutes) keeps objects that are closer to
the first object in the list than the stated value from being added to the list.
Enter zero if you don’t want any objects removed. (The “Sort Sheet”
section below explains how the first item in the list is determined.)

● Use PGC identifiers, when marked, uses identifiers from the PGC catalog.
Because the PGC contains most of the items in other catalogs, the resulting
list will often have only PGC numbers. This is especially useful when
creating a searchable database.

● Virtual Sky Filters allows the Filters dialog box settings to modify which
items are taken from the Selected Catalogs, Sky Databases, and User
Database sources. Mark the Object Type or Magnitude checkbox,
depending on how you want to filter the selections. (You can choose both.
If you choose neither, no filtering occurs.) Then click Filters to open the
Filters dialog box. Make your selections, then close the box.

The Defaults button restores the filters to the original (non-filtering) values.

Sort Sheet

The Sort sheet controls the order in which objects appear in the list, and how
paths are drawn in the Virtual Sky.
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There are three choices for Sort Type.

● Not sorted does no sorting at all. The objects are listed in the order the
List Creator finds them in the databases.

● Right ascension sorts objects in order of their RA coordinates.

● Declination sorts objects in order of their Dec coordinates.

Earth satellites move so quickly that you probably won't want to sort them.

If Right ascension or Declination is selected, the Order radio buttons are
enabled.

● Ascending lists objects in order of increasing coordinate values.

● Descending lists objects in order of decreasing coordinate values.

The Path radio buttons control how the path from object to object is drawn.

● Independent connects objects in the order they appear in the list.

● Shortest, object to object finds the absolute- shortest path from the first
object.

● Minimal telescope motion finds the path from the first object with the least
telescope slewing.

The “first object” is the first object in the list. But what determines which
object this is?

● If you sort by right ascension or declination, the first object is determined
by the objects’ coordinates and the sort order.

● If you don’t sort, the objects are first grouped by database blocks, groups
of data for small areas of the sky. (When you export large numbers of
stars you’ll see the path lines bunched within squares.) Within a block of
data, objects are arranged in order of increasing brightness. So the object
with the lowest magnitude is the first listed item in any given block.

Sample List

For example, the following is a list of galaxies surrounding NGC 891. There
was nothing complicated about its creation—the author simply placed NGC
891 at the center of the Virtual Sky, then adjusted the field width to limit the
number of galaxies.

CGCG538-47 Galaxy 02h 21m 05.50s +41°49'12.0" 15.6 0.0 0.0
CGCG538-54 Galaxy 02h 22m 50.40s +42°09'29.0" 15.8 0.0 0.0
NGC891 Spiral Galaxy 02h 22m 33.00s +42°20'48.0" 10.8 13.4 2.5
CGCG539-5 Galaxy 02h 23m 53.60s +42°12'22.0" 15.8 0.0 0.0
CGCG539-9 Galaxy 02h 24m 47.20s +42°01'28.0" 15.8 0.0 0.0
NGC906 Spiral Galaxy 02h 25m 16.30s +42°05'23.0" 14.0 1.8 1.6
NGC911 Elliptical Galax 02h 25m 42.40s +41°57'22.0" 13.7 1.7 0.9
NGC914 Spiral Galaxy 02h 26m 05.10s +42°08'38.0" 13.7 1.8 1.3
CGCG599-26 Galaxy 02h 26m 55.00s +42°01'00.0" 15.8 0.0 0.0
UGC1859 Type C Galaxy 02h 24m 44.40s +42°37'23.0" 13.9 1.7 1.1
PGC9068 Galaxy 02h 23m 11.70s +42°57'54.0" 30.0 0.0 0.0
NGC898 Spiral Galaxy 02h 23m 20.30s +41°57'04.0" 13.8 2.0 0.4
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Planet Report

The Planet Report command from the Tools menu displays a scrolling text
window with the following data. These data are provided for the Sun, Moon,
and all planets (except the Earth).

● rise, set, and transit times (for the current horizon)
● right ascension & declination
● altitude & azimuth (for current display time)
● phase (where applicable)
● apparent magnitude
● heliocentric ecliptical coordinates
● geometric geocentric ecliptical coordinates
● mean geometric ecliptical coordinates
● true equatorial coordinates (in RA-Dec)
● apparent angular diameter
● miscellaneous physical data specific to each object

The following information is also supplied at the beginning of the list.

● current date (Gregorian calendar date and Julian date)
● current time (UT and local sidereal) and time zone
● deltaT (dynamical time)
● latitude, longitude, time zone, and elevation

If you want this information for an observing session, set the appropriate
location and time (on the Location and Date and Time sheets) before using
the Planet Report command.

These data are discarded when you click Close. However, you can select any
or all of the text in the window, copy it to the Clipboard, then paste it into a
text editor or word processor.
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14 The Sky Database Manager

Several Sky Databases are supplied with TheSky, and you can create any
number of your own. Of course, you wouldn’t normally load every available
database at the same time—the more databases in use, the longer TheSky
takes to search for objects and redraw the screen.

The Sky Database Manager controls which databases (.SDB files) are loaded
when TheSky runs, and which of the loaded databases are actively searched.
You can enable or disable databases, and load or unload them, even while
TheSky is running.

1 Select Sky Database Manager from the Data menu.

The Sky Database Manager dialog box appears.

2 Click Add/Remove.

The Add/Remove Sky Databases dialog box appears. The File List shows
which SDBs are loaded.

3 To unload a database, highlight its name in the File List box and click Remove.

The database is either removed from memory, or its file is closed. It is not deleted
from the hard disk. Click OK to return to the Sky Database Manager dialog box.
You can select more than one database. To select a range, click on the first, then
press SHIFT as you click on the last. To select (or deselect) individual databases,
press CONTROL (z on the Macintosh) as you click on their names.



4 To load a database, highlight its name in the upper list box.

If the database does not appear in the box, use the browse controls to locate it.
You can select more than one database. To select a range, click on the first, then
press SHIFT as you click on the last. To select (or deselect) individual databases,
press CONTROL (z on the Macintosh) as you click on their names.

5 Click Add to add the database to the File List box.

Repeat Steps 4 and 5 to load additional databases.

6 Click OK.

You are returned to the Sky Database Manager dialog box.
Loading a database automatically activates it. Its checkbox will be marked.

To enable or disable databases that are already loaded:

1 Select Sky Database Manager from the Data menu.

The Sky Databases box shows which databases are currently loaded or open.
Each database has a checkbox. Active databases are marked, inactive databases
are clear. The name of a database is the Identifier you supply when you compile a
database—not the file name of the database.

2 Mark the checkboxes of those databases you want to activate.
Clear the checkboxes of those databases you want to deactivate.

Inactive databases remain open, or loaded in memory, but are not displayed or
searched.

To select a range, click on the first, then press SHIFT as you click on the last. To
select (or deselect) individual databases, press CONTROL (z on the Macintosh) as
you click on their names. Marking or clearing one of the selected databases
activates or deactivates all of them.

Searchable Databases

A database is searchable only if one of the fields in its records is marked as a Find
field. If a searchable database is loaded and active, its Identifier is listed in the
Databases section of the Find dialog box.
See Chapter 15, “Custom Databases,” for a description of database Identifiers
and the Find field.

Specialized Databases

Version 5 comes with an interesting selection of specialized databases.

Abell Galaxy Clusters

A catalog of over 2700 clusters of galaxies commonly used in astronomical
research.

Arp Peculiar Galaxies

Dr. Halton C. Arp’s catalog of 330+ peculiar or interesting galaxies, such as
groups or interacting pairs of galaxies. It was compiled from the Palomar
Sky Survey photos.
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Binocular Asterism

Small asterisms best seen with binoculars or low-power telescopes.
Displayed at field widths of 50° or less.

Bright Nebula

A detailed isophote drawing of the region around the Eagle nebula.
Displayed at field widths of 50° or less.

Caldwell

A database of 109 interesting objects intended to augment the Messier
catalog. They were compiled by Patrick Caldwell-Moore.

Constellation Art

These are more-or-less conventional drawings of the signs. There are 12 files,
one for each sign of the zodiac.

Dark Nebula

A selection of dark nebulas. Displayed at field widths of 50° or less.

Galactic Globule (“Galactiglob”)

Clusters of 10 or more galaxies, brighter than magnitude 16, within a 50'
field. Nearly 3000 previously uncatalogued galaxies are included.

Galaxy Isophote

Outlines showing the structure of the M51 galaxy, beyond a simple ellipse.
Displayed at field widths of 10° or less.

Herschel Numbers

William Herschel’s catalog of 400 galaxies, globular clusters, double stars,
and other objects.

Meade Alignment Star

Thirty-three alignment stars used with Meade LX-200 drives.

Navigational Star

The names of 58 stars commonly used in navigation.

Nebula Isophote

Outlines showing the structure of the Eagle nebula.

Palomar Globulars

A database of 15 globular clusters from the Palomar Sky Survey photos.
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Pole Indicators

Indicate exact positions of true celestial poles (north and south).

Popular Asterism

Constellation lines for the most-popular constellations.

Popular Names

The names of 34 common objects.

RealSky North
RealSky South
RealSky North & South

The center coordinates of the plates used to create the RealSky CD ROMs.
When you click on one of these points, the Object Information dialog box
displays the year in which the plate was taken, the plate ID, and the source
of the image.

Shower Radiants

Coordinates of the radiant for 64 annual meteor showers. The peak date and
zenith hourly rate are also supplied in the Object Information dialog box.

Super Nova

The positions of all super novas discovered to date.

Terzian Globulars

11 globular clusters compiled by astronomer Yervant Terzian.

Tom Lorenzin 2000+

A database of galaxies, with very precise coordinates, compiled by amateur
astronomer Tom Lorenzin.

Trapezium

Adds additional stars to the Trapezium in the Great Nebula of Orion.

Zwicky

The Zwicky Catalog of Galaxy Clusters contains 9134 clusters of galaxies
from the Palomar Sky Survey. It was compiled by Fritz Zwicky.
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15 Custom Databases

Astronomical software usually comes with just one set of databases, and the
software can access only that data. Databases in different formats can’t be
read, and there’s no easy way to create custom databases.

TheSky is different. It can read and display almost any text database,
regardless of its source. You can also design custom databases to meet your
own observational needs, or to add objects not in TheSky’s databases. And
you can create your own symbols to associate with these objects.

Database Requirements

An astronomical database must meet several requirements. The most-
important of these is that it’s written in plain text. That is, you can print
it out and read it directly—as in the example below.

Algol      SAO  38592   3.135833   40.955556
Betelgeuse SAO 113271   5.919519    7.406944
Castor     SAO  60198   7.576389   31.888056
Deneb      SAO  49941  20.690000   45.280000
Fomalhaut  SAO 191524  22.960833  -29.622222
Mizar      SAO  28737  13.398333   54.925278
Peacock    SAO 246574  20.427222  -56.734722
Rigel      SAO 131907   5.241944  -08.201389
Sirius     SAO 151881   6.752222  -16.716111
Thuban     SAO  16273  14.072778   64.375556
Vega       SAO  67174  18.615556   38.783611

Celestial data are usually distributed as plain-text (ASCII or ANSI) files, as
these can easily be read or modified with any text editor. The NASA CD
ROM of selected astronomical catalogs and the IAU listings of minor-planet
ephemeridae are examples of such databases. TheSky includes over 40
catalogs of database text files, along with their compiled Sky Databases.

There are several other “common-sense” format requirements. Almost every
text database meets them.

● Each data record must be on a separate line.
● Lines must be separated by “hard” carriage returns. (A hard return is

created when you press ENTER or RETURN.)
● The data in each record must have a consistent format—each field must

be in the same position on each line. (Lines can vary in length, though.)
● Each object must have equatorial or horizon coordinates. (Otherwise,

TheSky won’t know where to plot it.)

Since there is no standard database format, TheSky needs to know what type
of information the database contains, and where it appears in each record.
The Import dialog box is a convenient interface for entering this information.
Or you can supply format information in a “header” section of the file.



Importing Databases

You should be able to import any text-format astronomical database that
meets the requirements listed above and then compile it to a Sky Database
(.SDB) file. (The only “practical” requirement is that each record be limited
to 1500 characters.) Follow the steps below.

1 Select the Import command from the Data menu.

Or press ALT+C (zH on the Macintosh). The Import dialog box appears.

2 Click Browse.

The Open dialog box appears.

3 Highlight the name of the file you want and click Open.

Or just double-click its name. TheSky might take a few seconds to load a large file.

TheSky has several text databases in the user\SDBs subfolder. You can load
one of these to see how database compilation works.

4 In the Identifier edit box, enter a unique name for the database.

The name can be up to 50 characters, including spaces and punctuation. This name
will appear in the Sky Database Manager dialog box. Duplicate Identifiers cause no
harm—but you’ll have to study their descriptions in the Sky Database Manager to
tell them apart.

5 Select the Data Class of the objects in the file.

6 Select the Object Type.

If you select Objects/Points, you must also select an Object Type. This type
becomes the default type for the database. Symbols for user-created object types
(page 127) also appear in the Object Type list, and can be selected.

If the text database includes the Software Bisque header data, the Data Class and
Object Type are read from the header and automatically selected. (The header
format is described later in this chapter.)

If you selected Labels or Lines/Polygons, the Object Type doesn’t matter.

7 If the coordinates are not Epoch 2000.0, enter the correct epoch.

Epoch 1950.0 or 2000.0 can be selected by clicking the spin button. You can also
manually enter any year between 1000 CE and 3000 CE.
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8 Mark the “Horizon-based coordinates” checkbox if the data file does not
use equatorial coordinates.

Astronomical databases are of celestial objects, and therefore use equatorial
coordinates. Horizon coordinates are normally used only when adding reference
lines or labels keyed to a specific observation site (for example, a reference point
that marks an annoying street light).

9 Mark or clear the “Load to memory” checkbox, as required.

If you want the SDB to be loaded into computer memory (RAM), mark this checkbox.
This setting should be used for small databases—those with less than 4,000 or
5,000 objects. It gives the fastest searching and plotting, but places the greatest
demand on system resources.
If you want the SDB to be an optimized disk file which TheSky can access (but isn’t
loaded into memory), clear this checkbox. This format is best for large databases
(those over 5000 objects) that require too much RAM to load.

You’re now ready to tell TheSky how to interpret the data in the text file.

1 Click Define Fields.

The Field Definition dialog box appears. The first 80 database entries are displayed
in the bottom window. The columns are numbered across the top.

2 Highlight the columns with the RA coordinates.

There are three ways to do this.

• Drag the mouse from the first (left-most) column to the last (right-most) column.

• Click on the first column. Then press SHIFT and click on the last column.

• Click within the Columns edit box. Enter the numbers of the first and last columns,
separated by a dash (–).

3 Click RA Hours.

This defines the field that will be read as right-ascension hours.

4 Repeat Steps 2 and 3 for RA Mins and RA Secs.

If the right ascension is given as a single decimal value, you don’t need to define
RA Mins and RA Secs.

5 Repeat Steps 2 and 3 for the Dec Sign, Dec Degs, Dec Mins, and Dec Secs.

If the declination is given as a single decimal value, you don’t need to define Dec
Mins and Dec Secs.

The Dec Sign can be plus or minus signs (+ or –), or the letters N or S.
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The only required fields are right ascension and declination. (In a database of
reference points, they’re all that’s needed.) Most databases, however, need
more than just coordinates to be useful.

TheSky provides eight pre-defined optional fields to format the additional
information. Only those fields appropriate for the chosen data type are
available; the buttons of the remainder are dimmed.

● Alias The common name or database identifier of a sky object that the
multimedia file in this record is to be associated with. (See Chapter 16,
“Image and Multimedia Databases.”)

● File Name The name of a text, image, audio, or video file, for databases of
text, pictures, sounds, or movies. The full path is not needed, because
TheSky assumes the file is in the same folder as the .SDB database file.
(If TheSky can’t find the file there, it looks in the pictures folder.)

● Find The search index. This field must be included if the database is to be
searchable, and appear in the Databases list of the Find dialog box.

● Magnitude The magnitude of a star (or any object for which a magnitude
is appropriate).

● Maj[or] Axis The major axis of an extended object, in arc-minutes.

● Min[or] Axis The minor axis of an extended object, in arc-minutes.

● Obj[ect] Type Databases normally have a single predefined type, which is
the default. However, a database can include objects of up to nine types.
This column defines the eight non-default types.

● Pos[ition] Angle The angle of the major axis of an extended object.
It is measured counter-clockwise from the North Celestial Pole.

These optional fields are associated with a range of columns in the same
way the required coordinate fields are. You highlight the columns with the
data, then click the corresponding button.

There are also eight user-defined User Fields, which can be associated with
user-supplied data. Their data appear in the Object Information dialog box.
They also appear in the Virtual Sky when Extended Labeling is turned on.

To see which columns are associated with a field, press SHIFT and click that
field’s button (Required, Optional, or User). The Columns edit box shows
the columns (0-0 means there is no association), and the data columns are
highlighted in the display.

To remove an association, make sure no columns are selected. (Click in an
“empty” area of the dialog box. The columns edit box should read 0-0 .)
Then click the button for that field. The Verify dialog box asks if you want to
“Clear column information?”. Click Yes to remove the association.

You’re now ready to compile the database.
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1 Click OK to exit the Field Definition dialog box.

2 Click Compile.

The compilation time depends on the file size and your computer’s speed.

3 When compilation is complete, a dialog box prompts “Add to Auto Load
Database List?”.

Clicking Yes adds the new database to the list that appears in the Sky Database
Manager, and makes it active. You can use it immediately, without restarting
TheSky. It will be automatically loaded the next time you run TheSky.
Clicking No does not add the new database to the list. The database is available
during the current session, but it is not loaded the next time you run TheSky.

The positions of the database objects are plotted in the coordinate box at the
lower right, to confirm the compilation.

Sky Database Limitations

Any individual Sky Database (SDB) can hold over 100,000 objects. TheSky can
accommodate up to 200 SDBs at a time. How closely you can approach both
these limits depends on your computer’s resources (principally, the amount
of free RAM).

Creating Custom Databases

An amateur pursuing the 400 Herschel objects has different requirements
from a comet hunter trying to identify every faint, fuzzy patch. Sky
Databases (.SDB files) provide an elegant way to meet the varying needs of
the computer-aided astronomer. Custom-database objects can be plotted,
printed, searched for, and identified, just like the objects in the databases
supplied with TheSky.

Although 200 SDBs can be open at one time, and an SDB can contain 100,000
objects, SDBs are for customizing TheSky, and intended to be relatively small.
The following suggestions should help in designing a database that’s easy to
set up and maintain.

● Think about what you want to put in the database—and what you want to
leave out. Don’t include data you’re not likely to use.

● Every record must have the same format—but records don’t have to be
the same length. Comments should be placed at the end of each record,
where they can be of any length (within the 1500-character limit).

● Databases with a single type are usually easier to set up and maintain.
If you include more than one type, remember that the limit is nine types.

Optional Header

In addition to the data records, the text file from which a Sky Database is
compiled can contain an optional header that specifies the database format.

>IDENTIFIER Common Star Names
>CATALOG CLASS = LABELS
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>OBJECT TYPE 0
>LOADMEMORY
>LABEL 1,20
>ALIAS 22,33
>RAHOURS 35,43
>DECDEGREES 44,54
Acamar SAO 216112 2.970556 -40.304167

The header is the set of lines starting with right angle brackets (>). Lines
starting with semicolons (;) are comments. The compiler ignores them.

The header information can be entered in the Import and Field Definitions
dialog boxes, of course. However, the header format is worth learning and
using, for these reasons:
● A text file with a header is immediately ready to compile.
● You can create or edit a database on any computer with a text editor—

you don’t need TheSky to set up the formatting.

The header commands must come before the data, but they can appear in
any order. However, you’ll probably want to order them as shown in the
example, with the “general” commands first. The field definitions follow,
in the same order they appear in each record.

The header commands are listed in the table below, with examples.

Header Command Parameter Example

>ALIAS
starting and ending columns of common name or
database identifier a multimedia object is associated with

44,55

>BRUSH COLOR the fill color of an object R=000 G=099 B=128

>CATALOG CLASS the type class of the database LABELS

>DECDEGREES starting / ending columns of declination degrees 1,2

>DEC X declination degrees multiplier 1.0

>DECMINUTES starting / ending columns of declination minutes 4,5

>DECSECONDS starting / ending columns of declination seconds 7,8

>DECSIGN starting / ending columns of declination sign 3,3

>HORIZON COORDINATES No parameter required. Indicates coordinates are Alt-Az.

>IDENTIFIER text description of the data Herschel Objects

>LABEL starting / ending columns of data labels 50,70

>LOADMEMORY
No parameter required. Indicates file should be loaded
to memory. If not present, file is read from disk.

>MAGNITUDE starting / ending columns of object magnitude 20,25

>MAGNITUDE X magnitude multiplier 10.0
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Header Command Parameter Example

>MAJOR AXIS starting / ending columns of object major axis 30,35

>MAJOR AXIS X major axis multiplier 10.0

>MAX PLOT ANGLE the widest angle at which objects can be displayed 50

>MIN PLOT ANGLE the narrowest angle at which objects can be displayed 42

>MINOR AXIS starting / ending columns of object minor axis 40,45

>MINOR AXIS X minor axis multiplier 1.0

>OBJECT TYPE Index number of object type 1=variable star, etc

>PARSE Up to 8 additional data fields can be added. PARSE “Color” 1,7
PARSE “Name” 14,24

>PEN COLOR the outline color of an object R=256 G=064 B=110

>POSITION ANGLE starting / ending columns of object position angle 50,55

>POSITION ANGLE X position angle multiplier 1.0

>RAHOURS starting / ending columns of right ascension hours 1,2

>RA X right ascension hours multiplier 0.0666667

>RAMINUTES starting / ending columns of right ascension minutes 3,4

>RASECONDS starting / ending columns of right ascension seconds 5,6

>SEARCH
starting / ending columns that Find command can
search for information

1,108

>XREF DATABASE
Refers to an object in an existing database. Information
is taken from that database, not the current one.

SIRIUS
SA01024

>XREF PURE
cross-reference of one object to a multimedia object
without reference to coordinates

MARS mars_1.gif
NGC2231 ngc2231.txt

The header commands are largely self-explanatory. A few need a bit more
explanation.

● >DECMINUTES, >DECSECONDS, >RAMINUTES, >RASECONDS

If right ascension or declination is given as a single decimal value,
the corresponding entries are not needed.

● >DEC X, >RA X

If right ascension or declination is given as a single decimal value,
the multiplier applies to the full value—not just the integer part.

● >DECSIGN

The sign of the declination does not have to be separate entry—it can be part
of >DECDEGREES. However, for ease of reading and editing, some users
reserve a separate column for the sign. The declination sign is usually a plus
or minus sign (+ or –). It can also be the letters N or S.
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● >HORIZON COORDINATES

Astronomical databases are of sky objects, and therefore use equatorial
coordinates. This command lets you create a database of site-specific
reference points or lines. Altitude values are entered as if they were right
ascension, azimuth values as if they were declination.

● >LOADMEMORY

A compiled Sky Database can be either a disk file that TheSky opens and
reads as required, or a binary file that is loaded into RAM for immediate
access. The disk file is the default. The >LOADMEMORY command tells
TheSky to create a memory-resident binary file.

● >OBJECT TYPE

This number corresponds to the position of the object type in the Filters
dialog box. Please refer to page 190 for a list. User-created object types
start at 60.

● >PARSE

The >PARSE command creates user-defined data entries by defining their
names and fields. These appear in the Object Information dialog box.

● >SEARCH

Specifies the range of columns that can be searched by the Find command.
Data outside these columns cannot be located with the Find command.

● >XREF DIRECT

References an object (by name or catalog number) that already exists in
another catalog. The data for that object are taken from the other catalog
or database, not the current database.

● >XREF PURE

Associates an object (by name or catalog number) that already exists in
another catalog, with another object (star, text file, picture, sound, movie).
Because the first object is already defined, coordinates are not needed.

There is no header command to specify the epoch. Therefore, all coordinates
in a given SDB must be from the same epoch. Before compiling, be sure the
correct epoch (1950.0 or 2000.0) is selected in the Import dialog box. The
Precess button in the Add User Data dialog box (page 92) can perform the
conversion for you.

Database Types

In general, a Sky Database (SDB) contains objects of only one type. The type
classes are:

● Objects/Points
● Labels
● Lines/Polygons

Each class has its own characteristics, described in the following sections.
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Objects/Points Class

The Objects/Points class is primarily used to add celestial objects—stars,
galaxies, clusters, comets, nebulae, special symbols, and so forth. It’s also
used to place reference points.

You can select any object type that appears in the Preferences dialog box,
including user-defined types. (These are described later in this chapter.)

Clicking on an Object/Point symbol displays the Object Information dialog
box. The usual data are displayed for objects. Reference points are called
buffer points and are numbered: buffer point #1, buffer point #2, and so on.

Possible uses for an Objects/Points SDB include
● images not supplied with TheSky.
● a catalog of special objects, such as gamma-ray bursters or

the Herschel list.
● new coordinates for objects that are not positioned correctly

in any of TheSky’s databases.
● reference points for useful coordinates (such as the Celestial Poles),

or objects you often observe.

Labels Class

The Labels class adds descriptions, titles, or labels to the display. No symbol
is shown in the display, other than the label itself. Clicking a label displays
the Object Information dialog box, but nothing about the label is listed—
the label itself is the information.

A Labels database is most-often used to label objects that aren’t already
labeled. It can also be used to rename objects, or provide captions in a
different language.

When a Label database is loaded and active, its contents are automatically
displayed when Common Names labels are turned on. If labels are displayed
that you don’t want to see, use the Sky Database Manager to deactivate (or
unload) their database.

Lines/Polygons Class

The Lines/Polygons class adds reference lines and colored areas (“filled
polygons”) to the display. Unlike the Objects/Points and Labels classes,
lines and polygons are not objects as such, but instructions that specify
where lines and polygons are drawn.

As with labels, clicking on a line or polygon displays the Object Information
dialog box, but nothing about the line or label is listed—the line or polygon
itself is the information. If you need to display information, add an object
near the line or within the polygon.
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Possible uses for a Lines/Polygons SDB include
● reference lines, such as site obstructions.
● new constellation outlines.
● nebulae not currently in TheSky’s SDBs.

There are three line commands and three polygon commands.

● Move To

Terminates any preceding line and specifies the starting point of a new line.
All lines begin with a Move To command.

● Line To

Draws a line from the preceding Move To or Line To coordinates to the
coordinates given in this Line To command.

● End Line

Draws a line from the preceding Move To or Line To coordinates to the
coordinates given. The line terminates at this point.

● Poly Beg

Specifies the starting point of a new polygon.

● Poly Point

Draws a line from the preceding Poly Beg or Poly Point coordinates to the
coordinates given in this Poly Point command.

● Poly End

Specifies the end point of a polygon. If the Poly End coordinates do not
match the Poly Beg coordinates, the database compiler forces them to match,
so that the polygon closes.

Here are two examples of the line and polygon commands. The first draws
the familiar “Big Dipper” asterism. (The SAO star numbers are included for
reference but aren’t needed to draw the lines.)

1 MOVE TO  SAO44752  13.79233333  49.31305556
2 LINE TO  SAO28738  13.39877778  54.92138889
3 LINE TO  SAO28553  12.90046389  55.95944444
4 LINE TO  SAO28315  12.25707500  57.03222222
5 LINE TO  SAO15384  11.06209167  61.75055556
6 LINE TO  SAO27876  11.03068611  56.38194444
7 LINE TO  SAO28179  11.89714722  53.69444444
8 LINE TO  SAO28315  12.25707500  57.03222222

The second uses polygon commands to fill the “ladle” of the Big Dipper.

9 POLY BEG    SAO28315  12.25707500  57.03222222
10 POLY POINT  SAO15384  11.06209167  61.75055556
11 POLY POINT  SAO27876  11.03068611  56.38194444
12 POLY POINT  SAO28179  11.89714722  53.69444444
13 POLY END    SAO28315  12.25707500  57.03222222
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Line color is controlled by the Line color of Reference Lines. Fill color is
controlled by the Fill color of Reference Lines. Use the Preferences dialog
box to change them.

Format Restriction

Don’t enter a coordinate pair where both coordinates are zero (0.00000000 or
00 00 00). The record with those coordinates is ignored, and won’t appear in
the compiled database.

The reason for this has to do with the way the Sky Database compiler handles
comment lines. It assumes lines starting with a semicolon ( ; ) are comments,
and ignores them. Of course, the semicolon isn't universal—other databases
might very well use different characters to designate comment lines.
The compiler parses records by calling a function that converts text to numbers.
If this function doesn’t recognize text as a number, it returns a value of zero.
If both coordinates in a pair are read as zero, the compiler assumes it’s reading
text on a comment line (even if the line doesn’t start with a semicolon), and
skips over that record.
So—if you want to enter a zero-zero coordinate pair, make one of them zero,
and the other “vanishingly small” (such as 1 arc-second or 0.00000001).

Defining Database Indexes

An index makes it easy to find a particular entry in a database. If every
database record includes an index value, and its field is defined as a Find
field, the database becomes searchable. You enter the index value in the Find
edit box and TheSky locates the record.

An index can be any combination of letters and numbers. Indexes don’t have
to appear in alphabetic or numeric order, nor must they have a consistent
format. For example, one record can have the index JP502H, while the next
could be 794Z68PF . They only have to be unique within a given database.

In practice, some index formats work better than others. The following two
formats are recommended. (You are free, of course, to do things any way
you like. We wouldn’t want to be non-PC and suggest that maybe we know
anything. After all, anyone’s point of view is just as valid as anyone else’s.
We don’t want to be elitist, just because we designed the stinking program,
for cryin’ out loud, and might have some good suggestions.)

● If a database comprises objects of a single type, it usually makes sense
to number the entries in order—1, 2, 3, 4, and so on. You don’t need to
specify the type, because the Identifier does that for you. You choose an
Identifier from the Databases list box, then type just the index number.

● If a database includes objects of multiple types, you’d probably use an
alphabetic prefix that indicates the type, followed by a number. Each
type can use the same numbering sequence, since the alpha prefix makes
each entry unique. With this format, you don’t need to pick an Identifier
from the Databases list box—you just enter the full index.
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The Field Definition dialog box is used to add a search index to the database.
Highlight the columns that contain the index, then click Find. For the Find
command to actually search this database, it most be loaded and active.

Multiple Finds when Searching Sky Databases

The search engine looks for all records starting with the same letters or
numbers you entered. If you search for catalog number 25 (say), the search
also finds catalog numbers 251, 252, 2503 (and so on), if they exist. The
search stops after the first 10 matches.

Adding User-Defined Fields to the Database

Each database record can include up to eight user-defined fields. These fields
can include anything you want, and have any label you like. The labels and
their associated data are displayed in the Object Information dialog box
when you click on the object or locate it with the Find command box.

These labels are also listed on the Extended sheet of the Labels Setup dialog
box, when the database is loaded and active. Mark the checkboxes of those
labels you want to add to extended labeling.

These fields can be defined with the >PARSE command in the header. You
can also use the Field Definition dialog box to define them, just as you did
with the predefined database fields. (See page 115.)

1 Drag the mouse cursor across the columns that represent a user field.

2 Click one of the numbered buttons in the User Fields box.

Once you’ve defined the columns, pressing SHIFT when you click these buttons
displays the column numbers in the Column Selection box.

3 Enter a label for the field in the edit box.

This label (and related data) will appear in the Object Information dialog box and
can be added to extended labeling.

Databases with Multiple Object Types

Databases are normally created for only one object type—elliptical galaxies,
X-ray sources, and so on. This is not a limitation, because you can create and
load as many databases as you want. However, you might need to assemble
a database with multiple object types (such as the Herschel objects). This is
done by adding a data column that specifies the object type.

A file with multiple object types must meet the following requirements.

● The file can include no more than nine different object types.
● Each entry for an object with a non-default data type must include

a field with an identifier indicating its type.

Once you've created the text file for such a database, go through the steps
described in “Importing Databases.” When you’ve finished defining the
required/optional fields, and any user-defined fields, do the following.
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1 Drag the mouse cursor across the columns that represent the object type.

2 Click the Obj. Type button.

The Sky Database compiler now knows where to find the Object Type for objects
that aren’t the default type.

3 Click Advanced.

The Advanced Compile Options dialog box appears.

4 In the Object Type boxes, select the non-default data types you want.

If you’ve defined new object types, they are also available. (See page 127.)

5 Enter the Object Type Identifier in the corresponding edit box.

For example, if variable-star entries use ‘VS’ as their identifier, enter VS in the
adjacent edit box.

6 Click OK.

You’ve now told TheSky which symbol to display for each of these objects. If a
record doesn’t include one of the Object Type Identifiers listed in the Advanced
Compile Options dialog box, the compiler assumes it’s the default Object Type.

Multipliers

The Advanced Compile Options dialog box includes multipliers for the
following data items.
● RA
● Dec
● Mag[nitude]
● Major Axis
● Minor Axis
● Position angle

These normally need no adjustment. However, if a text database does not
use the “standard” units for these items, you’ll need to change the multiplier
to compensate. Multipliers can be greater than 1 or less than 1.

A multiplier is most-often used to correct the RA value. The default unit for
RA is hours. If the database expresses RA in degrees, the RA multiplier must
be set to 1 ⁄15 (0.06666667).
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Exporting User Data to a Database

Chapter 12 explains how to add User Data to the Virtual Sky. User Data is
stored in Sky Documents, and is unique to each document. If you wanted
the same User Data to appear in more than one Document, you’d have to
manually add it to each one. This is inconvenient and time-consuming.

The solution is to export User Data as a text database file, then compile it.
It can then be displayed (or hidden) as you like, regardless of which Sky
Document is loaded.

1 Add whatever User Data you want to the Virtual Sky.

You can only export data of a single type. However, there is no preset limit
to how many databases can be loaded and displayed at one time.

2 Save the current Sky Document under a new name.

This prevents loss of your work and lets you modify the user data without
having to reenter it.

3 Select the Add User Data command from the Data menu.

Or press ALT+U (zU on the Macintosh). The Add User Data dialog box appears.

4 Click Browse.

The Save As dialog box appears. The default folder is user\exported user data .

5 Type a name for the database file. Click Save As.

If the file already exists, the User Data is appended to the file. You can use this
feature to quickly combine existing User Data from several Sky Documents.

6 Type an (optional) comment in the Comment edit box.

If you create more than one User Data database, the comment helps identify them.

7 If the User Data contains multi-segment lines, and you want them converted
to polygon fills, mark the “As Polygons” checkbox.

If the start and end points of a multi-segment line don’t match, the compiler silently
changes the end coordinates of the last segment to the start coordinates of the first.

8 Click Export. The Verify dialog box prompts “Remove the Data?”

Click No to keep the User Data in the current Sky Document. This is the safe
response, since you can always go back and remove it manually.

Click Yes to delete the User Data in the current Sky Document. This is the usual
response, because you don’t want the data displayed twice.

9 Click OK to exit.

The database text file you’ve just created has a default Identifier of “User
Data,” which is displayed in the Sky Databases list. If you create only one
user-data database, this isn’t a problem. But if you create more than one
database, they’ll all have the same name, making it difficult to tell which is
which. You might, therefore, want to edit the database text file and change
the >IDENTIFIER entry to something more descriptive than “User Data.”
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Now you can compile the database.

1 Select the Import command from the Data menu.

Or press ALT+C (zC on the Macintosh).The Import dialog box appears.

2 Click Browse.

The Open dialog box appears.

3 Find and highlight the database file you just created. Click Open.

Or just double-click on the name. You’re returned to the Import dialog box.

4 Mark or clear “Horizon-based coordinates” and “Load to memory” as required.

5 Click Compile.

Because TheSky created the database file for you, it includes a header that defines
the correct format. You don’t have to define the fields or do anything else.

6 When compilation ends, you are prompted “Add to Auto Load Database List?”.

Since you usually want this User Data to be immediately available when TheSky
runs, select Yes. If not, select No.

7 Click OK to exit.

The objects in the new SDB should be displayed immediately. If not, check
that the database appears in the Sky Databases list (of the Sky Database
Manager dialog box) and is active (its checkbox is marked).

The Reference Point and Reference Line checkboxes of in the Filters dialog
box must be marked, as must those of any other object types in the SDB.

Export Restrictions

Exported User Data can be of only one type (Objects/Points, Labels, or
Reference Lines). If your Sky Document includes more than one type, the
exported text database will specify the data type of the first item in the Add
User Data dialog box list. Objects of other types will not be displayed.
Although this might be inconvenient, it is not a limitation, since you can create
and load as many user-created databases as you want.

Creating Object Symbols

TheSky includes symbols for only those objects in its databases. If you add
an object for which there is no symbol (such as a gamma-ray burster), you’ll
need to create a symbol for it.

1 Select the Preferences command from the View menu.

Or press ALT+P (zE on the Macintosh). The Preferences dialog box appears.

2 Click Add.

The Add Celestial Object dialog box appears.
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3 Type a description in the edit box.

The description must be unique—it must not duplicate any name in the Object
Descriptions list box.

4 Click OK.

The description is added at the end of the Object Description list.

You now have a “blank” object symbol, waiting to be defined. Set the Font,
Line, and Fill as you would for any other object. Click Symbol, then Edit, to
draw a bitmap symbol for the Virtual Sky, or select a Windows Metafile (or
Macintosh PICT file) for printing. (See Chapter 11, “Customizing the Display
with Preferences.”)

User-created object types have index numbers starting with 60. See page 190
for a list of object-type index numbers.

Deleting a User-Created Object

A user-defined object can be deleted at any time. Select it in the Object
Description list, then click Remove. You are prompted to respond Yes
to delete it, No to keep it.

The objects that come with TheSky cannot be deleted.
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16 Image and Multimedia Databases

TheSky’s database has photographs of many celestial objects. You can create
databases for your own photos or images, and TheSky will display them, too.
TheSky recognizes more than 30 image formats, so you can display almost
any kind of picture. You can also assemble your own multimedia databases
of text, images, sounds, and movies.

Activating Additional Image Databases

As shipped, TheSky is set up to display Solar System images and the Anglo-
Australian Observatory photos. If you want to activate other photo databases
(such as the Hubble images), follow the steps below.

1 Select the Sky Database Manager command from the Data menu.

The Sky Database Manager dialog box appears.

2 Click Add/Remove Databases

The Add/Remove Sky Databases dialog box appears.

3 Use the browsing controls to go to the Pictures folder on the CD ROM.

Five sub-folders have pictures: Aao, Hubble Icthumb , Ngcthumb , and
Solarsys .

4 Double-click the name of one of these directories.

The .SDB file in the sub-folder appears in the upper list box.

5 Highlight the filename and click the Add button.

The file is added to the File List.

6 To select additional databases, repeat Steps 4 and 5.

7 Click OK.

The Sky Database Manager dialog box returns. The added databases appear in the
Sky Databases box and their checkboxes are marked to indicate they are active.

8 Click OK to exit.

Image symbols (35mm SLRs) in the Virtual Sky mark objects that have items
in image databases. TheSky is shipped with these symbols displayed. If they
aren’t visible, open the Filters dialog box and mark the Images checkbox.



Displaying Pictures

There are four ways to display pictures.

● Click on an Image symbol in the Virtual Sky.
● Select the Multimedia tab in the Object Information dialog box.
● Use the Show Picture command from the Tools menu.
● Use the Slide Show command from the Tools menu (Windows).

Image Symbols

Clicking on a camera symbol displays the image associated with it. (Press
SHIFT when you click to display the Object Information dialog box instead.)

The image appears in a separate window, scaled to the image’s native
resolution. Drag the borders of the window to make the image larger or
smaller. Bitmapped images are made of discrete pixels, so they’ll look
“blocky” if they’re enlarged too much.

To hide the Image icons, open the Filters dialog box and clear the Image
checkbox. To disable an image database, open the Sky Database Manager
dialog box and clear that database’s checkbox.

Multimedia Tab

You can always view the images associated with an object, whether or not
the Image symbol is displayed. When you click on an object for which there
is at least one image in an active image database, the image is displayed on
the Multimedia sheet of the Object Information dialog box. If more than one
image is available, select the one you want from the list box.

Show Picture Command (Tools menu)

Select the Show Picture command from the Tools menu. In the Open dialog
box, select the image type (most popular—and even some not-so-popular—
formats are available). Use the browsing controls to find the file you want.

Highlight the filename, then click Open. (Or just double-click on the name.)
The picture appears in a separate window, scaled to the image’s native
resolution. Drag the borders of the window to make the image larger or
smaller. Bitmapped images are made of discrete pixels, so they’ll look
“blocky” if they’re enlarged too much.
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Slide Show Command (Tools menu)

Under Windows, you can create a “slide show” of images, and run the show
automatically or manually. You can choose which images are shown and the
order in which they’re presented.

1 Select the Slide Show command from the Tools menu.
Select Create List from the flyout menu.

Or press SHIFT+C. The Create Slide Show List dialog box appears.

2 Use the browse controls to find the image file you want. Highlight it.

You can select more than one file. To select a range of files, click on the first,
then press SHIFT as you click on the last. To select (or deselect) specific files,
press CONTROL as you click.

3 Click the Add button to add the file to the Slide Show List box.

As images are selected, they are added at the end of the Slide Show List.
They are displayed in the order they appear in the List. An image can appear
in the Slide Show List as many times as you like.

4 Repeat Steps 2 and 3 to add more image files.

To remove an image from the Slide Show List, highlight it, then click Remove. If no
files are highlighted, clicking Remove deletes all of them. If you change your mind
about the deletions, click Cancel to exit without removing the images from the list.

5 When the Slide Show List is complete, click OK.

You can open the Create Slide Show List dialog box at any time to modify
the Slide Show List. The list is automatically saved between sessions, in the
file browse.lst . You might want to back it up.

The default operation of the slide show is manual—select Forward or
Backward from the flyout menu to show the next or the previous image.

For automatic display, click Options and mark the “Automatic Browse”
checkbox in the Slide Show Options dialog. In the “Seconds image is
displayed” edit box, enter a value from 1 to 120 seconds (or click the spin
buttons). The display time does not include the time it takes to load the file.
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To start the slide show, select the Slide Show command and choose Forward
or Backward from the flyout menu. (When Automatic Browse is selected,
the Slide Show can only run Forward.) When the bottom (top) of the Slide
Show List is reached, the show starts over from the top (bottom).

The picture appears in a window scaled to the image’s native resolution.
Drag the borders of the window to make the image larger or smaller.
Bitmapped images are made of discrete pixels, so they’ll look “blocky”
if they’re enlarged too much.

To stop the slide show, press ESC. You are prompted to quit or continue.

Creating Your Own Image Databases

Creating your own image database is not difficult. You create a text file that
gives the filenames of the images, and the sky coordinates at which you
want the Image symbol to appear. You then compile the text file and put the
resulting Sky Database (.SDB) file in the same directory as the pictures.

If the database is then loaded and made active, and the Image checkbox in
the Filters dialog box is marked, image symbols (cameras) will appear in the
Virtual Sky at the coordinates given in the database. When you click on a
symbol, the associated image is displayed.

The following is a brief overview of the process. Chapter 15, “Custom
Databases,” has a complete explanation of how to create Sky Databases.

The text file needed to create the database has a simple format. Here’s a
sample. (It’s the first 10 lines from the Anglo-Australian database.)

0.40167h 00m 00s 72.08333d 00m 00s S NGC0104.GIF
0.79333h 00m 00s 25.28333d 00m 00s S NGC0253.GIF
0.91500h 00m 00s 37.68333d 00m 00s S NGC0300.GIF
0.91500h 00m 00s 37.68333d 00m 00s S NGC0300.GIF
3.30500h 00m 00s 66.50000d 00m 00s S NGC1313.GIF
3.56000h 00m 00s 36.13333d 00m 00s S NGC1365.GIF
3.76333h 00m 00s 24.36667d 00m 00s N NGC1432.GIF
3.76833h 00m 00s 23.78333d 00m 00s N NGC1435.GIF
4.33333h 00m 00s 54.93333d 00m 00s S NGC1566.GIF
5.59000h 00m 00s  5.45000d 00m 00s S NGC1976.GIF

Each record in an image database needs only four entries—right ascension,
declination, declination hemisphere, and the name of the image file. When
an image database is loaded and made active, the Image symbol (the 35mm
SLR) is displayed in the Virtual Sky at the RA-Dec coordinates given.

In Version 5, you can add a fifth entry that specifies the common name or
catalog number of the sky object the image file is to be associated with. (The
number must appear in a loaded, active catalog, or the association will fail.)

● If you do not specify a sky object, the image file can be accessed only
when the Image symbol is displayed (that is, the Image checkbox in the
Filters list is marked).
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● If you do specify a sky object, the image file is listed on the Multimedia
sheet of the Object Information dialog box—whether or not the Image
symbol is enabled—and can be viewed by clicking on its name.

You’ll probably want to specify the object, since it lets you access the image
(or other multimedia file) without having to clutter to the Virtual Sky with
additional symbols. To use this feature:

1 Add the objects’ names or catalog numbers to the text database.

2 In the Field Definition dialog box, select the columns with the catalog number.

3 Click the Alias button.

That’s it.

No path is given for the image file, because TheSky assumes the file is in the
same folder as the database (.SDB) file. If it can’t find the image file there, it
looks in the pictures folder. This search is intended only as a “fail-safe.”
You should try to keep images and their database file in the same folder.

Once the database text file is complete, you can select Import from the Data
menu, then load and compile it, as you would any other database.

The new images are now part of TheSky’s database. If you open the Sky
Database Manager, you should see the database’s Identifier in the Sky
Databases list box.

Creating Other Types of Databases

TheSky supports other multimedia types. You can create databases of the
following multimedia object, in exactly the same way you create them for
images.

● Notes (.TXT or Macintosh text files)
● Sound (.WAV or Macintosh sound files)
● Video (.AVI or .MOV files)

For example, a notes database can contain observational notes for planets or
variable stars. A sound database might include radio noises from the Sun.
A video database might have videos of Shoemaker-Levy impacting Jupiter.

These databases have the same format as Image databases. If you insert a
Header in the database text file, remember that the Object Type is 41 for
Image, 42 for Video, 43 for Sound, and 44 for Notes.

When the corresponding checkbox in the Filters dialog box is marked, the
icon for each object type appears at the specified coordinates. Clicking the
icon presents the object (as text, sound, or video). If you want the database
objects to be available even when the symbols aren’t displayed, include an
“alias” specifying the name or catalog number of the associated sky object.

If you don’t want these icons to clutter the Virtual Sky, hide them by clearing
their checkboxes in the Filters dialog box. Or use the Sky Database manager
to deactivate those databases you don’t want to use.
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Using TheSky to Help You Create Image, Notes, Sound, or Video Databases

When creating your own Image, Notes, Sound or Video database, you might
not look forward to typing in a lot of data. Fortunately, TheSky’s Export User
Data feature can do most of the work of creating the text data file.

1 Decide what type of database you want to create.

An exported user data file can be of only one object type.

2 Create a new Sky Document without any user data.

3 Select Add User Data from the Data menu.

Or press ALT+U (zU on the Macintosh). The Add User Data dialog box appears.

4 Select the Objects/Points data class.

5 Select the Image, Video, Sound, or Notes object type.

6 If you want to place points exactly on stars or deep-sky objects,
select Snap To Nearest Star or Snap To Nearest Non-Stellar.

7 Click Close.

8 CONTROL+click ( z+click on the Macintosh) in the Virtual Sky where
you want to place the database objects.

9 Open the Add User Data dialog box again.

10 For each point, enter the associated file name in the Label edit box.

For example, saturn.gif , apollo.avi , marceau.wav , or ur.txt .

11 Click Browse. Enter a name for the file the user data will be exported to.

12 Click Save.

13 Click Export.

14 Click Close.

You should see the points and their labels in the Virtual Sky.

15 Save the current Sky Document under a new name.

Saving the user data lets you can modify it later without having to reenter it.

16 Select Import from the Data menu.

Or click ALT+C (zH on the Macintosh). The Import dialog box appears.

17 Click Browse and load the text database file you just created.

18 Click Define Fields.

19 Highlight the field with the file names, then click File Name.

This is the “trick”—you enter the file name as a Label (where it’s placed at the end
of the record), then redefine it as a File Name.

20 Click OK, then Compile.

If you want the multimedia files to be accessible from the Multimedia sheet
of the Object Information dialog box, you must add to each record the
common name or database identifier of the sky object you want to associate
with the multimedia file in that record. This requires manual editing of the
database text file.
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Associating Sounds with Events in TheSky

Version 5 lets you associate sounds with specific events in TheSky. You can
use these “just for fun” (”Good morning, Dave…”), or to provide audible
reminders (such as announcing that slewing has aborted).

Windows Sounds

To see which events are supported in Windows, open the Control Panel and
double-click Sounds. As you scroll down the Events list you'll come to a
section labeled “Sky.” The events are listed alphabetically. Most are self-
explanatory; some need a bit of explanation.

● Background is played at random times, to provide ambiance.
As shipped, it’s a cricket chirping.

● End is played when you exit TheSky.

● Identify is played when you click within the Virtual Sky.

● Image Link is played when a successful Image Link match is made.

● Start is played when TheSky starts running.

To create an association between an event and a .WAV file:

1 Open the Control Panel

2 Double-click Sounds.

The Sounds Properties dialog box appears.

3 Find the event and highlight it.

Events already associated with sounds have a speaker symbol next to them.

4 Type the full path of the .WAV file in the Name edit box.

If you don’t know the path, click the Browse button to search for the file. Or click the
arrow on the edit box to select from .WAV files in the windows\media directory.

5 Click Apply to make the association.

Click Cancel to quit without making the association.

Macintosh Sounds

The Macintosh uses sounds recorded in QuickTime™ format. The following
sound files are associated with the given events.

● Start.mov and End.mov are played when TheSky starts and terminates.

● Background.mov is played at random times.

● Identify.mov is played when you click in the Virtual Sky.

● ImageLink.mov is played when a successful Image Link match is made.

● SlewStart.mov , SlewEnd.mov , SlewDuring.mov , SlewAbort.mov are played
when slewing starts and ends, during slewing, when slewing aborts.

● TelescopeEstablish.mov , TelescopeSuspend.mov , TelescopeTerminate.mov
are played when the telescope link is established, suspended, terminated.
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The events are associated with sound files having the names given above.
You can disable a sound by renaming its sound file, or by moving that file
out of the sounds folder.

To change a sound, you need to rename the new sound’s file to the name
TheSky expects, then move it to the sounds folder. If the file is not in the
QuickTime Movie (.MOV) format, use the QuickTime “Movie Player” to
convert it, then save it as a QuickTime Movie.

The QuickTime Movie format was chosen for sounds because it supports a
wide variety of sound files, including MIDI files and MPEG soundtracks.
This greatly expands the range of sounds you can associate with events.
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17 Image Link Overlays

The Image Link™ function makes it possible to add CCD images or scanned
photographs to the Virtual Sky. The image exactly overlays the display—
stars and galaxies in the image line up precisely with the corresponding
objects in the Virtual Sky.

Image Link also works with the Digitized Sky Survey, in either high- or low-
compression format. Using RealSkyView (supplied with the RealSky edition
of the DSS) to extract the image, TheSky can automatically create an Image
Link overlay for an area of the sky of up to about 1° square.

Image Link turns your CCD and photographic images into interactive star
charts. Objects in the image can be viewed, labeled and identified, just as if
they were part of the Virtual Sky.

Under Windows, you can also link unaligned images to the Virtual Sky,
as OLE objects that can be updated or edited without exiting TheSky.

Inserting the Image to be Linked

The image must be inserted before it can be linked to the Virtual Sky. Only
one image at a time can be linked.

1 Select Pole Up orientation.

Or clear the “Use computer’s clock” checkbox. Either keeps the Virtual Sky from
updating and shifting as you the link the image.

2 Set the field of view to 50° or less.

Linked images are only displayed at field widths below 50°. The projection
automatically switches to orthographic, which is required when linking images.

3 Move the Virtual Sky to the part of the sky where the image was taken.

Try to get as close a match as possible. Use the zoom function from the Find dialog
box to get exactly the field width you need. Use the Rotate Tool to adjust the angle
of the Virtual Sky. When scrolling, press CONTROL+SHIFT (SHIFT+z on the Macintosh)
to make fine adjustments.

4 Use CCDSoft ™ to copy the image to the Windows Clipboard.

If you don’t have CCDSoft, load the bitmap (.BMP) image into a paint program
(such as MSPaint or the QuickTime Picture Viewer), and copy it to the Clipboard.

Under Windows, only 8-bit grayscale bitmapped images can be used to perform
a link. If the image is in color, it must be first converted to 8-bit grayscale. On the
Macintosh, you can use any image; it will automatically be converted to grayscale
when pasted. Under either operating system, you can link with the grayscale image,
then paste the color image over it.

5 Use the Paste command from the Edit menu to insert the image.

Once the image is inserted, there are two ways to align it with the Virtual
Sky. Object Dragging uses manual adjustment. Under Windows (Level IV),
the Link Wizard uses pattern recognition to align the image automatically.



Linked images are not permanent. When you exit TheSky, the linked image
is removed from the Virtual Sky.

Aligning Automatically with the Link Wizard (Windows Level IV)

Under Windows, the Link Wizard uses an advanced pattern-recognition
algorithm to align the underlying object data in the Virtual Sky with the
digital image. The Link Wizard has performed successfully on thousands of
CCD images, with fields of view ranging from 8 arc-minutes to over 30°.

Image Requirements

For the Link Wizard to do its job, the image should meet the following
requirements.

● Minimum Size

The image should be at least 100 pixels on a side—preferably larger. Small
images contain fewer objects, making pattern recognition more difficult.

● 1:1 Pixel Aspect Ratio (“square” pixels)

Scanned photographs always have a 1:1 ratio, as do most CCD images.
Those that aren’t 1:1 must be rescaled. Use the Resample command from
CCDSoft, or a paint program with a resampling function.

● White Stars

The image must be “positive”—white stars on a black background. In CCD
terms, this means “high” pixel values for stars, “low” for the background.

● Minimum Number of Stars

The image must have at least six well-defined stars that appear in the Tycho,
Hipparcos, or GSC catalogs. Since most images are at least 10 arc-minutes
wide, and the GSC goes to 15th magnitude even in “sparse” areas of the sky,
this requirement can almost always be met. An image narrower than 10 arc-
minutes might not have enough stars for automatic alignment.

Image Link Setup

The Image Link Setup dialog box has several optional settings that can make
it easier for the Link Wizard to find a match. To display this dialog box,
select the Image Link Setup command from the Image Link flyout, or click
the Image Link Setup button in the Image Link toolbar.
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The “Show … frame” checkboxes are useful when making your initial rough
alignment. If “Show image frame” is marked, the borders of the CCD image
are shown in the Virtual Sky. This makes it easy to distinguish the image
from the background of the Virtual Sky.

When “Show telescope frame” is marked, the Link Wizard computes the
area covered by the CCD and displays it as a rectangle in the Virtual Sky.
You can then determine what will fall in its field before taking a picture.

If the Link Wizard knows the scale factor of the CCD—how many arc-
seconds of the sky each pixel represents—it can scale the Virtual Sky to
exactly match the image’s magnification. To calculate the scale factor:

1 Calculate the field of view of the CCD.

The Compute function in the Add Field of View Indicator dialog box can calculate
the field of view for you.

2 Convert the field of view to arc-seconds.

Multiply degrees by 3600 and arc-minutes by 60 to get arc-seconds.

3 Divide that result by the number of pixels along one side of the CCD chip.

This gives the field of view of a single pixel. Don’t round off the answer.

4 Click the “Known scale” radio button and enter this value in the edit box.

Fractional values of up to two decimal places are okay.

Once you’ve entered the scale factor, you can limit the area over which the
Link Wizard searches. Enter a Search Radius between 1 and 10 arc-minutes.
Start with a value about twice the width of the CCD image.

Running the Link Wizard

Once the image has been inserted, select Image Link from the Tools menu,
then Link Wizard from the flyout. (Or click the Link Wizard button.)

If the image meets the requirements listed above, and the Virtual Sky shows
essentially the same area as the image, the Link Wizard should find a match
almost immediately.

The single most important factor in getting a quick, accurate match is setting
the Virtual Sky’s zoom factor and rotation so that the display closely matches
the image. The following suggestions should help you do this.

● If you know the catalog number of one of the stars (or galaxies) in the
image, use the Find dialog box to locate it. Then use the arrow keys to
put the center of the Virtual Sky near the center of the part of the sky
shown in the image.

● The field width of the Virtual Sky should be no more than twice the field
width of the image. The less area the Link Wizard has to search, the more
easily it can find a match. (In Version 5, the Link Wizard can now find
matches outside the current field of view, over a field up to 2° square.)
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You might find it useful to create a FOVI that matches your CCD sensor’s
(or camera’s) field of view. (If the sensor has non-square pixels, the FOVI’s
dimensions must be scaled to compensate.) Adjust the field width so the
entire FOVI is visible, and positioned near the edges of the Virtual Sky.
(See page 67 for information on creating and using FOVIs.)

● Use the Rotate Tool to match the Virtual Sky’s orientation to the image.
If you set the Virtual Sky’s orientation to Pole Up, and orient your images
and CCD photographs so that North is at the top and East is to the left,
you won’t need to rotate the Virtual Sky for a match.

These adjustments don’t have to be exact—the idea is to quickly “rough in”
the settings. This leaves the hard work for the Link Wizard. It does the
“fiddly bits”—adjusting the field width, screen coordinates, and rotation so
the Virtual Sky exactly lines up with the image.

As the Link Wizard searches for a match, a progress bar marks its activity.
If the Link Wizard doesn’t find a match on the first pass, it makes up to six
more passes over progressively smaller sections of the Virtual Sky.

Once a match is found, the Link Wizard sets the Image Link display mode to
Transparent, so you can easily confirm the match is correct. Clicking
anywhere within the image displays the Object Information dialog box with
link information.

No Match?

If the Link Wizard can’t find a match, or makes an invalid match, check that
the Virtual Sky is centered on the image area. You might need to adjust the
magnification and rotation to more closely align with the image.

If the Link Wizard can’t align the image, you can still perform a manual
alignment. If you can get close with manual adjustments, the Link Wizard
can then (usually) complete the alignment. (Manual alignment is explained
in a following section, “Aligning Manually with Object Dragging.”)

Adjusting the Appearance of the Linked Image

The linked image is displayed or hidden by selecting the Display Image
command from the Link Image flyout menu, clicking the Display Image
button in the Image Link toolbar, or pressing I (I or zI on the Macintosh).

You can scroll or zoom the Virtual Sky while an image is linked. This
suspends (but does not remove) the link. To restore the link, press I
(I or zI on the Macintosh). The Virtual Sky returns to the coordinates of the
image, and the image is redisplayed at the previous field width.

The Image Link Setup dialog box has several useful controls. To open it,
select the Image Link Setup command from the Image Link flyout, or click
the Image Link Setup button in the Image Link toolbar.

● When the Link Wizard achieves a match, it automatically marks the
“Image is Linked” checkbox. If you clear this checkbox, the link is lost,
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and the image remains centered in the display regardless of how the
Virtual Sky is scrolled or oriented.

● When the Transparent radio button is clicked, stars are visible through
the linked image. Their values are reversed—white stars are black dots—
to keep them visible. When the Opaque radio button is clicked, stars are
hidden by the linked image.
Deep-sky objects such as galaxies and nebulae behave differently. Their
Transparent/Opaque behavior interacts with the Non-Stellar Fill setting
in the Options dialog box.

✴ When Color is selected, deep-sky objects always cover the
corresponding objects in the image.

✴ When Transparent or Transparent When Image Is Present is selected,
deep-sky objects are not filled with their Fill colors, and the image is
fully visible. Choose according to whether you want deep-sky objects
filled when no image is linked.

Examples of how these settings affect the Image Link display are shown
below.

Transparent, Color Transparent, Transparent

Opaque, Color Opaque, Transparent
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● To adjust how much of the Virtual Sky is visible, change the Image Size
in the Image Link Setup dialog box. By default, this value is 100%.
Picking a smaller value (down to 20%) shows more of the Virtual Sky.

Aligning Manually with Object Dragging

While you are performing a manual alignment, you have to make decisions
about which patterns in the image correspond to patterns in the Virtual Sky.
The closer the image is to matching the magnification and orientation of the
Virtual Sky, the less trouble you’ll have finding a match. A little extra time
spent in adjusting the Virtual Sky will pay off in a quick alignment.

Once the image has been inserted:

1 Select the Image Link command from the Tools menu.
Choose Setup from the flyout menu.

Or click the Image Link Setup button in the Image Link toolbar. The Image Link
Setup dialog box appears.

2 Click the Transparent radio button so the image won’t hide the Virtual Sky.

You need to see both to align the image.

3 Click OK.

4 Look for stars in the image that match stars in the Virtual Sky.

Try to find two stars, preferably on opposite sides of the image. Press I (I or zI on
the Macintosh) to toggle the image on and off—“blinking” makes it easier to see
patterns.

5 While pressing SHIFT, click on one of the stars and drag the mouse cursor
to the matching star in the image.

Drag from the star in the Virtual Sky to the star in the image (not the other way).
A green “destination arrow” is drawn to show the direction in which the Virtual Sky
will be repositioned.

6 Repeat for the second star.

A second “destination arrow” is drawn.

You can’t draw more than two arrows at one time. But you can repeat the alignment
as often as you want, with any stars you choose.

7 To accept the adjustment, left-click in the Virtual Sky.
To discard it, right-click ( CONTROL+click on the Macintosh) in the Virtual Sky.

The Virtual Sky will be resized, repositioned, and rotated (as required) to match the
linked image.

You don’t have to use two stars, but lining up a single star rarely produces a
complete match. But it might sufficiently improve the match to reveal
additional matching star patterns.

If the match isn’t as good as you’d like, you can repeat the dragging as many
times as you want. Or you can run the Link Wizard to complete the match.
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An Example for You to Try

If you have the North or North&South RealSky CD ROMs, you might want
to try aligning M2.

1 Use the Find command to locate and center M2.

2 Set the field of view to 1°.

3 In RealSkyView , open ngc.lst and view NGC 7089 (M2).

Note the two bright stars at RA 21h32m49.5s, Dec 00d52m57s and
RA 21h32m56.2, Dec 00d54m47s.

4 Copy the NGC 7089 image to the Clipboard.

5 Paste the image into the Virtual Sky.

6 Locate the two bright stars at the coordinates given in Step 2.

7 While holding down SHIFT, drag a line from each star in the Virtual Sky
to the matching star in the image.

8 Click anywhere.

You should get perfect or near-perfect alignment.

Creating an Automatically Linked DSS Image

If you have the RealSky disks, and RealSkyView is installed, TheSky can create
a linked DSS image for you, automatically. (TheSky uses the RealSkyView
program that comes with RealSky to extract the image.)

1 Set the Virtual Sky to Pole Up orientation.

2 Center the object or the part of the sky you want to create a linked image for.

The field of view doesn’t matter—TheSky will adjust it automatically.

3 Select Create DSS Image from the Image Link flyout menu.

Or click the Create DSS Image button in the Image Link toolbar.

4 You are prompted for one of the RealSky disks. Load it and click OK.

The “No image found to extract” message means you don’t have the CD ROM with
data for the part of the sky you’ve chosen. (If you have both the North and South
RealSky sets, you have a complete set of data and you’ll never see this message.)

To use 102-CD set of low-compression disks, the “Low Compression” checkbox
in RealSkyView’s Digitized Sky Survey Setup dialog box must be marked.

5 The image is extracted. You are prompted to reload TheSky’ s CD ROM.

If all TheSky’s databases are on the hard disk, you aren’t prompted.

6 The linked image is displayed.

That’s it. The Image Link Setup controls work just as they do for manually
inserted images.

To modify the DSS image, select Edit DSS Image from the Image Link flyout.
(Or click the Edit DSS Image button in the Image Link toolbar.) RealSkyView
runs, with the image loaded.
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Attaching an OLE Object to the Virtual Sky (Windows)

Under Windows, OLE objects can be attached to the Virtual Sky. When you
save the currently loaded Sky Document, the object is saved with it. Each
Sky Document can have a unique set of OLE objects.

1 Select the Insert New Object command from the Edit menu.

The Insert Object dialog box appears. The Object Type box lists all the registered
OLE applications on your system.

2 To create a new object:

a Click the Create New radio button.

b Select the Object Type from the box. Click OK.

The application associated with that file type runs within the Virtual Sky.

c Create the file or image.

d Select Save from the File menu to save the new object, along with the currently
loaded Sky Document.

3 To attach an existing file as an OLE object:

a Click the Create From File radio button.

b Enter the full pathname of the file, or click Browse to locate it.

c Mark the “Link” checkbox if you want the Sky Document to be updated
when the object changes.

The attached file can be edited at any time by double-clicking on it. The
associated application automatically runs, and you can modify the file
without exiting TheSky.
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When you’ve completed the edits, select Save from the File menu. Then click
anywhere outside the edit box to remove the edit box and return to the
normal display.

An attached object can be dragged anywhere on the screen. Its position is
fixed with respect to the main window (not the contents of the Virtual Sky).
Scrolling or zooming has no effect on its position or size.

Objects are normally displayed directly. If you mark the “Display as Icon”
checkbox when you create an object, the object is replaced with the icon of
the application associated with objects of that type. You can also mark or
clear this box to change the display mode of an existing object.

To delete a linked object, click on the object. Then select Delete from the Edit
menu. (Or press DELETE.) You are prompted to confirm the deletion.
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✍ NOTES
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18 Time Skip Animation

Time Skip animation can simulate the motion of Solar System bodies, letting
you observe their behavior over time. It can also update the Virtual Sky at
selected intervals of a fraction of a second to hundreds of years. All the
following activities—and more—are possible.

● Watch the proper motion of stars over hundreds of years.
● View the retrograde motion of the outer planets.
● Watch Solar eclipses and occultations.
● Plot comet and minor-planet paths.
● Watch a constellation rise or set.
● Create the Sun’s analemma.

The figure below is a Time Skip animation of the retrograde motion of Mars.

Orientation and Animation

The Virtual Sky’s orientation has a significant effect on Time Skip animation.
If Pole Up is chosen, the sky background remains stationary and only Solar
System objects move. All objects are displayed.

If Zenith Up is chosen, both the star background and the selected object
move. (However, if the skip interval is a sidereal day (23 hours, 56 minutes,
4 seconds), the background stars do not move. This is because, with respect
to Alt-Az coordinates, the star pattern repeats each sidereal day.) All objects
are displayed in Zenith Up—except when the Record Trails button is
depressed. Then only Solar System objects and the Local Horizon are shown.

The Pole Up display can be strikingly beautiful, with the background of
stars moving against a “locked” planet or comet at the center of the display.
The Zenith Up display runs faster, and (when Record Trails is selected) the
screen is uncluttered.



Setting Up a Simulation

A Time Skip simulation must be set up before you can run it.

1 Select the appropriate display orientation, as explained above.

2 Select Site Information from the Data menu.

The Site Information dialog box appears.

3 Click the Location tab and pick the Earth coordinates you want to view from.

4 Click the Date and Time tab and choose the starting time.

Mark the “Use computer’s clock” checkbox to start simulations at the current time.

If you want to start at a specific date and time, clear the “Use computer’s clock”
checkbox, then enter the date and time you want.

5 Select the Time Skip command from the Tools menu.
Select the Tracking Setup command from the flyout menu.

Or click the Tracking Setup button in the Time Skip toolbar. The Solar System
Tracking dialog box appears.

6 Mark the checkboxes of the objects you want to watch.
Clear the checkboxes of those you don’t want to watch.

For example, you’d select the Sun and Moon to observe a solar eclipse. You’d
select Uranus to view its retrograde motion or watch it occult a star.
Don’t select objects you don’t want to view. It slows down the simulation and clutters
the display (especially if you’re plotting trails).
Selecting Comets or Minor Planets runs Time Skip simulation for all the comets or
local minor planets currently displayed. Open the Comets and Minor Planets dialog
box and disable the ones you don’t want to view.

7 In the Lock On box, choose which object you want the simulation to track.

Not Locked leaves the Virtual Sky at its original position and field of view. The object
might move off the screen. Locking on an object keeps the object at the center.

All selected items are listed in the box. If you chose Comets or Minor Planets, the
names of all non-Extended objects currently viewable in the Virtual Sky are shown.

8 In the Trails box, select the kind of trails you want the moving object to leave.

Object Trails leaves copies of the object’s bitmap symbol.

Dot Trails leaves a series of dots.

Connected draws a series of lines connecting each simulation event.
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Using Connected requires a Preference change. In the Object Description list of the
Preferences dialog box, select the objects or Object Types you’re tracking. Click
Line, then change the color to something other than black. The lines are now visible.

TheSky can record about 500 trail objects, divided among all items being tracked.
If you’re following 25 minor planets, the 500 will be quickly exhausted. Keep this in
mind when tracking many objects, or a single object for a long period of time.

9 Click OK to accept the settings.

If you locked on a specific object, the Virtual Sky is repositioned with that object at
the center. If you select Not Locked, no change occurs. If the object isn’t visible, use
the Find command to locate and center it.

10 If you want the object’s trails to be visible, select Record Trails from the Time
Skip flyout menu.
Or you can click the Record Trails button in the Time Skip toolbar. The button
remains “down” to show that Record Trails is selected.
When you’re in any of the Zenith orientations, everything but Solar System objects
is removed from the Virtual Sky when you select Record Trails.

11 Select Set Increment from the Time Skip flyout menu.

The Time Skip Increment dialog box appears. Or you can enter the increment in the
Time Skip toolbar’s edit box. (If the toolbar is “vertical,” click the Increment button.)

12 Select the desired increment from the combo box. There are eight choices.

● one second
● one minute

● one hour
● one day (one diurnal day—24 hours)

● sunrise

● sunset
● 23h56m04s (one sidereal day)
● 27d7h43m15s (one synodic period)

Choose any of these, or enter any value you want. Type the time value, followed
by the letter representing the time unit—d for days, h for hours, m for minutes,
s for seconds. Case doesn’t matter.
Fractional values—like 2.4d —are okay. You can also combine units. Seven days,
four hours, six minutes, and two seconds is entered as 7d 4h 6m 2s .

You can modify default values by adding + or – values to the defaults. For example,
you can type –10m after the Sunset default: Sunset – 10m .

13 For faster updates, turn off any labels, especially if you’re recording trails.

You might also want to turn off the Ecliptic, Meridian, and Grid lines. Once the
simulation is complete, you can restore these without erasing the simulation.

You’re now ready to run the simulation.
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Running the Simulation

Select the Time Skip command from the Tools menu. Pick the speed and
direction from the flyout menu. The simulation can run forward or
backward, in single steps or continuously.

These controls are also available from the keyboard. ALT+] and ALT+[
(z] and z[ on the Macintosh) step the simulation forward and backward.
ALT+> and ALT+< (z' and z; on the Macintosh) run the simulation forward
and backward. (You don’t need to press SHIFT with the > and < keys.)

To stop the simulation, select the Stop command from the flyout menu, click
the Stop button in the Time Skip tool bar, or press ESC. (You can also press z.
(period) on the Macintosh). If you recorded the simulation, the trail remains
on the screen. You can scroll or zoom the display without losing the trail.

To start over, select the Reset Date and Time command from the Time Skip
flyout menu. (Or click the Reset Date & Time button in the Time Skip tool
bar.) Any trail is erased, so be sure you really want to restart!

You can change any simulation parameter while the simulation is running.
You do not need to stop or reset. Simply select the Tracking Setup command
from the Time Skip flyout menu. You can also turn object-trail recording on
or off from this flyout.

What’s Visible?

If you Lock On to one of the objects you’re tracking, that object remains at
the center of the screen throughout the simulation.

If you select the Not Locked option, the Virtual Sky is not adjusted to show
all the selected objects. The Virtual Sky keeps its initial position and field
width throughout the simulation. If all the objects aren’t visible, you must
“zoom out” until they can be seen. You might also need to scroll the display
in anticipation of where the objects will move during the simulation.

Occultations

It’s easier to follow occulted objects if you can “see” them behind the Sun,
Moon, or planets. Select the Options command from the Data menu and
mark the “Translucent sun and moon” checkbox.

Scrolling and Zooming During Simulation

Virtually every command and feature of TheSky (including keyboard
shortcuts) are available while the Time Skip simulation is running. You can
scroll, zoom, turn reference lines on and off, even use the Find command,
without disrupting the simulation. The simulation might pause briefly while
TheSky performs calculations or redraws the screen, but it continues when
these are completed.

Any recorded trail remains intact, too. However, if you change the trail type,
the existing trail is erased.
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Using the Time Skip Toolbar

The controls needed to set up and run a Time Skip simulation are on the
Time Skip toolbar. If it’s docked at the top of the Virtual Sky’s window, you
might want to drag it off and reposition it at a more convenient location.

The button with the symbol of a cheap lady’s wristwatch (it’s supposed to be
Saturn with a “speed blur”) displays the Tracking Setup dialog box.

You can choose a skip interval from the combo box, or enter your own value,
using the single-letter abbreviations (d, h, m, s) for days, hours, minutes, and
seconds. The skip interval can be changed as you work. You can start with a
long interval to find an event, then switch to a short one to study it in detail.

The u and t buttons step the simulation forward and backward. The uu and
tt buttons run the simulation forward and backward. The button with the
black square is Stop. The button with the “CD eject” symbol resets the date
and time. (It also erases the trail, so be careful not to accidentally click it.)
The button with the red circle (“recording”) turns the trails on and off.

Dragging the Time Skip toolbar to the side of the screen changes it to vertical
format. The edit box is replaced with a “clock” button. Clicking the clock
button displays the Time Skip Increment dialog box.

Labeling Time Skip Animations

When the Record Trails option is selected, each trail object can have a
unique label attached to it. You can pause and add the labels during the
simulation, or wait until the simulation has run its course.

1 Click on the trail object you want to label.

The Object Information dialog box appears.

2 Select the trail object in the Object List.

Objects near the trail object also appear in the Object List. Trail objects
are prefixed with Skip Position, followed by the name of the object.

3 Select the Utility tab and click Time Skip Label.

The Time Skip Labeling dialog box appears.

4 Click the Left, Right, Above, or Below radio button.

This positions the label accordingly.

5 Click Add Date and/or Add Time to add these values to the label.

You can add your own comments, too. Clicking Clear erases the Label box.
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6 Click OK.

The label is added next to the trail object. Click Cancel to exit without adding
a label, or changing the existing label.

To label the full path with dates at the selected interval, click “Add every.”
To label with times, click Clear, then Time. To label with both times and
dates, click Clear, Time, Date. An interval of 0 removes the labels.

Labels can be changed. Click on the trail object, click Time Skip Label, then
edit the label and click OK.

Time Skip Examples

Here are two non-trivial examples that show how to use Time Skips. Both
are given in a “terse” form that describes the setup, but doesn’t go through
such details as selecting commands or closing dialog boxes.

Example #1: July 11, 1991 Solar Eclipse

The July 11, 1991 Solar eclipse was a total eclipse visible from Mexico City.
This example shows how to use the Time Skip feature to watch an eclipse on
the Virtual Sky (rather than using the Eclipse Finder).

1 Set the Location to Mexico City.

Mexico City’s coordinates are in the Cities outside USA.loc location file.

2 Clear the “Use computer’s clock” checkbox.

3 Set the date to July 11, 1991. Set the time to 11:40.

4 Set Orientation to Pole Up.

We aren’t interested in the background motion of the stars.

5 In the Tracking Setup dialog box, mark only the Sun and Moon checkboxes.

6 In the Lock On box, select Sun. In the Trails list box, select Connected.

This keeps the Sun centered, and does not display a trail of objects.

7 Click OK.

The Sun and Moon should be now be centered in the Virtual Sky.

8 Adjust the field of view to 10° or less.

You can select a field width of nn degrees by typing Znn in the Find box.
The Sun and Moon should now be large disks. If not, reduce the field width.

9 Set the Time Skip interval to 5 minutes.

10 Start the simulation.
You can select the Go Forward command from the Time Skip flyout menu,
or click the uu button in the Time Skip toolbar.
If you have a fast computer, you might want to select a shorter skip interval,
so you can view the eclipse at a more leisurely pace.

You can also run this simulation by loading the Eclipse, Total -

Solar, 1991.11.07.sky Sky Document. It’s in the user\documents

subfolder.
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Stepping through the Eclipse

If you want to see where first contact occurs, or the point of maximum
totality, use the u or t buttons to step the simulation forward or backward.
You can change the skip interval at any time, but the simulation will stop.
Click one of the motion buttons to restart the simulation.

The point of maximum totality is easier to see if the Sun remains visible.
Select the Options command in the Data menu and mark the “Translucent
Sun and Moon” checkbox. This lets you see the Sun behind the Moon.

Notes on the Eclipse

Depending on the distance of the Moon from the Earth (and to a lesser
degree, the distance of the Sun from the Earth) the Moon’s disk can be larger
than, the same size as, or smaller than the Sun’s disk. In the case of the July
11, 1991 eclipse, the Moon’s disk was larger than the Sun’s, producing a total
eclipse.

In the eclipse of January 4, 1992, the Moon’s disk was smaller than the Sun’s,
producing an annular (ring-shaped) eclipse. Try repeating this example to
observe an annular eclipse. Change the location to Flagstaff, Arizona
(111° 39’ W, 35° 12’ N) and the time to 17:30.

Example #2: Plotting the Sun’s Analemma

The analemma is a plot of the Sun’s path through the sky, at the same time
each day, over a period of one year. This example plots the position of the
Sun every five days at 10 AM.

Since we’re interested in the position of the Sun in the hemisphere above our
observing position (rather than its position on the celestial sphere), we need
to switch to Zenith Up orientation to get a horizon plot. The stars will move
during the Time Skip, since we’re viewing at a constant altitude and azimuth
(rather than a constant right ascension-declination).

1 Select Zenith Up orientation.

2 Clear the “Use computer’s clock.” checkbox.

3 Set the date to December 21 (for any year). Set the time to 10:00.

4 In the Tracking Setup dialog box, click None, then mark the Sun checkbox.

5 In the Trails box, select Object Trails.

6 In the Lock On box, select Not Locked.

7 Enter a Time Skip interval of 5d (five days).

8 Enable Record Trails.

9 Press CONTROL+E (z3 on the Macintosh) to set a field width of 100°.

10 Press F to display the Find dialog box.

11 Highlight Sun in the list box. Click Find.

12 Click the Center button in the Object Information dialog box.
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13 Scroll upward to move the Sun near the bottom of the Virtual Sky.

December 21 is the morning of the Winter solstice, so the Sun is at its
lowest point in the sky. If you live in the Southern hemisphere, it’s the
morning of the Summer solstice, so the Sun is at its highest point in the sky.

14 Start the simulation.

You can select the Go Forward command from the Time Skip flyout menu,
or click the uu button in the Time Skip toolbar.

The Sun climbs higher in the sky as you move toward Spring and Summer.
(You might want to display the Local Sidereal Time and Date in the Status
Bar.) The Sun continues to climb until the Summer solstice is reached (on or
about June 21). The Sun then moves back down, until it returns to its lowest
point (on or about the following December 21, the Winter solstice).

You can also run this simulation by loading the analemma.sky Sky
Document. It’s in the user\documents subfolder.

Recording Time Skip Simulations

Time Skip simulations are “recorded” by saving the current configuration of
TheSky in a new Sky Document.

● To “record” a simulation, simply create a Sky Document with the
necessary configuration.

● To “play” a simulation, load the Sky Document, then select Step or Go.

TheSky comes with Sky Documents for about a dozen interesting and/or
useful simulations. These are described on page 81.

Using the Time Skip Controls with the Virtual Sky

You can use the controls in the Time Skip toolbar even when you aren’t
running a simulation. It’s a lot easier to set the interval to (say) one day and
click Step Forward, than it is to change times from the Time and Date sheet.

If you’re in Zenith Up orientation (or any horizon-based orientation),
everything in the Virtual Sky moves when you click a Step or Go button.
If Pole Up is selected, deep-sky object remain fixed and only Solar System
objects move.

Creating and Playing Movies

Version 5 adds the ability to create QuickTime™ movies. You can record
Time Skip animations, or any sequence of changes to the Virtual Sky, 3D
Solar System, or TheSky’s utilities, for later study or sharing with others.

All you need to record these movies is a copy of QuickTime, version 2.5
or later, installed on your computer. The movies can be played on any
computer platform running the same or a later version of QuickTime.
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TheSky ships with QuickTime version 3.0.2. To install it, run QTInstal.exe

in the QuickTime folder on the CD ROM. Apple occasionally updates
QuickTime. You might want to check the Apple Web site (www.apple.com )
to see if a newer version is available.

To record a QuickTime movie:

1 Configure the Virtual Sky as you want it to appear in the movie.

To record only a portion of the Virtual Sky, drag a zoom box around the area.

2 Select the Record Movie command from the Tools menu.

3 Select Start Recording from the flyout.

The Start Recording dialog box appears.

4 Click the "Entire screen" radio button to record the full Virtual Sky.
Click the "Selected area" radio button to record the area within the zoom box.

Even if you drew a zoom box, you can still select Entire Screen.
If you didn't draw a zoom box, Selected Area is dimmed.

5 Select the image size from the Recording Size list box.

You can choose from eight, quarter, half, or full size. The larger the image,
the larger the .MOV file.

6 Click OK.

The Compression Settings dialog box appears.

7 Select the desired compression technique.

Sixteen compression methods are available, including None. You might need to
experiment to find the one that best meets your needs.

8 Click OK

The Compression Settings dialog box closes, and movie recording begins.

9 Change the display in whatever way you want.

Each change adds a single frame to the movie. If you do nothing, nothing is added
to the movie. (See King Lear, act 1, scene 1). Both Time Skip changes (Step or Go)
and manual alterations are recorded.
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Select Pause Recording from the flyout at any time to suspend recording.

Select Pause Recording again to continue recording.

10 When done, select Stop Recording from the flyout menu.

The Stop Recording dialog box appears. It previews the movie you just recorded.
You can play the movie, alter its playback rate, and change its loop settings.

11 To save the movie, click Save Movie.
To continue recording, click Continue Recording.
To discard the movie, click Delete Movie.
To play the movie, click the u button at the lower-left corner.

Frame Rate

The default frame rate is 24 frames per second (fps). It gives very smooth
animation, but can produce large .MOV files. You can select the frame rate
from the Compression Settings dialog box. Rates of 12 and 15 fps work well.

Frame Size

The size of the .MOV file varies as the square of the relative frame size.
Switching to half size reduces the file to one-quarter its full-frame size.
A quarter-size frame reduces the file to one-sixteenth its full-frame size.

Animation Quality

If your movie runs too fast, or looks choppy, it needs more steps. If you’re
zooming or scrolling, try pressing CONTROL (z on the Macintosh) to reduce
the scrolling or zooming increment. CONTROL+SHIFT (z+SHIFT on the
Macintosh) gives an even finer step.

Respecting the Copyright

The design of the Virtual Sky and 3D Solar System is copyrighted. We ask that
you respect the copyright by making movies only for personal use, or limited
distribution (such as within your club, or for a single posting on the Internet).
The creation of movies for publication or general distribution is not allowed
without express written permission from Software Bisque. Thank you.
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19 Simulations and Tools

TheSky includes display modes and utilities that can…

● Simulate the Solar System’s motion, in perspective.
● Predict and simulate Solar and Lunar eclipses.
● View the positions and motions of Jupiter’s and Saturn’s moons.
● View the positions of Saturn’s rings.
● Display a monthly calendar of the Moon’s phases.

3D Solar System View

In Version 5, the 3D Solar System replaces the Solar System Simulator. 3D
Solar System is a one of the Virtual Sky’s display modes, not a separate tool.

To switch to 3D Solar System mode, select 3D Solar System Mode from the
View menu. Or click the 3D Solar System Mode button in the View toolbar.

The first time you go to 3D Solar System mode, it is configured so that…

● All planets, the Sun, and all ”marked” comets are enabled. The Sun
is at the center of the display.

● The orbits of all planets are visible and the ecliptic grid is displayed.
● The positions of Solar System objects are as they would be at the date

and time currently on the Date and Time sheet.
● The Solar System is oriented as it would be seen when looking (from

outside the Solar System) towards the coordinates that are currently the
center of the Virtual Sky.

● The First Point of Aries is pointed to by a green line.



● The line of sight is about 60° above the plane of the ecliptic .
● The Time Skip interval is set to one day.

Solar System objects can be identified (by clicking on them) and labeled (by
enabling Common Labels).

The orbit lines for the planets are shown at all times and cannot be turned
off. One section of each orbit is brighter than the other. The brighter section
is the part of the orbit in or above the plane of the Ecliptic. Because the
Earth’s orbit defines the plane of the Ecliptic, all of its orbit is bright.

Changing the Field of View

PAGE UP and PAGE DOWN zoom the 3D Solar System display just as they do
the Virtual Sky. Pressing CONTROL or CONTROL+SHIFT (OPTION or
OPTION+SHIFT on the Macintosh) at the same time provides a reduced or
micro increment (respectively), as it does when zooming the Virtual Sky.

If the Virtual Sky is displayed as the background (see “Display Options”
below), it is set to a field of view of 50° and does not zoom. The reason is that
the stars and other deep-space objects are so far away (relative even to the
diameter of Pluto’s orbit) that there would be no significant change in their
perspective, regardless of your position within the Solar System.

Changing the Viewpoint

The arrow keys change the angle of view.

● Pressing LEFT or RIGHT changes Theta and rotates the display. Theta is
measured in the plane of the ecliptic from the First Point of Aries.

● Pressing UP or DOWN changes Phi and tips the display. Phi is measured
from an axis perpendicular to the plane of the ecliptic, through the Sun.
If you change Phi sufficiently, the display “tips over” and you see the
Solar System from below! (Okay, we know there’s no “up” or “down” in
space, and “north = up” is set by the fact that astronomical studies were
first made by civilizations in the Northern hemisphere (Egyptian, Aztec,
Babylonian, Arabic). But, hey, that’s the way it is.)

The relationship among Phi, Theta, and the user’s viewpoint.
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Pressing CONTROL or CONTROL+SHIFT (OPTION or OPTION+SHIFT on the
Macintosh) while changing the viewpoint gives a reduced or micro
increment (respectively), as it does when zooming.

Why Is the Sun Fuzzy? And What’s that Black Area Around Mars’ Orbit?

If you zoom-in on the inner Solar System, you’ll see that the Sun is surrounded
by a nimbus of light. This aureole simulates the “blinding” effect of the Sun on
objects near it. The Sun is drawn in a similar way in Daytime Sky mode.

If the Sun overlaps an extended object (such as a nebula or the Milky Way),
you’ll see a circular black area around the Sun. This disk marks the boundary
of the inner Solar System.

Using the Tracking Setup Dialog Box

Because the 3D Solar System is a mode of the Virtual Sky, the Tracking Setup
dialog box controls which objects are visible and how they are tracked, just
as it does in the Virtual Sky.

All currently displayed objects (including comets and minor planets) are
listed in the Lock On and View From list boxes. When you Lock On an object,
it moves to a fixed position at the center of the display, while all other objects
continue to move. (When you first enter 3D Solar System mode, the display
is implicitly locked on the Sun.) When you View From an object, that object
becomes the viewpoint from which the motions of the other objects are seen.

View From can provide some rather spectacular simulations. Try a View
From the short-period comet 9P/Tempel 1. (Leave Lock On disabled.)

Lock On and View From can be used together. For example, you might Lock
On a comet and View From the Earth, to get a better idea of how the comet’s
path appears in our sky.

Running Time Skip Simulations

Time Skip animation works exactly the same in 3D Solar System mode as it
does in the Virtual Sky. (See Chapter 18, “Time Skip Animation.”)

Display Options

Several display options are available from a context-sensitive menu that
pops up when you right-click (CONTROL+click on the Macintosh) anywhere
within the 3D Solar System display, or on an object. You can select these
options at any time; you don’t have to stop the Time Skip simulator.

● Show Background displays the Virtual Sky behind the 3D Solar System.
The Virtual Sky and 3D Solar System are coordinated with each other.
If you tip or rotate the Solar System, the Virtual Sky’s coordinates
shift to match. (Its angle of view is fixed at 50°, however.)

● Ecliptic Grid displays or hides a grid marking the plane of the Ecliptic.
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● Show Orbit displays the orbital path of the comet or minor planet you
right-clicked on.

● Clear Orbits erases all comet and minor planet orbits. This command is
only available when you right-click within the display (not on an object).

● Orbit Depths draws vertical lines under or over orbit paths of comets and
minor planets, showing the orbits’ distance above or below the Ecliptic.

● Zoom To adjusts the field of view so that the orbit path of the selected
planet falls within the window.

Printing the Display

The 3D Solar System display can be printed at any time with the Print
command. Print Preview works just as it does for the Virtual Sky.

You can also copy the display to the Clipboard by pressing CONTROL+C (zC
on the Macintosh), or clicking the Copy button in the Standard toolbar. You
can use the Export command from the File menu to create a metafile (a PICT
file on the Macintosh) of the display. The file can be imported into a word
processing or graphics program and printed from there.

Daytime Sky Mode

Daytime Sky mode simulates the rising and setting of the Sun. The Virtual
Sky’s background lightens and darkens, and objects appear and disappear,
according to whether they would be visible against the sky.

Daytime Sky mode can be used with any orientation. However, in Pole Up
(equatorial coordinates) orientation, objects remain visible at all times. You
must select one of the horizon-based orientations—Zenith Up, North, East,
South, West, Look Up—for objects to fade and reappear against the sky.

1 On the Date and Time sheet, select the date and time you want.

If “Use computer’s clock” is marked, the Virtual Sky will change in real time.

2 Select the orientation you want.

Remember that the Sun rises in the East and sets in the West.

3 Select Daytime Sky Mode from the View menu.

Or click the Daytime Sky Mode button in the View toolbar.

The Time Skip controls can be used with Daytime Sky mode. The Sunrise
and Sunset Increment settings advance or retard the Virtual Sky about 24
hours, to the moment at which the top of the Sun’s disk just touches the
horizon. (The Local Horizon reference line is ignored.)

You can add or subtract time from the Sunrise and Sunset settings, to view
the Sun at later or earlier times.

1 Click within the Increment edit box

2 Press RIGHT to move the cursor to the end of the line.

3 Enter the amount of time in seconds, minutes, or hours.
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Negative times are preceded by a minus sign (–). Seconds must be followed
by s , minutes by m, and hours by h. (Entries without these letters are
ignored.) You can combine hours, minutes and seconds, and each can have a
different sign.

Eclipse Finder and Simulator (Tools menu)

In Version 5, the Eclipse Finder and Simulator is integrated with the Virtual
Sky—a separate program is no longer needed. Selecting the Eclipse Finder
command automatically computes all eclipses—Solar and Lunar, total and
partial—for the decade following the date currently on the Date and Time
sheet. The Eclipse Finder box lists the dates and types of the eclipses.

Click on an eclipse to view information about it—the start and end times, the
time of peak totality, and the magnitude. If the eclipse is not visible from the
current location, “Not visible from this site” is displayed.

If a Solar eclipse is Total or Annular, the “Show path of totality” checkbox is
enabled. Marking this checkbox opens a second window showing the path of
totality over a globe of the Earth. (Because Lunar eclipses can be seen from
almost anywhere on the dark side of the Earth, there is no path of totality to
show.) The site currently selected on the Location sheet is marked with a
yellow dot.

Moving the mouse over this window changes the mouse cursor to a hand.
Drag the hand to rotate the globe to any position.

To view a simulation of a specific eclipse:

1 Highlight the eclipse in the list box.

2 On the Location sheet, select a site or enter coordinates from which
the eclipse is visible.

3 Click the View button.
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The time and date are set to the starting time of the eclipse. The Sun or Moon is
placed at the center of the Virtual Sky and locked. The Earth’s shadow is displayed
(for Lunar eclipses). The time interval for Time Skip simulations is set to five minutes.

4 Click the Step Forward or Go Forward button to view the eclipse.

For Solar eclipses, the Virtual Sky shows the Moon passing in front of the
Sun. For Lunar eclipses, two concentric circles represent the Earth’s shadow.
The inner circle represents the umbra. The gray space between the inner and
outer circles represents the penumbra.

The Earth’s shadow is automatically shown when you run a Lunar eclipse
simulation. You can display it or hide it at any time by marking or clearing
the “Earth’s shadow” checkbox in the Tracking Setup dialog box.

Eclipse Magnitude

The magnitude of an eclipse is defined by
M = (L1 - m) / (L1 + L2)

where L2 and L1 are the respective radii of the umbral and penumbral cones
at the observer’s position, and m is the observer’s distance from the axis of the
shadow at the time of maximum. The magnitude M is not necessarily the
eclipsed fraction of the disk, and can be greater than unity in total eclipses.

Jupiter’s and Saturn’s Moons

In Version 5, the display of Jupiter’s Gallilean moons is integrated with the
Virtual Sky—a separate program is no longer needed. The Virtual Sky also
shows the position of the eight principal moons of Saturn—Hyperion, Titan,
Mimas, Iapetus, Dione, Tethys, Rhea, and Enchilada (uh, Enceladus). The
positions of the moons take into account the finite speed of light—they are
shown at the positions you'd see them from Earth, at the current time.

You can see which satellites will be visible before beginning your viewing.
Or you can find the times at which particular moons pass across a planet’s
disk, or are occulted by it.

To view the motions of the moons of Jupiter or Saturn:

1 Set the date and time you want on the Date and Time sheet.

2 Select Find from the Edit menu.

Or press F, or click the Find button in the Objects toolbar.

3 Select Planets, Sun, Moon in the Common names list.

4 Select Jupiter or Saturn from the list box to the right.

5 Click Center & Frame.

The planet is displayed at the center of the Virtual Sky at a 3° field of view.
(You might need to zoom out a bit to view Saturn’s outermost moons.)

6 Click on the planet.

The Object Information dialog box appears.
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7 Select the Utility tab and click Lock On.

8 Enter the desired time interval in the Time Skip edit box.

9 Click one of the Time Skip Step or Go controls.

Click on a moon to display its name. (Or turn on Common Labels.)

Saturn’s Rings

The phase of Saturn’s rings is visible in the Virtual Sky.

1 Set the date and time you want on the Date and Time sheet.

2 Press F, or click the Find button in the Objects toolbar.

3 Select Planets, Sun, Moon in the Common names list.

4 Select Saturn from the list box to the right.

5 Click Center and Frame.

Saturn is displayed at the center of the Virtual Sky at a 3° field of view. The rings’
phase should be easy to see. Depending on the size of your monitor and the display
driver’s resolution, you might need to adjust the field of view for the best image.

To view a Time Skip simulation of the rings’ phase change, continue with Step 6.

6 Click on the planet.

The Object Information dialog box appears.

7 Select the Utility tab and click Lock On.

8 Enter the desired time interval in the Time Skip edit box.

9 Click one of the Time Skip Step or Go controls.

Moon Phase Calendar (Tools menu)

The Moon Phase Calendar displays the relative phase of the Moon for each
day of the selected month and year.

Simulations and Tools 163



The month and year currently shown on the Date and Time sheet are the
default when you display the calendar. Click the Previous or Next buttons
to see the preceding or following month.

The times when the Moon turns full and new are shown on the days when
they occur. The “first time” (when the new Moon begins to wax) and the
“last time” (when the full Moon begins to wane) are also shown.

Click Print to print a copy of the calendar. If the “Moon rise/set” or “Sun
rise/set” checkboxes are marked, these times are added to the printout.
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20 Linking Your Telescope with TheSky

WARNING!

NEVER attempt to observe the Sun through your telescope! Without a specially
designed Solar filter, viewing the Sun—for even a fraction of a second—will
cause instantaneous, irreversible eye damage.

When observing during the day, do not point the telescope near the Sun. Do not
use TheSky’s automatic-slew feature to find astronomical objects during the day.

Introduction

TheSky’s telescope-link system can work with two classes of telescopes.

● Telescopes with Optical Encoders

The encoders read the rotation of the telescope’s axes, and return numbers
that represent how much they moved. The following serial interface boxes
are compatible with TheSky.

✴ AB Engineering
✴ BBox (Tangent Instruments)
✴ CompuSky PC Plug-In Card
✴ Metal BBox (Merlin Controls)
✴ NGC-MAX (JMI)
✴ NGC Sky Commander (Lumicon)
✴ Sky Commander (SkyComm Engineering)
✴ Sky Wizard 3 (Lumicon)

● Telescopes with Computer Control

TheSky can send positioning commands to the following computer-
controlled drive systems.
✴ Astronomy Command Language-controlled telescopes
✴ Celestron Compustar™
✴ Celestron™ Ultima 2000™ telescope
✴ Meade™ LX200™ telescopes
✴ Quadrant Systems™ Coordinate III™ drive

✴ Software Bisque Paramount GT-1100
✴ Telescopes in Education Network
✴ University of Iowa

In addition, TheSky can simulate a telescope link. You can experiment
without actually having a telescope connected. This is explained on page 180.

Whether your telescope has optical encoders, or full computer control, the
Virtual Sky tracks the telescope’s position. In addition, TheSky can position
computer-controlled systems. Select an object from TheSky’s database, and it
will point the telescope at it.



The following sections explain how to connect your computer to your
telescope or drive system, and calibrate or synchronize the setup. All
systems using optical encoders are set up the same way and are explained in
a single section. Computer-controlled telescopes are each set up differently,
and are described individually.

Complete documentation for the Software Bisque Paramount GT-1100 drive
is provided with the instrument.

Setting the Correct Time

Computer-controlled drive systems have an internal clock that must be set with
high accuracy. (Encoder-based system do not need as high degree of accuracy,
unless you’re tracking planets, or want to see the horizon line precisely.)

Neither radio station time announcements nor the telephone company’s time
signals are especially accurate. The internal clocks of personal computers aren’t
accurate, either—they are notorious for gaining or losing several seconds a day.
The best source of time signals in the USA is WWV (WWVH in Hawaii). WWV
can be received on any shortwave radio at frequencies of 5, 10, 15, and 20 MHz.
Entering the correct time “by hand” from WWV should be accurate enough.
The new “self-setting” clocks that use a small ferrite antenna to pick up time
signals transmitted at 60kHz are compact, inexpensive (much less than the cost
of a good shortwave receiver), and about as accurate as the WWV broadcasts.

You can also use TheSky’s Time Service feature to update your computer’s
clock then transfer that time to the telescope’s drive system. (See page 19.)

Setting Up and Using Optical Encoder Systems

Other than the encoders and their interface box, the only extra hardware
required is a standard serial (RS-232 or RS-422) cable to connect the interface
to your computer. This cable is usually supplied with the encoder system.

Make the appropriate connections from the encoders to the interface box,
and the box to your computer, as shown in the drawing below. (See the note
on page 178 about selecting a serial port.)

The CompuSky PC Plug-In Card mounts inside your computer. Please refer to
its manual for installation instructions.

Computer

Telescope

Serial Cable

Serial BoxDec Cable
(longer)

RA Cable
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Configuring the Hardware

You are now ready to configure the hardware.

1 Select the Setup command from the Telescope menu.

The Telescope Setup dialog box is displayed.

2 From the Control System list box, select the encoder interface you’re using.

3 Click Settings.

The Telescope Settings dialog box appears.

4 In the COM Port list box, select the serial port to which the interface
is connected.

On the Macintosh, select the modem or printer port.

5 In the Baud Rate list box, select 9600.

Most encoder interfaces communicate at 9600 baud. The 14.4K, 19.2K, and faster
rates are provided for interfaces that can operate at higher speeds.

6 Select your telescope from the Telescope list box.

If it isn’t listed, choose CUSTOM.

The number of encoder tics per revolution for that telescope is displayed in the
Encoders edit boxes to the right. If your telescope isn’t listed, these values must be
manually entered in the Encoders edit boxes. If you don’t know these values, contact
the manufacturer or Software Bisque.
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7 Enter the same values in the Tics/Rev edit boxes.

The RA and Dec values are sometimes different. Don’t switch them.

If you own version 1.7 through 1.99 of the BBox, or version 2.93 through 3.49 of
NGC-MAX, enter 32768 for both axes. (If you don’t know the version number,
choose Options from the Telescope menu, and select the Communications Test
command from the flyout menu. Click Get Version, then turn the interface box off,
then on. The version number will be displayed.)

8 Set the Clockwise/Counterclockwise options for Altitude and Azimuth
Direction.

If you aren’t sure which way the encoders are supposed to be mounted, contact the
manufacturer. Or continue with the setup, and see which way the cross hairs move
when you link the telescope and computer.

9 Click Configure BBox.

This Step applies only if you own a plastic BBox, version 1.7 (or later).
If not, skip to Step 10.

The BBox is automatically configured for the selected number of encoder tics.
If you get the message “Cannot configure BBox,” try again. If you still cannot
configure the box, please refer to the “Troubleshooting” section on page 178.

This step need be done only once, as the interface box stores the configuration
in non-volatile memory.

10 Click OK to save the configuration.

Aligning the Encoders

The computer and the encoders can now communicate. The next step is to
align the encoders by aiming the telescope at specific stars. This gives TheSky
the information it needs to calculate where the telescope is pointing.

1 Set up the telescope where you do your observing.

2 Select the Link command from the Telescope menu.
Click Establish in the flyout menu.

Or click the Establish Link button on the toolbar. (The Sky Commander is aligned
independently of TheSky, so users can skip the rest of this section.)

3 If your telescope has an equatorial mount, point it at 90° declination.
If your telescope has an alt-az mount, point it at 90° altitude.

Specifically, you’re looking for the position where motion in right ascension
(or azimuth) causes no motion in declination (or altitude).

The default angle is 90°. To point the telescope at a different angle, exit the Link
Establish dialog box. Go back to the Telescope Setup dialog box. Enter the angle in
the Point Declination edit box. Click OK, then Close. Select Establish Link again.

4 Click OK.

5 Point the telescope at the first alignment star.

The default first-alignment star is Polaris. To use a different star, use the Find
command to locate the star (or just click on it in the Virtual Sky). Then click
Align On in the Telescope sheet of Object Information dialog box.

6 Click OK.
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7 Point the telescope at the second alignment star.

The default second-alignment star is Capella. To use a different star, use the Find
command to locate the star (or just click on it in the Virtual Sky). Then click Align On
in the Object Information dialog box.

8 Click OK.

The difference between the actual angular separation of the alignment stars and
the angle measured by the encoders is displayed. A difference of zero indicates
a “perfect” alignment. Experience has shown that a difference of less than ½° is
acceptable. If the difference is substantially greater, please refer to “Troubleshooting”
on page 178.

9 Click Accept.

The alignment is complete. You should see cross hairs in the Virtual Sky, marking
the center of the field of view of the telescope.

As you move the telescope, the cross hairs move to show where the telescope
is pointing. As the cross hairs reach the edge of the screen, the Virtual Sky
automatically scrolls to keep the cross hairs visible.

The Establish Link button on the toolbar is “down” to show the telescope
link is active. Click the Suspend Link button at any time to temporarily
disable the link and regain manual control of the Virtual Sky. Click the
Suspend Link button again to restore the link. (These commands are also
available from the Telescope menu.)

Selecting Alignment Stars

If you choose different alignment stars, don’t pick closely spaced ones. No
encoder is perfect; all have some positional error. Generally speaking, the
greater the angular separation of the alignment stars (in both right ascension
and declination), the more this error is “averaged out” across the sky.

Realignment with Each Use

TheSky has no provision for saving alignment settings, because you must align
the telescope each time you use it, even when observing from the same location.
Slight differences in telescope elevation and leveling will invalidate the
previous calibration, especially at high magnifications.
Suspending the link does not cause loss of alignment. You do not have to
realign when you reestablish a link in the current session.

Software Options

The Software Options section of the Telescope Setup dialog box provides the
following additional controls over encoder/drive interface. Mark or clear
the checkboxes to select or deselect them.

● Confirm slews

You must confirm any slewing command.

● Confirm syncs

You must confirm any synchronization command.
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● Confirm mapping

You are prompted to confirm each new coordinate point mapped.
(Applies only to owners of TPoint Telescope Pointing Analysis software.)

● Impose slew limits (destination coordinates only)

Turns slewing limits on, and warns if you try to slew the telescope inside
them. This checkbox must be marked for the slewing limits to be in effect.
(The limit lines do not have to be displayed, however.)
Slewing limits also work with encoder systems. TheSky beeps three times
if you try to move the telescope inside a limit line.

● Attempt to stop slews in progress through slew limits

If you select an object that requires the telescope to slew across the limit area,
TheSky will attempt to stop the slew when the boundary is reached.

● Switch to night vision upon link

The Virtual Sky automatically turns the title bar, tool bars, and Status bar
red when the link is established. Under Windows, if you also want the stars
to be red, select the Stellar Options command from the View menu and
mark the “Red in night vision” checkbox.

● Show the number of packets, retries, failures

Gives detailed information about serial-link activity. We recommend
turning this on when connected to the Mount Wilson Observatory. It can
provide useful information when you get “retry” or error messages.
Otherwise, you’d select this option only when you have a communications
problem with the serial link to your encoder or telescope.

● Close Object Information dialog box upon slew

When you click the Slew To button to move to the selected object, the
Object Information dialog box closes to keep the screen uncluttered.

● Enable TheSky modeling

Enables the TPoint model for improved positioning accuracy. (Applies only
to owners of TPoint Telescope Pointing Analysis software.)

● Always keep telescope cross hairs on screen

This is the default—the display follows the telescope, and vice versa. If this
checkbox is cleared, the telescope and the Virtual Sky can be independently
repositioned.

● Cross Hair Update Period (milliseconds)

The Cross Hair Update Period determines how often TheSky communicates
with the attached encoder or control system.
The 500 ms default is about right for computer-controlled telescopes. If you
have a fast computer, try 250 ms. Much-smaller values might force the
computer to spend so much time communicating with the telescope that its
performance becomes sluggish. You might want to experiment to find the
smallest value that doesn’t interfere with normal operation of TheSky.
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This setting also affects TheSky’s ability to halt slewing into a limit zone.
The more often the computer interrogates the telescope, the more likely
TheSky will be able to stop the slew in time.

The 500 ms default is too slow for encoder systems—checking only twice
each second makes it difficult to perform minor adjustments on the
telescope’s position. Try 100 ms (or less, if you have a fast computer).

Using the Link

The cross hairs in the Virtual Sky will now “follow” the telescope. This is
true whether you move the telescope by hand, or let its motor drive turn it.

Be sure you’ve marked the “Use computer’s clock” checkbox. The Virtual
Sky will then update automatically. (The time between updates can be
changed. See page 56.)

If you select a specific date and time, the Virtual Sky does not update.
The display will not match what you see through the telescope.

Terminating the Link

Select the Link command from the Telescope menu and click Terminate in
the flyout menu. (Or click the Terminate Link button on the toolbar.)

Finding a Particular Object

TheSky can help you position the telescope on a particular object.
(This feature is not available with the Sky Commander.)

1 Use the Find command to locate the object.

2 Click Guide To in the Object Information dialog box.

The Guide To dialog box is displayed.

The current position of the telescope is shown by the long lines (“guiding needles”)
in the Axis circles. The object’s coordinates are indicated by short lines (“destination
marks”) at the edges of the circles.

Mark the Enlarge checkbox if you want a larger display for greater precision.

3 Starting with the RA/Az axis, move the telescope to align the needles with the
marks. When the needle and mark are aligned, use the telescope’s fine
adjustment to make the middle, red “LED” illuminate. Lock the RA/Az axis.

On B&W displays, the illuminated “LED” is brighter than those surrounding it.

4 Repeat Step 3 for the Dec/Alt axis.

When both red “LEDs” are lit, the Guide To dialog box automatically closes.

The Virtual Sky’s cross hairs are now over the desired object. When you look
through the telescope, the object should be near the center of the field.
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If “Impose slew limits” is enabled, TheSky warns you if you try to move the
telescope into a limit-line region.

Setting Up and Using a Meade LX200

TheSky can drive any Meade LX200 telescope. The only additional hardware
needed is a standard serial (RS-232 or RS-422) cable, to connect your
computer to the LX200’s drive base.

This section explains how to set up a link and synchronize the system. We
strongly recommend that you read the LX200 owner’s manual carefully,
and become thoroughly familiar with the telescope’s operation, before using
TheSky to control it. Do not attempt daytime slewing before you have read and
understood the “Daytime Slewing” section of the Meade manual.

Configuring the Interface

The interface must be configured so your computer can communicate with
the LX200.

1 Turn off the LX200.

2 Using the appropriate cable, connect the serial port on the LX200 to an
unused serial port (modem or printer port on the Macintosh).

See the note on page 178 about selecting a serial port.

3 Turn on the LX200.

4 Select the Setup command from the Telescope menu.

5 In the Control System list box, select “LX200 by Meade Instruments Corp.”

6 Click Settings.

The Settings dialog box appears.

7 In the COM Port list box (Serial Port popup menu on the Macintosh),
select the serial port the interface is connected to.

8 In the Baud Rate list box, select 9600.

All current interfaces run at 9600 baud.

Linking to and Synchronizing with the Telescope

The LX200 drive system must be properly configured before TheSky can
control it. You can do this “by hand,” at the telescope. Or, you can do it from
within TheSky.
● The time and terrestrial coordinates must be entered. If the telescope is

connected to your computer, you might find it easier to use the LX200
Initialization dialog box, described below.

● The telescope must be aligned. The instructions below include a one-star
alignment. If you’d prefer to align the telescope a different way, you
should do so before continuing.
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1 Level the telescope as accurately as you can.

Use a carpenter’s level—it’s more accurate than the level in the telescope’s tripod.

2 Select the Link command from the Telescope menu.
Choose Establish from the flyout menu.

If the “Switch to night vision” checkbox is marked, the title bar, tool bars, and Status
Bar turn red. Cross hairs appear at the center of the Virtual Sky.

If you receive a “Can’t establish link” message, be sure the connections are correct
and the telescope is turned on.

3 If you haven’t set the telescope’s time and coordinates, do so now.

4 Move the telescope to position a known deep-space object (preferably a star)
at the center of the telescope’s field.

Don’t use a planet, nebula, or galaxy. Star coordinates are more accurate,
and a star is a true “point.”

5 Click on that star in the Virtual Sky.

The Object Information dialog box appears. If the star is not highlighted in
the Object List, click on it.

6 Click Sync.

The LX200 is now aligned and can be used with TheSky. The Virtual Sky’s
cross hairs should jump to the object used for synchronization.

When the link is active, TheSky and the LX200 are interdependent.
If you use the telescope’s drive controls (or any of TheSky’s controls) to
reposition it, the Virtual Sky tracks the movement.

The Establish Link button on the toolbar is “down” to show the link is active.
Click the Suspend Link button at any time to suspend the link. TheSky and
the LX200 are then independent, and behave as if there were no link. (If you
suspend the link while the LX200 is slewing, the slewing continues to
completion.) Click Suspend Link again to restore the link.

Once the link is restored, the Virtual Sky repositions itself at whatever new
position the telescope has been driven to. The opposite, however, is not true.
If the Virtual Sky is repositioned when there’s no link, the telescope does not
move to match it. You must select an object and click Slew.

Slewing While the Link is Suspended

The Suspend Link command does not actually keep commands from being
sent to the telescope. Its main purpose is to let you reposition the Virtual Sky,
without having to keep the cross hairs on-screen. You can still slew the
telescope. Follow the instructions in “Slewing to a Specific Object” below.

Slewing to a Specific Object

1 Click on the object in the Virtual Sky.

If it isn’t visible, use the Find command.

2 Click the Slew button on the toolbar of the Object Information dialog box.
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The box below appears, and remains until the slewing is completed.
Clicking Cancel sends a command to the LX200 to stop slewing.

There’s a quicker way to slew, without displaying the Object Information
dialog box.

1 Right-click ( CONTROL+click on the Macintosh) on the object in the Virtual Sky.

2 Select the Slew To command from the Virtual Sky’s pop-up menu.

Motion Controls

The Motion Controls dialog box moves the telescope a specific distance each
time one of the motion buttons is clicked. The increments are preset at 0.5, 1,
5, 15, and 30 arc-seconds; 1, 5, and 30 arc-minutes; and 1, 5 and 10 degrees.

Motion can be in four directions—North, East, South, or West. Motion can
be with respect to Horizon (Alt-Az) or Equatorial (RA-Dec) coordinates.
Click the radio button of the coordinate system you want to use.

The Motion Controls dialog box is non-modal. It can remain open while
you’re doing other things.

The Motion Controls command has a check mark next to it if the dialog box
is displayed. Select the Motion Controls command a second time to remove
the dialog box. Or press ALT+M (zM on the Macintosh).

LX200 Options

When the link is active, the following controls are available from the Options
command of the Telescope menu. (Sync, Align On, Set Park, and Park are
also available from the Telescope sheet of the Object Information dialog box.)
They let you operate the LX200 directly from the computer. Each has its own
dialog box, described below.

Initialize

The LX200 Initialization dialog box sets the date, time, location, and time
zone of the LX200.

To set the date, time, or location data, press the corresponding button. The
date and time are read from the computer’s internal clock and passed to the
LX200. The latitude, longitude, and time zone are taken from the values you
entered in the Location dialog box.

These values can’t be changed from the LX200 Initialization dialog box.
If the date or time is wrong, reset the internal clock using the Date/Time
applet in the Control Panel (Date/Time control panel on the Macintosh). If
the location coordinates are wrong, change them in TheSky’s Location sheet.
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A message box is displayed if TheSky cannot set the telescope. Check the
connections and power to the LX200.

Focuser

The Focuser dialog box controls the focus and focus speed of an electric
focuser connected to the LX200. This feature is especially useful when using
an CCD imager and viewing its output on a monitor. This dialog box is
non-modal and can remain open while you’re doing other things.

The number displayed indicates how many times you’ve clicked the Slow
and Fast buttons, and in which direction. Clicking Fast changes the count by
1000, Slow changes the count by 1. For example, if the number is 4007,
you’ve clicked Slow seven times and Fast four times.

The Focuser command is “checked” if the dialog box is displayed. Select the
Focuser command a second time to remove the dialog box and check mark.

Reticle

The Reticle dialog box changes the reticle brightness and reticle flash mode.

Set Park

Sets the telescope’s park position. (ACL, Meade 16" LX-200 and Software
Bisque Paramount GT-1100 only)

Park

Moves the telescope to its park position. (ACL, Meade 16" LX-200 and
Software Bisque Paramount GT-1100 only)

Find Home

The telescope searches for its “home” sensors and reports the results. The
home position must be found (once) before a “parked” position can be set.
(ACL, Meade 16" LX-200 and Software Bisque Paramount GT-1100 only)

Align Home

Establishes “home” position and stores it in telescope’s memory. The
conditions listed in the prompt below must be met before clicking OK.
(ACL, Meade 16" LX-200, and Software Bisque Paramount GT-1100 only)

Terminal

Gives direct access to drive system. Type a command in the Command edit
box, then click Send. The drive’s response appears in the Response edit box.
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Set LST

Sets telescope’s Local Sidereal Time (LST), using time set in TheSky.
(ACL only)

Star Search

Slews the telescope in a spiral pattern of increasing size to locate an object.
(Software Bisque Paramount GT-1100 only)

Status

Reports status of 32 items. (ACL only)

Terminating the Link

Select the Link command from the Telescope menu and click Terminate in
the flyout menu. (Or click the Terminate Link button on the toolbar.)

Setting Up and Using the Quadrant Systems Coordinate III

TheSky can communicate with the Coordinate III to position a telescope
on any object in TheSky’s database. You can also access all functions of the
Coordinate III through the Terminal command. The only additional hardware
needed is a standard serial (RS-232 or RS-422) cable.

This section explains how to set up a link and synchronize the system.
We strongly recommend that you read the Coordinate III owner’s manual
carefully, and become thoroughly familiar with its operation, before
attempting to use TheSky to control it.

Configuring the Hardware

The interface must be configured so the computer can communicate with the
Coordinate III.

1 Turn off the Coordinate III .

2 Using the appropriate cable, connect the serial port on the Coordinate III
to an unused serial port (modem or printer port on the Macintosh).

See the note on page 178 about selecting a serial port.

3 Turn on the Coordinate III .

4 Select the Setup command from the Telescope menu.

5 In the Control System list box, select “Coordinate III by Quadrant Systems.”

6 Click Settings.

The Settings dialog box appears.

7 In the COM Port box (Serial Port popup menu on the Macintosh),
select the serial port the interface is connected to.

8 In the Baud Rate list box, select 9600.

All current interfaces run at 9600 baud.
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Linking to and Synchronizing with the Telescope

The Coordinate III must be properly configured before TheSky can control it.
Specifically, you must enter the required information (time, terrestrial
coordinates, and so on) and perform a star alignment. Once this is done, you
are ready to establish a link.

Select the Link command from the Telescope menu and click Establish in the
flyout menu. If you receive a “Coordinate III not responding” message, be
sure that the connections are correct and the telescope is turned on.

Once the link is established, cross hairs appear at the center of the Virtual
Sky. These show where the telescope is currently pointed. Before you can
control the Coordinate III, you must first synchronize the display and the
telescope:

1 Move the telescope to position a known object outside the Solar System
(preferably a star) at the center of the telescope’s field.

Don’t use a planet, nebula, or galaxy. Star coordinates are more accurate,
and a star is a true point source.

2 Click on that star in the display to bring up the Object Information dialog box.

If the star you want is not highlighted in the Object List, click on it.

3 Select the Utility tab and click Sync.

The Coordinate III is now synchronized. The screen cross hairs should jump
to the object used for synchronization.

When the link is active, TheSky and the Coordinate III are interdependent. If
you use the telescope’s drive controls to reposition it, the Virtual Sky tracks
the movement.

The Establish Link button on the Telescope toolbar is depressed to show the
link is active. Click the Suspend Link button at any time to suspend the link.
TheSky and the Coordinate III are then independent, and behave as if there
were no link. (If you suspend the link while the Coordinate III is slewing, the
slewing continues to completion.) Click the Suspend Link button again to
restore the link.

Once the link is reestablished, the Virtual Sky repositions itself at whatever
position the telescope has been driven to. The opposite, however, is not true.
If the Virtual Sky was repositioned when there was no link, the telescope
does not move to match it. You must select an object and click Slew To.

Slewing to a Specific Object

1 Click on the object in the Virtual Sky.

If it isn’t visible, use the Find command.

2 Click the Slew To button on the toolbar of the Object Information dialog box.

The box below appears, and remains until the slewing is completed.
Clicking Cancel sends a command to the Coordinate III to stop slewing.
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There’s a quicker way to slew, without displaying the Object Information
dialog box.

1 Right-click ( CONTROL+click on the Macintosh) on the object in the Virtual Sky.

2 Select the Slew To command in the Virtual Sky’s pop-up menu.

Terminal

The Terminal function lets you send any command to the Coordinate III.
It appears under Options in the Telescope menu.

Type a command in the Command edit box, then click Send. The Coordinate
III’s response appears in the Response edit box.

To view a list of all Coordinate III commands, enter a question mark (?) in the
Command edit box, then click Send. The command list is displayed in the
Response box.

Terminating the Link

Select the Link command from the Telescope menu and click Terminate in
the flyout menu. (Or click the Terminate Link button on the toolbar.)

Troubleshooting

The most-likely problem is a misconfigured serial port. Check all the
following items.

● Is the telescope or encoder plugged into the correct serial port?
● Is the cable defective or miswired?
● Under Windows, are the port settings (address, IRQ, data rate) correct?

(If you think there’s an interrupt conflict, refer to “Serial-Port Interrupt
Conflicts” below.)

Cannot align NGC-MAX, SGT-MAX, Sky Vector, or Sky Wizard.

If there’s a large difference between the encoder readings and the actual
angular separation of the alignment stars, select the Options command from
the Telescope menu and pick Communications Test from the flyout menu.
There should be no errors on either the right-ascension or declination axis.
The battery status must be “OK.”

As you move the telescope manually, the raw encoder readings should
change. The number should fall between plus and minus half the encoder
resolution for that axis. For example, if the resolution is 4400, the number
should be greater than -2200 and less than +2200. (If you own an older metal
BBox, the numbers are displayed in hexadecimal format.)
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If the numbers do not change, check the cable connections, and be sure the
interface box is getting power. If this does not correct the problem, the
difficulty is most likely a hardware problem with the encoder or the
interface box.

If the encoder numbers are changing correctly, but the angular error remains
large, check the settings in the Telescope/Encoder Data dialog box. You
might have entered the wrong values for the Tics/Rev setting.

Cannot connect to the LX200.

Cannot connect to the Coordinate III.

If you get the message “LX200 not responding” or “Coordinate III not
responding,” exit TheSky and try to establish a link using a communications
program (such as HyperTerminal, ZTerm, or ClarisWorks). Set up the
program to talk to the same serial port, at the same speed as the telescope.
When the connection is made, type

:GR# (LX200) or

R (Coordinate III)

then press ENTER. The response should be a coordinate string, such as

01:28.3# (LX200) or

RA02:24:20 (Coordinate III)

If you don’t get a response, check the following.

● The serial cable is in working order and properly connected.
● The correct data are entered in the Telescope Setup dialog box.
● The power supply is turned on and can deliver sufficient current.

Serial-Port Interrupt Conflicts under Windows

An interrupt is a signal that tells the computer’s CPU that a piece of hardware
(such as a serial port, sound card, or disk drive) needs attention. To avoid
conflicts, each hardware device must have a unique interrupt. Unfortunately,
the original IBM PC allowed for only two serial (COM) ports and their
assigned interrupts. No interrupts were reserved for additional COM ports.
Desktop PCs have two serial ports, COM1 and COM2. They use interrupts 4
and 3. If you add an additional serial-port card for COM3 and COM4, these
also use interrupts 4 and 3. This causes problems if you try to use COM1 and
COM3 (or COM2 and COM4) simultaneously—two ports cannot share an
interrupt at the same time.
If you use a serial mouse, connect it to COM1 (or COM3) and the drive or
encoder interface to COM2 (or COM4). You might also change the interrupt
on COM3 or COM4. (Interrupts 5 and 9 are often unused, and can be selected
by moving a jumper on the serial interface card.)
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Another way to get around COM-port conflicts is to change the mouse
interface. If your computer has a PS/2 mouse port, ask your dealer for a
PS/2-to-serial adapter so you can attach your serial mouse to the PS/2 port
(which uses interrupt 12). This is especially useful for notebook computers,
which rarely have more than one external serial port.

Using the Link Simulator

If you have a computer-controlled telescope, you’ll probably want to
experiment with TheSky’s telescope link before doing any serious observing.
If the telescope you’ll be using is not available, or is inconvenient to set up,
you can still work with the link, using the Link Simulator.

1 Select the Setup command from the Telescope menu.

2 In the Telescope Setup dialog box, choose Simulator from the
Control System list.

3 Click Settings.

The Settings dialog box appears.

4 Select values for Velocity and Acceleration.

The defaults are 1°/second and 1°/second². If your telescope’s capabilities differ,
you might want to change these. The simulation will more-closely mimic the
telescope’s behavior.

The Baud Rate setting doesn’t matter. However, you must select a port that is not
currently in use by another running program.

5 Click OK, then Close.

6 Select the Setup command from the Telescope menu.
Choose Establish from the flyout menu.

Or click the Establish Link button in the Telescope toolbar.

The Simulator slews to its “home” position (1 hour right ascension,
0 degrees declination).

The Link Simulator is now active. The standard controls and functions are
available, including limit lines. The Simulator is a good way to check your
limit-line setup before driving the telescope with TheSky.

Digital Setting Circles

TheSky can display the telescope’s position coordinates, in large characters,
so they can easily be read at a distance. This feature is available with both
encoder-based systems and telescopes having full computer control.

To use it, select Digital Setting Circles from the Telescope menu. The Virtual
Sky is replaced with a screen that shows the right ascension and declination
of the telescope. Press ESC to return to the Virtual Sky.

As explained previously, no encoder is perfectly accurate. The coordinates
shown might differ slightly from the telescope’s actual position.
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Mosaic Command (Tools menu)

The Mosaic command divides a rectangular area of the sky into smaller
rectangles, each of which has the dimensions of a selected field-of-view
indicator (FOVI). You can slew to the center of any rectangle simply by
clicking on it.

This feature provides an easy way to photograph an area of the sky larger
than a single CCD or film image can cover, or to systematically
survey sections of the sky (as when searching for comets or minor planets).

1 Set the field of view to less than 50°.

Mosaicking is limited to narrow fields of view, and only with orthographic projection.

2 Drag a zoom box around the area you want to divide.

Until both these things are done, the Mosaic command in the Tools menu is dimmed.

3 Select the Mosaic command from the Tools menu.

The Mosaic dialog box appears.

4 Select the FOVI you want from the Use box.

All rectangular FOVIs—including user-created FOVIs—are listed. If none of these
meets your need, you can define one with the dimensions you want. (See page 68.)

5 Enter the percentage of linear overlap between frames.

The default is 5%. You can choose values between 0% and 60%.

6 Click Compute.

The total number of points is limited to 400. If you’re within the limit, the array
dimensions are displayed and the zoom box is divided.

If you exceed the limit, you are told the number of frames required, and the zoom
box is not divided. You need either a larger FOVI or a smaller zoom box.

7 Click Close.

The mosaic of frames is now displayed, and remains at the same place in the
Virtual Sky, even if you scroll or zoom. To remove it, click Clear Frames in
the Mosaic dialog box.

Using the Mosaic

Once a link with the telescope is established, all you have to do is click
anywhere within one of the mosaic frames, and the telescope will
automatically slew to those coordinates and track them.
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If you are viewing or photographing the Moon, mark the “Lunar tracking
rate” checkbox. The telescope’s drive will automatically be reset to the
sidereal rate. (The previous rate is restored when you remove the mosaic.)

The frames are numbered, but you can select them in any order. (If TheSky’s
window is not maximized, the numbers might not be displayed.) A selected
frame’s border changes color from magenta to red, to remind you it’s been
“visited.” To reset these frames to magenta, click Reset Slewed.

Telescope Mounting and Mosaic Tracking

If you’re using the Mosaic feature to take pictures, the CCD or film camera has
to be aligned with the mosaic frames. You must therefore either position the
camera to align it with the Virtual Sky, or orient the Virtual Sky to the camera.

TheSky can help you. Use Image Link to align one of your CCD images with the
Virtual Sky, then click inside the image to display the Object Information dialog
box. The “Image Link Information” gives the orientation of the image as an
angular offset from North. You can then adjust the camera mount or the
Virtual Sky’s orientation accordingly.

The Mosaic feature works best with equatorial telescopes. Alt-az telescopes
suffer from field rotation, which causes the camera’s field of view to gradually
rotate. The severity of this effect varies with the altitude coordinates of the area
being photographed, and the length of time needed to complete the
photography. A field-rotation corrector might be needed.

Using the Telescopes in Education Network

Access to the Telescopes in Education Network requires Software Bisque’s
Remote Astronomy Software™ package, which runs under Windows. This
package includes full instructions.

Using Astronomy Command Language

Astronomy Command Language is a standard communications protocol for
computer-controlled telescopes and other astronomical devices. Software
Bisque’s implementation includes the error-checking and device-specific
features needed to take full advantage of ACL.

ACL is supported only at Level IV.

Using the Paramount GT-1100 Drive System

Full instructions are supplied with the Paramount GT-1100 drive system.

The Paramount is supported only at Level IV.
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A Database Locations and Errors

Database Locations

TheSky (Level IV) has almost 800 MB of files and databases. The Hipparcos-
Tycho catalogs are the principal databases, supplemented by the Hubble
Guide Star catalog (GSC), plus specialized catalogs, described on page 6.

If you select Typical installation, the installation program copies only a
preselected group of files and databases to the hard disk—even if there’s
room for every file and database.

If you select Custom installation, you can choose which files are copied.
Copying all the databases to the hard disk gives the fastest operation.

In a Custom installation, you can choose the folders for the databases,
indexes, and picture files. If your main partition doesn’t have enough free
space, and another partition does, select a folder in that partition.

Databases that aren’t copied to the hard disk are accessed from the CD ROM.
You can tell where a database is located by selecting File Locations from the
Data menu and browsing the Files listing.

You can change file locations at any time. If some databases weren’t copied
to your hard disk, copy them and change the path. If you want to recover
space on your hard disk, delete one or more databases and change the path
back to the CD ROM.

If you don’t have enough space, the GSC database and the PGC images are
the two files most likely not to be copied. For this reason, they are supplied
on the second CD ROM.

Missing or Anomalous GSC Data

Diffraction Spikes and Halos

The areas around some bright stars do not show any dim, high-magnitude
stars. The “empty” areas take the form of halos or diffraction spikes. These
optical artifacts obscure dimmer objects on the photographic plates from
which the GSC data are derived.



“Burned-Out” Areas

The GSC data were derived from photographic plates given heavy exposure
to bring out detail. As a result, the central regions of globular clusters and
bright nebulae are sometimes overexposed, and show no detail. This can be
seen (for example) as an empty square area in NGC 5139. It is also the reason
why the Trapezium shows little detail.

Missing Data

There are no data for several areas. In particular, there is a blank rectangular
region in Hercules, at about 17h 20m RA, 33º 13' Dec. (The Hipparcos-Tycho
catalogs include some of the brighter stars in this region.)

Anomalous Data

There are two rows of “stars,” centered at 22h 10m 34.5s RA, -11° 38' 12"
Dec, and 22h 08m 17.6s RA, -11° 39' 53" Dec.

Other Errors…?

The contracts under which Software Bisque provides the GSC data (and
other databases) prevent us from adding to or altering them. If you find
additional errors or omissions, please let us know so we can report them.
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B Reference Data

Common Star Names

“Common” means the non-scientific name or designation—Mizar, for example, rather than
Zeta-Ursae Majoris.

Acamar Alrakis Cebalrai Kaus Australis Nashira Seginus

Achernar Alrescha Celaeno Kaus Borealis Natarehs Shaula

Acrab Alshain Chara Kaus Media Navi Sheliak

Acrux Altair Chertan Keid Nekkar Sheratan

Acubens Altais Cor Caroli Kitalpha Nihal Sirius

Adhafera Alterf Cursa Kochab Nunki Skat

Adhara Aludra Dabih Kornephoros Nusakan Spica

Albali Alula Australis Deneb Kurhah Peacock Sterope

Albireo Alula Borealis Deneb Algedi Lesath Phact Sualacin

Alchiba Alya Denebola Maia Phecda Suhail

Alcor Ankaa Diphda Marfik Pherkad Sulafat

Alcyone Antares Double Double Markab Pleione Syrma

Aldebaran Arcturus Dubhe Matar Polaris Talitha

Alderamin Arkab Edasich Mebsuta Pollux Tania Australis

Alfirk Arneb Electra Megrez Pomima Tania Borealis

Algedi Ascella Elnath Meissa Procyon Tarazed

Algenib Asellus Australis Eltanin Mekbuda Propus Taygeta

Algieba Asellus Borealis Enif Menkalinan Rasalas Thuban

Algol Aspidiske Errai Menkar Rasalgethi Trapezium

Algorab Atik Fomalhaut Menkent Rasalhague Unukalhai

Alhena Atlas Furud Menkib Rastaban UU

Alioth Atria Gacrux Merak Regor Vega

Alkaid Avior Giausar Merope Regulus Vindemiatrix

Alkalurops Azha Gienah Mesarthim Rigel Wasat

Alkes Baten Kaitos Gomeisa Miaplacidus Rotanev Wazn

Almach Beid Graffias Mimosa Ruchbah Wezen

AlNair Bellatrix Grumium Mintaka Rukbat Yed Posterior

Alnasl Betelgeuse Hadar Mira Sabik Yed Prior

Alnilam Biham Hamal Mirach Sadalmelik Zaniah

Alnitak Canopus Hinds Crimson Star Mirfak Sadalsuud Zaurak

Alpha Centauri Capella Homam Mirzam Sadr Zavijava

Alphard Caph Izar Mizar Saiph Zosma

Alphecca Castor Kaffaljidhma Muphrid Scheat Zubenelgenubi

Alpheratz CE Muscida Schedar Zubeneschamali



Common NGC Objects

The following is a partial list of object names can be used with the Search command.

Antennae Eight-burst planetary Omega Nebula

Barnard’s Galaxy Eskimo Nebula Owl Nebula

Baxendell’s Nebula The Eyes Pinwheel Nebula

Bear Paw Galaxy Filamentary Nebula Polarissima Australis

Black-Eye Galaxy Ghost of Jupiter Polarissima Borealis

Blinking planetary Great Cluster in Hercules Praesepe

Blue planetary Great Nebula in Andromeda Ring Nebula in Lyra

Blue Snowball Great Nebula in Orion Rosette Nebula

Bode’s Nebula Helix Galaxy Saturn Nebula

Box Helix Nebula Sculptor Galaxy

Box Nebula Hind’s Variable Nebula Siamese Twins

Bubble Nebula Hourglass Nebula Sombrero Galaxy

Bug Nebula Hubble’s Variable Nebula Spindle Galaxy

Butterfly Cluster Jewel Box Stephan’s Quintet

California Nebula Lacework Nebula Struve’s Lost Nebula

Christmas Tree Cluster Lagoon Nebula Sunflower Galaxy

Cone Nebula Little Dumbbell Tarantula Nebula

Copeland’s Septet Little Gem Triangulum Galaxy

Crab Nebula Maia Nebula Trifid Nebula

Crescent Nebula Merope Nebula Veil Nebula

Double Cluster The Mice Whirlpool Galaxy

Dumbell Nebula Network Nebula Wild Duck Cluster

Eagle Nebula North America Nebula

Spectral Classes

O bluish-white 30000° K

B bluish-white 20000° K

A white 10000° K

F yellowish-white 7000° K

G yellow 6000° K

K deep-yellow 4000° K

M reddish 3000° K

186 TheSky Astronomy Software



Constellation Abbreviations

(And) Andromeda (Cru) Crux Australis (Ori) Orion

(Ant) Antlia (Cyg) Cygnus (Pav) Pavo

(Aps) Apus (Del) Delphinus (Peg) Pegasus

(Aqr) Aquarius (Dor) Dorado (Per) Perseus

(Aql) Aquila (Dra) Draco (Phe) Phoenix

(Ara) Ara (Equ) Equuleus (Pic) Pictor

(Ari) Aries (Eri) Eridanus (Psc) Pisces

(Aur) Auriga (For) Fornax (PsA) Pisces Australis

(Boo) Bootes (Gem) Gemini (Pup) Puppis

(Cae) Caelum (Gru) Grus (Pyx) Pyxis

(Cam) Camelopardus (Her) Hercules (Ret) Reticulum

(Cnc) Cancer (Hor) Horologium (Sge) Sagitta

(CVn) Canes Venatici (Hya) Hydra (Sgr) Sagittarius

(CMa) Canis Major (Hyi) Hydrus (Sco) Scorpius

(CMi) Canis Minor (Ind) Indus (Scl) Sculptor

(Cap) Capricornus (Lac) Lacerta (Sct) Scutum

(Car) Carina (Leo) Leo (Ser) Serpens

(Cas) Cassiopeia (LMi) Leo Minor (Sex) Sextans

(Cen) Centaurus (Lep) Lepus (Tau) Taurus

(Cep) Cepheus (Lib) Libra (Tel) Telescopium

(Cet) Cetus (Lup) Lupus (Tri) Triangulum

(Cha) Chamaeleon (Lyn) Lynx (TrA) Triangulum Australis

(Cir) Circinus (Lyr) Lyra (Tuc) Tucana

(Col) Columba (Men) Mensa (UMa) Ursa Major

(Com) Coma Berenices (Mic) Microscopium (UMi) Ursa Minor

(CrA) Corona Australis (Mon) Monoceros (Vel) Vela

(CrB) Corona Borealis (Mus) Musca Australis (Vir) Virgo

(Crv) Corvus (Nor) Norma (Vol) Volans

(Crt) Crater (Oct) Octans (Vul) Vulpecula

(Oph) Ophiuchus
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Dreyer Abbreviations

In Version 5, the Object Information dialog box includes a plain-English Dreyer description
for each NGC object. This list has been retained, however, because some readers might find
it useful.

Abbreviation Meaning Abbreviation Meaning

ab about exc excentric

alm almost F faint

am among f following (eastward)

att attached g gradually

B bright gr group

b brighter i irregular

bet between iF irregular figure

biN binuclear inv involved, involving

bf brightest to east side L large

bn brightest to north side l little; long

bp brightest to west side M middle

bs brightest to south side m much; magnitude

C compressed N nucleus

Cl cluster n north

c considerably neb nebula

chev chevelure nebs nebulous

co coarse; coarsely neby nebulosity

com cometary form nf north following

comp companion np north preceding

conn connected ns north-south

cont contacting; in contact nr near

D double P poor (sparse) in stars

D* double star p preceding (westward)

d diameter p pretty (prior to F, B, L, S)

def defined pf preceding-following

dif diffused pg pretty gradually

diffic difficult plan planetary nebula

dist distance or distant pm pretty much

E extended prob probably

e extremely; excessively ps pretty suddenly

ee most extremely R round

er easily resolvable RR exactly round
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Abbreviation Meaning Abbreviation Meaning

Ri rich in stars stell stellar, pointlike

r resolvable (mottled) susp suspected

rr partially resolved triN trinuclear

rrr well-resolved v very

S small (in angular size) var variable

S* small (faint) star * single star

s suddenly; south *10 10th-magnitude star

sc scattered *7-8 star of mag 7 or 8

sev several ** double star

sf south following (southeast) *** triple star

sp south preceding (southwest) ! remarkable

st stars !! very much so

st 9…13 stars of magnitude 9 to 13 !!! a magnificent or
otherwise-interesting object
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Object-Type Index Numbers

Each Object Type is numbered. You need to know this number when
specifying the default Object Type in a database header.

User-defined Object Types appear at the end of this list and continue
the numbering sequence—60, 61, 62, and so on.

Object Type Index Object Type Index Object Type Index Object Type Index

Star 0 Bright Nebula 15 Jupiter 30 Constellation
Figure

45

Variable Star 1 Dark Nebula 16 Saturn 31 Constellation
Boundary

46

Suspected
Variable

2 Planetary Nebula 17 Uranus 32 Ecliptic 47

Double Star 3 NGC Probable
Star

18 Neptune 33 Horizon Grid 48

Galaxy 4 Other NGC 19 Pluto 34 Horizon Lines 49

Type C Galaxy 5 Mixed Deep Sky 20 Moon 35 Meridian 50

Elliptical Galaxy 6 Non-stellar GSC 21 Comet 36 Equatorial Grid 51

Lenticular Galaxy 7 Quasar 22 Minor Planet 37 Galactic Equator 52

Spiral Galaxy 8 X-Ray Source 23 Extended Comet 38 Milky Way 53

Irregular Galaxy 9 Radio Source 24 Extended Minor
Planet

39 Reference Line 54

Cluster of
Galaxies

10 Sun 25 Spacecraft 40 Reference Point 55

Open Cluster 11 Mercury 26 Image 41 Field of View
Indicator

56

Globular Cluster 12 Venus 27 Video 42 Sky Chart 57

Cluster +
Nebulosity

13 Earth 28 Sound 43 Sky Legend 58

Nebula 14 Mars 29 Notes 44 Telescope Limit 59
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C Function & Accelerator Keys

Windows Function & Accelerator Keys

Key Use

F Displays the Find dialog box.

I Displays or hides the Image Link overlay.

N, S, E, W Orient the Virtual Sky towards one of the cardinal compass points.

Z Orients the Virtual Sky with the zenith at the center of the screen.

END Zooms the Virtual Sky to 1' (narrowest view).

ESC Halts Virtual Sky redraw. Halts Time Skip simulation. Exits automatic
Slide Show. Exits Digital Setting Circles. Closes Print Preview window.

F1 Displays help about the currently selected object or command.

F5 Redraws the Virtual Sky.

HOME Zooms the Virtual Sky to widest view (360° Mercator, 300° azimuthal
equal-distance, 235° azimuthal equal-area, 235° stereographic,
180° orthographic, 150° gnomonic).

LEFT / RIGHT Scroll or rotate the Virtual Sky. Rotate the 3D Solar System.

UP / DOWN Scroll the Virtual Sky vertically. Tilt the 3D Solar System.

PAGE UP / PAGE DOWN Zoom Virtual Sky, 3D Solar System to a wider/narrower angle of view.

SPACE Toggles between full-screen display and windowed view.

SHIFT When clicking on a symbol with an associated image, displays the
Object Information dialog box instead of the image.

SHIFT+F1 Turns the regular cursor into the Help cursor.

SHIFT+B Moves to the previous slide in the Slide Show.

SHIFT+C Displays the Create Slide Show dialog box.

SHIFT+F Moves to the next slide in the Slide Show.

CONTROL When scrolling/tilting/zooming, reduces increment to ¼, 1⁄5 normal.
When dragging the Rotate Control Line, forces angle to 15° multiples.
When dragging zoom box, forces aspect ratio to display driver’s ratio.
When clicking Create List to export data, appends to existing list.

CONTROL+SHIFT When scrolling, tilting, or zooming, produces a “micro” increment,
usually 1⁄20 the default value.

CONTROL+B Zooms the Virtual Sky to 50° (Binoculars).

CONTROL+C Copies the current Virtual Sky or 3D Solar System (minus title bar,
menu, and status bar) to the Clipboard.

CONTROL+E Zooms the Virtual Sky to 100° (Eye).



CONTROL+F Zooms the Virtual Sky to 10° (Finder).

CONTROL+N Reloads the current Sky Document.

CONTROL+O Opens a Sky Document (.SKY file).

CONTROL+P Displays the Print dialog box.

CONTROL+S Saves the current Sky Document.

CONTROL+T Zooms the Virtual Sky to 1° (Telescope).

CONTROL+W Zooms the Virtual Sky to 180° (Wide).

CONTROL+V Pastes the contents of the Clipboard into the Virtual Sky.

CONTROL+Z Reverses the last scroll/zoom/orientation/rotation change
to the Virtual Sky.

CONTROL+F5 Deactivates all object-class resident Sky Databases.

CONTROL+F7 Adds an ellipse representing an extended deep-sky object.

ALT+C Displays the Import dialog box.

ALT+I Displays the Filters dialog box.

ALT+L Displays the Labels Setup dialog box.

ALT+M Displays/hides the Motion Controls dialog box.

ALT+P Displays the Preferences dialog box.

ALT+R Displays/hides the Rotate Control Line.

ALT+U Displays the Add User Data dialog box.

ALT+F4 Closes the currently active dialog box or window.
If it’s the main window, exits TheSky.

ALT+BACKSPACE Reverses the last scroll/zoom/orientation/rotation change
to the Virtual Sky.

ALT++ / ALT+– Rotates the Virtual Sky clockwise / counter-clockwise.

ALT+> / ALT+< Steps forward / backward in a Time-Skip simulation.

ALT+] / ALT+[ Runs forward / backward in a Time-Skip simulation.

right-click in
Virtual Sky

Displays the Virtual Sky pop-up menu.

right-click in
docked toolbar

Displays the toolbars pop-up menu.
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Macintosh Function & Accelerator Keys

Key Use

F Displays the Find dialog box.

I Displays or hides the Image Link overlay.

N, S, E, W Orient the Virtual Sky towards one of the cardinal compass points.

Z Orients the Virtual Sky with the zenith at the center of the screen.

END Zooms the Virtual Sky to 1' (narrowest view).

ESC Halts Virtual Sky redraw. Halts Time Skip simulation. Exits Digital
Setting Circles. Closes Print Preview window.

F1 Displays help about the currently selected object or command.

F5 Redraws the Virtual Sky.

HOME Zooms the Virtual Sky to widest view (360° Mercator, 300° azimuthal
equal-distance, 235° azimuthal equal-area, 235° stereographic,
180° orthographic, 150° gnomonic).

LEFT / RIGHT Scroll or rotate the Virtual Sky. Rotate the 3D Solar System.

UP / DOWN Scroll the Virtual Sky vertically. Tilt the 3D Solar System.

PAGE UP / PAGE DOWN Zoom Virtual Sky, 3D Solar System to a wider/narrower angle of view.

SPACE Toggles between full-screen display and windowed view.

SHIFT When clicking on a symbol with an associated image, displays the
Object Information dialog box instead of the image.

SHIFT+F1 Turns the regular cursor into the Help cursor.

SHIFT+zE Adds an ellipse representing an extended deep-sky object.

SHIFT+R Redraws the Virtual Sky.

CONTROL When dragging the Rotate Control Line, forces angle to 15° multiples.
When dragging zoom box, forces aspect ratio to display driver’s ratio.

CONTROL+F7 Adds an ellipse representing an extended deep-sky object.

CONTROL+click
in Virtual Sky

Displays the Virtual Sky pop-up menu.

CONTROL+click
in docked toolbar

Displays the toolbars pop-up menu.

zB Toggles between full-screen display and windowed view.

zC Copies the current Virtual Sky or 3D Solar System (minus title bar,
menu, and status bar) to the Clipboard.

zE Displays the Preferences dialog box.

zF Displays the Find dialog box.

zH Displays the Import dialog box.
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zI Displays or hides the Image Link overlay.

zL Displays the Labels Setup dialog box.

zM Displays/hides the Motion Controls dialog box.

zN Reloads the current Sky Document.

zO Opens a Sky Document (.SKY file).

zP Displays the Print dialog box.

zQ Closes the currently active dialog box or window.
If it’s the main window, exits TheSky.

zR Displays/hides the Rotate Control Line.

zS Saves the current Sky Document.

zT Displays the Filters dialog box.

zU Displays the Add User Data dialog box.

zV Pastes the contents of the Clipboard into the Virtual Sky.

zZ Reverse the last scroll/zoom/orientation/rotation change
to the Virtual Sky.

z1 Zooms the Virtual Sky to 1' (narrowest view).

z2 or CONTROL+T Zooms the Virtual Sky to 1° (Telescope).

z3 or CONTROL+F Zooms the Virtual Sky to 10° (Finder).

z4 or CONTROL+B Zooms the Virtual Sky to 50° (Binoculars).

z5 or CONTROL+E Zooms the Virtual Sky to 100° (Eye).

z6 or CONTROL+W Zooms the Virtual Sky to 180° (Wide).

z7 Zooms the Virtual Sky to widest view (360° Mercator, 300° azimuthal
equal-distance, 235° azimuthal equal-area, 235° stereographic,
180° orthographic, 150° gnomonic).

z. (period) Halts Virtual Sky redraw. Halts Time Skip simulation. Exits automatic
Slide Show. Exits Digital Setting Circles. Closes Print Preview window.

z? Displays help about the currently selected object or command.

OPTION When scrolling/tilting/zooming, reduces increment to ¼, 1⁄5 normal.
When clicking Create List to export data, appends to existing list.

OPTION+SHIFT When scrolling, tilting, or zooming, produces a “micro” increment,
usually 1⁄20 the default value.

z+ /z– Rotates the Virtual Sky clockwise / counter-clockwise.

z' /z; Steps forward / backward in a Time-Skip simulation.

z] /z[ Runs forward / backward in a Time-Skip simulation.
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